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1 Forward AV Studio Overview 
Forward AV Studio is designed for video clips scoring, creating audio 
commercials, and synchronizing voice with music. You can create, save, restore 
and playback multi-track projects. Forward AV Studio is a non-destructive 
editor, i.e. it does not change source multimedia files. 
Forward AV Studio project may have up to 32 audio tracks, one track with midi 
sound, and one/two video tracks. Each track can contain an unlimited number of 
clips. Clip is a reference to a continuous fragment (or the whole content) of audio 
or/and video data from the source file. 
Forward AV Studio playbacks video on any device supported by Video for 
Windows. 
An outstanding feature of the editor is the speed of playback, especially its audio 
part. Forward AV Studio is able to mix many sound tracks in real time. 
Forward AV Studio is a powerful and flexible tool for audio mixing. Each track 
has solo/mute toggles. Master volume and balance can be set for the whole 
project, each track or each clip. Moreover, volume and balance profile can be set 
separately for each clip. 
You can apply real-time audio effects on clips, tracks and the entire project (mix 
of all audio tracks). 
Forward AV Studio has an intuitive user interface. Operations and features are 
easily accessible from the toolbar, menus, context-sensitive local menus and 
keyboard accelerators (hot keys). Forward AV Studio supports up to 999 
undo/redo levels. 
Forward AV Studio has two main windows: Project and Clip Collection. The 
Project window contains all data and tools for project editing. The 
Clip Collection window may be considered as a handy storage site for your audio 
and video files. 
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2. Project Window 

2 Project Window 

 
Project window is the main window with the title bar containing the application 
name, Forward AV Studio, and the path to the project file or Untitled for a newly 
created project. 
The Toolbar, accelerator keys and main menu provide access to all commands 
and options. 
By right clicking on different components of the Project window you can call a 
context-sensitive local menu. The mouse arrow takes different context-dependent 
shapes. 
The Working Area of the Project window is used to edit multi-track projects with 
clips. At the left of each track there is the Track State window with one of the 
three track-type icons (video/audio/midi) and the Solo and Mute buttons to control 
track inclusion into the playback. 
Clips on track, depending of the clip type (Video, Midi or Audio), have various 
data-specific features but their general functionality and appearance are the 
same. 
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2. Project Window 

All tracks and clips of a project are schematically represented in the 
Project Overview window. Time Ruler provides the project time reference for the 
Working Area. 
The position of Current time is visually represented by two red vertical lines: one 
in the Project Overview window and the other, current time mark, across the 
Time Ruler and Range windows as well as across the track in the Working Area. 
At the bottom of the Project window there is a status line. By putting the mouse 
arrow over an object you can view various information about this object. For 
settings and options call the Settings dialog box (press F5). The 
Audio Meter (Faders) window contains the output volume indicator and may 
have faders and audio effects buttons for tracks. 
From the Project window clips can be dragged to the Clip Collection window, 
and vice versa. Source media files can also be dragged from the standard 
Windows Explorer. 

2.1 Project Overview window 

 
This window displays the reduction of all tracks and clips of a project. 
The bold black frame indicates the position of the Working Area, a visible part of 
the project displayed in the window of video/midi/audio tracks. The red vertical 
line indicates current time. 
To move the Working Area, place the cursor inside the black frame, where it 

takes the shape , press the mouse left button and drag the frame to the 
left/right. 
To change the Working Area size, move the left/right edges of the working area 
putting the cursor over the black frame edge (the cursor will look  or ), 
pressing the mouse left button and dragging the edge to the left/right. 
To redefine the Working Area completely, press the mouse right button at a new 
position of the first edge, drag it to the left/right and release the button where you 
want to set the new edge. 
The Set Size dialog box is used to view and change the Working Area bounds. 
To change the duration of and the number of audio tracks in the Project you can 
use the Set Size dialog box or General Settings (press F5). 
A double click in the Project Overview window (not in the main window with 
tracks) starts project playback from a specified position to the end of the Project. 
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2. Project Window 

2.2 Time Ruler 

 

The Time Ruler provides the time reference for the project in the Working Area. 
Labels with the project time values are displayed in the current time format with 
the time step set in the Scale Step window. 
Each click in this window redefines the position of the current time, which is 
indicated by the red vertical line or current time mark. To start ‘scrubbing’, or 
fast preview in the current position while moving it, press the mouse left button, 
hold it and then move the mouse. A double-click starts playback from a specified 
position to the end of the Working Area. 
A right-click in the Time Ruler window calls its local menu. Note that the 
Add Mark command can be dynamically replaced by another command by 
pressing the mouse right button over the previously set mark. 

Play playback the Project from a specified position to the 
end of the Working Area. 

Set current time call the Set Current Time dialog box. 
The following three commands are analogs of those in the General Settings (F5). 

Show video display the current frame on the video player 
(Video window). This command is an analog of 
Show In/Out frame setting in the Edit Clip dialog box. 

Play audio start audio scrubbing while dragging the current time 
mark. 

Auto-scroll rolls control automatic scrolling of the working area while 
moving the mouse outside the window. 

The following two commands duplicate those in the Alignment Settings 
(Time Alignment group). 

Align to nearest frame align the current time mark to the nearest video frame. 
Snap to marks snap the current time position to the placed marks. 
Add mark place the mark at a specified position. This command is 

also used to call the Mark info menu for a previously 
placed mark. 
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2.3 Current Time window 

 

The Current Time window on the left of the Time Ruler displays the current time 
value in the current time format. 
In the Project window, the current time is shown by two red vertical lines: one in 
the Project Overview window and the other, the current time mark, across the 
Time Ruler, Range window and tracks in the Working Area. You can move the 
current time position by dragging it with the mouse in the Time Ruler and 
Working Area. 

 

To set the current time manually, double-click in the current time window to call 
the Set Current Time dialog box. This dialog box can also be called by the 
Set current time command in the Time Ruler local menu. 

2.4 Range Window 

 

Range is a user-defined time interval to be used in different operations 
(playback, normalize/statistics, export to the resulting file etc.). The selected 
interval is displayed as a blue box. The range window and the Time Ruler have 
the same time scale. If the range is set, the Range Flag window displays the blue 
box and Playback Start and Playback Duration windows display in blue color 
the start time of the range and its duration. To specify the range and select the 
time interval for a Project, press the mouse left button when the mouse arrow is 
on the range window, drag the mouse to the left/right and release it where 
necessary. If Show video is on, the current video frame from the video track is 
being displayed during the dragging (see Time Ruler local menu or 
General Settings). A shift-click on the range window resets the nearest boundary 
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2. Project Window 

of the selected range to a specified position. A double-click sets the full range 
that covers all clips in the Project except those in the non-active tracks (for 
switching off tracks by the Mute button see track selection). The Include all clips 
command from the Range menu can also be used for this purpose. 
You can move the selected range or its boundaries to the left/right using the 
mouse. Press and hold the Ctrl key, move the mouse arrow to the selected range 
or its start/end (the arrow will change its shape), press and hold the mouse left 
button and drag the mouse to the left/right. When a video range on a video track 
is being dragged, the first/last frame of the selected range is being displayed. 
Press the mouse right button to switch between the first and last video frame of 
the selected range to be displayed when being dragged. 
You can set the range boundaries equal to the start/end of any clip by moving the 
mouse arrow over the clip and pressing the G key on the keyboard. Press Shift+G 
to expand the range to the start or end of the clip (also, see the section about 
keyboard accelerators). 
To set/view the range boundaries in the current time format, double-click in the 
Range Flag window or click on the Set Size button to call the Set Size dialog box. 
To clear the range and remove the time interval selection, click at any place in 
the range window or press and hold the Ctrl key and click on the blue indicator in 
the Range Flag window. This may be useful if you want to clear the range while 
keeping the current time position. 
Right-click on the range window calls a local menu with the same commands as 
in the Range menu plus the following: 

Normalize audio call the Normalize Level dialog box to adjust project 
master volume to a specified level. 

Statistics mix audio within a range and represent the resulting 
audio volume as a color picture on range window 
according to the volume levels and color associations 
defined in Audio Meter Settings. Show Statistics of the 
mixed audio in the selected range. 

2.5 Range Flag window 

 

A blue band in this window to the left of the Range Window indicates that the 
range is defined; a blank in this window indicates otherwise. 
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2. Project Window 

 

A double-click in the Range Flag window calls the Set Range dialog box that 
displays range boundaries values in the current time format. 

2.6 Playback Start and Playback Duration 

 

These two windows show the start and duration of playback in the current time 
format. 
If the time range is set in the Range window, the range start and duration are 
shown in blue. Otherwise, the start and size of the Working Area are shown in 
black. Where playback actually starts depends also on the status of 
Start playback from current time position in General Settings. 
Double-click in either window to call the Set Size dialog box. 

2.7 Set Size 

 

The Set Size button or double-click in either Playback Start or Playback Duration 
windows calls the Set Size dialog box, which have three groups of parameters. 
Project Limits. In the Size and Audio tracks boxes you can set the duration and 
number of audio tracks in the Project. These settings duplicate the parameters 
from the Project Limits group in the General Settings. 
In the Working Area boxes you can set the left and right boundaries and the size of 
the Working Area. 
In the Time Range boxes you can set the left and right boundaries and the size of 
the time range. The same settings are also available in the Set Range dialog box. 
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2.8 Scale Step 

 

From the list you can select the interval between the ticks in the Time Ruler 
window. Following the setting, the Working Area is zoomed to a new size to fit 
the selected scale. 
If the current time position (vertical red line) is within the Working Area, it 
retains its visual position after the execution of any zoom commands; otherwise 
the center of the Working Area does. 
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3 Project Working Area 

 

Working Area is part of the Project window that is located below the 
Range window. This area represents the project’s Video, Midi and Audio tracks 
with clips within a specified time interval. 
On the left of each track there is the Track State window with the track type icon 
(video/audio/midi) and the Solo and Mute buttons. The Show Video tracks, 
Show MIDI track and Show Audio tracks commands from the View menu are used to 
define the type of tracks to be shown in the Working Area window. The vertical 
scrollbar in the right part of the area indicates that the project contains too many 
audio tracks to display all of them separately. 
The clip on track in the Working Area is represented by a rectangle with the clip 
name shown in its top left corner. Video, Midi, and Audio clips also have type-
specific features and settings. 
To call the local menu right-click on the area not occupied by clips: 

Open source file… call the Open Clip dialog box and add a clip with 
reference to the source file to the project and 
Clip Collection. There is an identical command on the 
File menu. 

Cut. Copy. Paste. Insert. perform the corresponding operation on the selected 
clip(s). These are Identical to the commands from the 
Edit menu. 

The Working Area size and position can easily be modified or redefined in the 
Project Overview window. The Set Size dialog box is used to set the values for 
the left and right bounds. The position of the Working Area relative to the 
start/end of the project can be changed using the horizontal time scrollbar at the 
bottom of the Working Area window. To the left of the scrollbar there are zoom 
buttons. 
The red vertical line visually represents the current time position. 

Forward AV Studio  9 



3. Project Working Area 

3.1 Track State 

 

In the Track State windows at the left of each track in the Working Area, there 
are Solo and Mute toggle buttons to control the track playback and different icons 
for each type of track (audio/video/midi). There appear indicators L and R on 
audio tracks of stereo projects to balance the Audio clip profile in stereo projects. 
If a track is excluded from playback (either because it is muted or other tracks 
are solo) the track icon becomes gray and faded as shown below: 

   - Video track.    - Audio track.    - MIDI track. 
A right-click on a track state window region calls the track local menu: 

Name call the Track Name dialog box to change the track 
name. 

The following two commands are used to change the positions of tracks of the 
same type. Note that during playback the first (top) video track is of higher 
priority than the second video track. The number of an Audio track is shown in 
the upper left corner. This is of special convenience when the vertical scrollbar is 
used instead of a large number of tracks. 

Move up swap the positions of a given track and the upper track. 
Move down  swap the positions of a given track and the track below. 
Track height change the height of the track. The desired value of 

height can be selected from the submenu: Double, Normal, 
Half or Locked (too small height; clips on the locked track 
cannot be selected or manipulated with the mouse). You 
can change the height of any track using the keys 1, 2, 3 
and 0 on the keyboard when the mouse arrow is on the 
corresponding track. To change the height of all audio 
tracks at once you can use the Audio tracks Height 
command from the View menu. 
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3. Project Working Area 

Track volume change the track volume in a special dialog box window 
or in the Faders window if the latter is active. Available 
only for Audio and Midi tracks. 

Audio effects allow access to audio effects on the current track. There 
is a submenu having the following commands:  

    Add new…  call the Audio Effects List dialog box to add new effects 
or edit effects on a track,  

    Use   turn on/off the effects,  
    Delete   remove all effects from the track (with confirmation),  
    Cut   move the effects to the clipboard,  
    Copy   copy the effects to the clipboard,  
    Paste   replace the effects on track with the effects from the 

clipboard,  
    Add   add the effects from the clipboard to the current effects 

on track, 
Duplicate track create a copy of the current track with all clips, the track 

volume and audio effects, and place a copy to the first 
vacant track that follows the current track, 

Clear track remove all clips and audio effects from the current 
audio track, reset the track volume to 0 dB, track 
balance to center, 

Insert track insert a blank audio track before the current track and 
move all lower audio tracks down. You can do it also 
with the ‘Ins’ key on the keyboard when the mouse 
cursor is over the track state window. 

Delete track clear the current audio track and move all lower audio 
tracks up. You can do it also with the ‘Del’ key on the 
keyboard when the mouse cursor is over the track state 
window. 

Solo always include track in playback, same as Solo toggle. 
Mute exclude track from playback, same as Mute toggle. 
Enable all tracks turn off Solo / Mute toggles on all tracks 

3.1.1 Track selection (active tracks) 
Each track has Solo and Mute buttons on the Track State window and may be 
included in or excluded from playback and export to the resulting multimedia 
file. For excluded track its type icon is ‘grayed’. 

 - Solo. Track is always included in playback. Tracks not chosen as solo are 
automatically excluded from playback (‘grayed’) if solo track(s) is present. If 
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3. Project Working Area 

Exclusive ‘Solo’ in Selection Settings controls is on, solo can be set for only one 
track and for many tracks otherwise. 

 - Mute. Track is excluded from playback (track type icon is ‘grayed’). 

 - Neither Solo nor Mute. Track included in playback if there is no other solo 
track(s). 

3.1.2 Track Name 

 

Track name is displayed in the status line at the bottom of the Project window 
while cursor is over the Track State window. Predefined names typically consist 
of a track type and number inherited from the initial enumeration of project 
tracks of that type. The Name command from the local menu of Track State is 
used to call the Track Name dialog box. 

3.2 Clip on Track 

 

In the Working Area, Clip on track is displayed as a rectangle with the clip name 
in the top left corner. The height of the rectangle is equal to that of the track (see 

Forward AV Studio   12 



3. Project Working Area 

the Track State local menu), the width is determined by the clip duration. The 
clip background color depends on the status of Clip Selection. 
To call the local menu right-click on a clip. Some commands are common for all 
types of clips, other commands are clip-type specific. 

Edit the ‘Clip type’ editor command is used to call the external 
media editor to perform common operations with clips 
and the clipboard (Delete, Cut, Copy, Paste, Insert). The 
actual name of the command depends on the clip type – 
Video editor, Audio editor, Midi editor. The Editor 
application can be set in the 
Configure external applications dialog box. The clip 
source file name is added to the command line of the 
application at its startup. 

Split clip split the clip into two parts (new clips) at a specified 
position. This command is similar to the Split command 
on the Edit menu. 

Repeat clip… call the Repeat Clip dialog box. 
Select source file in project 
 select all clips from a clip collection referred to the 

same source file as the current clip. 
Range submenu commands are as follows: 
Zoom to clip zoom the Working Area to the current clip. 
Set range to clip set the Range boundaries to the start/end of the current 

clip. 
Expand range to clip expand the start/end of the Range to the start/end of the 

current clip. 
Add mark set Place mark at a specified position. If the local menu 

is called near a previously placed mark (the cursor’s 
shape is ), the Add mark command is replaced by 
the following three commands: Set mark position, Mark info 
and Remove mark. 

Play clip playback this clip only. 
Properties call the Clip Properties dialog box. 

Specific features and editing operations are provided for each type of clips and 
tracks, Video, Midi, and Audio. The keyboard accelerators can be used to 
perform some operations with clips. 

3.3 Video Tracks and Video Clip 
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3. Project Working Area 

 

 and  in the Track State window help identify video tracks. A Project 
can have one or two video tracks. During video playback the first video track is 
given a priority over the second video track. The second video track may be used 
for temporary storage of video fragments or as the second variant of a video on 
the first track switched off with the Mute button. 
To display the first and last frames of the clip on track in the Working Area, 
check the Draw first and last frames at clip edges box in the Video Settings. 
To call the local menu right-click on a clip. Specific commands for video clips 
are as follows: 

Clip In is a key frame  arrange for starting the video clip from a key frame. 
Clip In to next key frame  move the In position of the clip forward to the next key 

frame in the source file. 
Clip In to preceding key frame 
 move the In position of the clip back to the preceding 

key frame in the source file. 
The above-mentioned In position is the place in the source file where the clip 
starts. See also the Start from Key frame only command in the Video Settings. 
The application can playback and export video ONLY in the format of the source 
video files. All clips must have the same width, height, frame rate and CODEC 
name. Two files with the same width, height and frame rate but with another 
CODECs can be decompressed with Convert AVI on the Tools menu in the 
Clip Collection window. After starting the AviEdit application you should open 
the first file and look through its info. Then you need to open the second file and 
set the video’s CODEC parameters equal to those of the first file. 

3.4 Midi Tracks and Midi Clip 

 

The buttons  and  in the Track State window indicate midi sound 
tracks. 
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The appearance of all midi clips in the Working Area is similar to that of 
common clips on track. The only difference is that at the clip bottom there are 
parameters characteristic of midi clips, namely measure, current tempo and 
source tempo (for example 4/4,120[120]) at all positions where the source file 
contains tempo and/or the time signature change command. 
To call the local menu, right-click on a midi clip. Specific commands for midi 
clips are as follows: 

Tempo call the Tempo dialog box to 
modify the clip tempo (see below). 
Clip volume call the Volume dialog box named 
Clip to view/set the master volume of the clip. 
The number at the bottom of the Tempo dialog box shows 
tempo at a specified position of the original source file. The 
number on the top sets a new tempo. The vertical scrollbar 
can also be used to change the tempo (to the values in the 
range from 8 to 250 bpm). The tempo of the whole clip will 
change in the new (on top) to the original (at bottom) tempo 
ratio. 
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3.5 Audio Tracks and Audio Clip 

 

The buttons  and  in the Track State window indicate audio tracks. A 
Project may have up to 32 audio tracks. In the Track State windows, at the left of 
the audio tracks, there appear letters L and R (L = left, R = right) on the top or at 
the bottom of stereo projects (if Stereo is set in Audio Settings). This indicates 
that the points of the balance profile have been moved respectively on top of the 
balance (panorama) in the left channel or to the bottom of the balance in the right 
channel. 
The sample rate (ratio) of all audio files in the Project must be equal to that of 
the Project (see Audio Settings). The audio file first added to the Project 
determines the Project ratio. At an attempt to open a file with another ratio, 
Forward AV Studio will request that the conversion of this audio file be 
confirmed (please, note that in this case the standard re-sampling system 
CODEC is used, so the result may be poor). To select the preset standard ratio 
values, use the list in Audio Settings, or set the values manually. If the Project 
ratio is changed, all audio clips will be removed from the Project (the user will 
be asked to confirm the removal of clips from audio tracks). 
Audio clips have general features and common clip-on-track appearance in the 
Working Area, but for them some additional features are available: sound 
waveform picture, volume profile, balance profile (waveform, profiles and 
profile points are drawn in different colors, which can be selected in 
Settings Colors), clip volume under clip’s name (if the volume is not zero). The 
Edit volume profile or Edit balance profile commands on the Edit menu or Toolbar are 
used to set the profiles available for editing (active). An inactive profile is drawn 
in dark color. 
To call the local menu right-click on a clip. Specific commands for audio clips 
are as follows: 
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Clip volume call the Volume and Balance dialog boxes with the Clip 
title to view/set general volume and balance values for 
the current clip (the same can be applied independently 
to profile). 

Clips volume offset call the Volume offset dialog box to change or set the 
volume for a group of selected clips. This item is 
available only for selected clip(s). 

Profile call the submenu with the commands for 
volume/balance profile on the audio clip. The submenu 
commands include: 

Set profile value call the Volume/Balance dialog box with the title Profile 
to set the volume or the balance profile value at a 
specified position. The profile value can be replaced 
with a profile key point or the horizontal segment of the 
profile. When called on a sloping segment of a profile 
that cannot be changed manually, this command is 
accompanied by a request to insert a new key point at a 
specified position. 

Add profile point add a new key point to the profile at a specified 
position. 

Remove profile point remove from the profile the key point at a specified 
position. 

Delete profile remove all key points and set a default profile – a 
constant volume/balance level (confirmation will be 
requested). Only an active profile can be deleted (see 
the Edit menu to know how to switch between the 
volume and balance profiles). 

FadeIn apply (multiply) FadeIn profile to the current volume 
profile from the start of a clip to a specified position. 

FadeOut apply (multiply) FadeOut profile to the current volume 
profile from a specified position to the end of a clip. 

Declick a submenu for setting/removing declicks on/from audio 
clip (see also Effects Settings). 

 FadeIn/FadeOut – set/remove declick at the start/stop 
edges of the clip. 

 Set both – set declicks on both the start and stop edges of 
the clip. 

 Clear both – remove declicks from both the start and stop 
edges of the clip. 

Audio effects a submenu for working with audio effects on the current 
audio clips: 
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 Add new/Edit – call the Audio Effects list dialog box to 
add/edit audio effects on the clip; 

 Use – turn on (use)/off (bypass) audio effects on the clip; 
 Delete – remove all effects from the clip upon 

confirmation; 
 Cut – move the effects to the Clipboard; 
 Copy – copy the effects to the Clipboard; 

 Paste – replace the current effects with the effects on the 
Clipboard; 

 Add – add the effects on the Clipboard to the current 
effects on the clip. 

 Note that you may paste/delete effects on several 
selected clips simultaneously (see the Edit menu). 

Check overflow a submenu containing two commands (similar to those 
in the Command menu): 

 Normalize – call the Normalize Level dialog box to 
normalize the volume of a single clip (for the entire 
project use the Normalize command on the Command 
menu). This command can be executed by using the N 
button on the keyboard. 

 Statistics – calculate and display Sound Statistics for a 
single clip (for an entire project use the Statistics 
command on the Command menu). This command can 
also be executed by using the C button on the keyboard. 
Press Shift+C to calculate and display the statistics for the 
clip without audio effects on track, track 
volume/balance, master effects and master 
volume/balance. The two latter commands are executed 
with regard to the currently selected Range. 

Most operations with clips can also be performed using the keyboard 
accelerators. 
Note that besides volume and balance profiles each audio clip has general 
volume and balance (Clip volume on the local menu); each audio track and whole 
projects also have master volume and balance levels. Volume at each point of a 
clip is the sum (in dB) of the volume profile at this point and all master volumes 
(project master volume, track master volume and clip master volume). The same 
is true for the balance. 
Attention! The maximum volume amplification is 12 dB (4 times). At the points 
with maximum amplification, the profile touches the top of the clip rectangle and 
remains there while other profile key points may move as the master volume 
changes. Thus the profile is subject to distortions. The mixed signal may have 
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worse quality than expected. To avoid such situations, please, see that the clip 
volume profile does not touch the clip’s top edge. 

3.6 Other elements 
3.6.1 Zoom buttons 
Four zoom buttons are located in the lower left corner of the Project window. To 
change the Working Area, or part of the Project with clips on Video, Midi and 
Audio tracks displayed in the window, press the following buttons. 

 - Zoom to the whole project. 
 - Zoom to the current time Range boundaries. 
 - Increment zoom factor, preserve the current time position. 
 - Decrement zoom factor, preserve the current time position. 

Note that equivalent commands, Zoom In (+), Zoom Out (–), Zoom to Project (/), can be 
found at the bottom of the View menu, and Zoom in range (*) on the top of the Range 
menu. 
You can zoom the Working Area to any clip using an appropriate command from 
the clip local menu. 
The Working Area can also be changed in the Project Overview window, in the 
Set Size dialog box and by resetting the Scale Step. 

3.6.2 Time scrollbar 
The Time scrollbar is used to shift the Working Area by a step displayed in the 
Scale Step window. 

3.6.3 Audio tracks scrollbar 
At the right of the Working Area there appears the vertical scrollbar when the 
Project has too many audio tracks and there is not enough place in the Project 
window to display all of them. 
Audio tracks are numbered from the top to the bottom of the Project window 
with the track numbers shown in the upper left corner of the Track State 
windows. 
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3.7 Toolbar. Project 

 

The first 5 buttons on the Toolbar are equivalent to the commands on the File 
menu. 

 create a new (empty) project. If there is any open and 
unsaved project, you will be requested to choose 
between saving the changes in the current Project and 
Clip Collection and canceling the creation of the new 
project. 

 open the selected project file. 

 save the changes in the Project and Clip Collection to 
files. If the new project is saved for the first time, you 
will be requested to give the project file’s name. By 
default the project and clip collection file’s extensions 
will be *.TML and *.PRC, respectively. 

 save the project to a file under a specified file name. If a 
new Clip Collection is saved for the first time, you will 
be requested to indicate its file name. 

 call the Open Clip dialog box to insert to the Project a 
clip with reference to the whole source file content. The 
new clip will also be added to the current clip 
collection. 

 switch to the Clip Collection. See also the Clip Collection 
command on the Window menu. 

The following 7 buttons on the Toolbar are equivalent to the commands on the 
Command menu. 

 switch to different playback modes: if the button is 
pressed, the project is always played to its end. If the 
button is released (and looks like the button at the top of 
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this page), only the current Working Area is played 
(when the current time position reaches the right edge of 
the Working Area, the playback stops). 

 set the current time to Playback start. 

 start playback from the current time. To start playback 
from a specified position, double-click in the 
Working Area or the Project Overview window. 

 stop playback. 

 move the current time to the previous video frame. 

 move the current time to the next video frame. 

 call the Audio Recorder dialog box. When the recording 
is completed, you will be requested to give a target file 
name (press the Save button to insert the recorded file to 
the Project and Clip Collection). 

 

These Toolbar buttons are equivalent to the commands on the Edit menu. 

  clear the Clipboard and move the selected clip(s) to the 
Clipboard. 

  clear the Clipboard and copy the selected clip(s) to the 
Clipboard. 

 add all clips from the Clipboard to the Project to vacant 
tracks at the current time. 

 split all clips in the Project at the current time, shift 
them right, past the Project’s current time, and insert 
into the resulting gap the clip(s) from the Clipboard. For 

Forward AV Studio  21 



3. Project Working Area 

video data the current time and gap width will be 
aligned to the frame boundaries. 

  cancel the last operation if possible. 

  repeat the last cancelled operation if possible. 

 split the selected clip(s) into two parts at a current time. 
If clip(s) contain video data, the current time will be 
first aligned to the frame boundary. New clips retain 
Clip Selection status of the source file and have its 
volume and balance profiles as well as its audio effects. 

 enable editing of audio effects profiles of Audio clips. 

 enable editing of the volume profile of Audio clips. 

 enable editing of the balance profile of Audio clips (for 
stereo projects only). 

 turn on/off the Add profile point mode. This makes it 
possible to add new points to the volume/balance profile 
of Audio clips. 

 turn on/off the Multi-selection mode. This makes it 
possible to make multiple clips selection. 

 

 check overflow by making audio mix in the selected 
range and display the resulting audio volume as a color 
picture in the Range window. The volume is drawn in 
colors selected in accordance with the color thresholds 
set in the Audio meter Settings. This button is also used 
to call the Sound statistics dialog box. It is equivalent to 
the Statistics command on the Command menu. 

The following 4 buttons are equivalent to the commands on the View menu. 
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 Next mark Group - change the current Place marks group 
number in a cycle. See also Active group number in the 
Alignment Settings. 

 Next selection group - change the current Clip Selection 
group number in a cycle. See also Active group number in 
the Selection Settings. 

 Zoom In, shrink the Working Area by an increment zoom 
factor preserving the current time position. 

 Zoom Out, expand the Working Area by a decrements 
zoom factor preserving the current time position. See 
also the zoom buttons and the Project Overview 
window. 

 call the Settings dialog box (it can also be called by 
pressing F5). This command is equivalent to the Settings 
command on the Options menu. 

3.7.1 Status Bar 
The status bar is located at the bottom of the Project window. It shows 
information about any object under the mouse arrow (when the mouse arrow is 
over an object (icons on the toolbar, clips on tracks, etc.), the status bar will 
display the text information about this object). 
The table below summarizes the information that can be displayed in the status 
bar: 

Object under mouse arrow Information displayed in Status Bar 
Icon on the toolbar Short description of the action that can be 

performed by pressing this icon 
Project overview window Current limits of the Project working area (start 

and size in the current time format) 
Track state window Track name, track volume (for midi/audio tracks) 

and balance (for audio tracks only) 
Clip on a track General info: clip name, start of the clip in the 

Project: time, stop of the clip in the Project: time, 
clip duration: time (type – audio/video/midi) 
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Clip volume (for midi/audio clips), clip balance 
(for audio clips only) 
Time is displayed in the current time format. 

Left edge of a clip (clip start) General info, source in: time 
Source in = the clip starts at the beginning of the 
source file in a clip collection. 

Right edge of a clip (clip end) General info, source out: time, rest: time 
Source out = the clip ends at the beginning of the 
source file in a clip collection. 
Rest = duration of the rest from the end of a clip 
to the end of the source file in a clip collection. 

The current format of audio output in a project (the format that is used during 
playback) is displayed at the right of the status bar (the sample rate, bits depth 
and number of channels, for example, 44100 Hz/16 bits/Stereo). You can also 
change audio format in Audio Settings (press F5 and choose Audio tab). Note that 
’32 bits’ is shown for the extended and floating audio formats. 

3.8 Accelerators (‘Hot keys’) of Project window 
Action First accelerator Second accelerator 

Operations with files 

Open a source file  F4 
New project Ctrl+N Shift+F3 
Open a Project Ctrl+O F3 
Copy from the Project to the 
Clipboard 

Ctrl+Shift+O Ctrl+F3 

Save the Project Ctrl+S F2 
Save the Project as Ctrl+Shift+S Shift+F2 
Export AVI (video+audio) F11  
Export WAV (audio only) F12  

Editing 

Undo Ctrl+Z Alt+Backspace 
Redo Ctrl+Y Alt+Shift+Backspace 
Delete  Delete 
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Cut Ctrl+X Shift+Delete 
Copy Ctrl+C Ctrl+Insert 
Paste Ctrl+V Shift+Insert 
Paste under cursor Shift+P  
Insert Ctrl+I Insert 
Select all Ctrl+A  
Select None Ctrl+D  
Select next clip on track Tab  
Select previous clip on track Shift+Tab  

Zoom 

Zoom in Ctrl+’+’ ‘+’ 
Zoom out Ctrl+’-‘ ‘-‘ 
Zoom to the whole project  Ctrl+’/’ ‘/’ 
Zoom in a selected range Ctrl+’*’ ‘*’ 
Zoom to the clip Z  

Playback/current time position 

Start/Stop playback Space Enter 
Stop playback Escape  
Rewind Home Ctrl+W         W 
Playback the entire project mode Ctrl+P  
Move to next mark PgDn  
Move to previous mark PgUp  
Move to previous frame Left arrow  
Move forward 1 sec Shift+Right arrow (with video or not) 
Move backward 1 sec Shift+Left arrow  
Move forward 10 sec Ctrl+Right arrow  
Move backward 10 sec Ctrl+Left arrow  
Note: step of cursor moving is customizable in Scrubbing settings 

Scroll operations 

Scroll working area to right Alt+Right arrow  
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Scroll working area to left Alt+Left arrow  

Scroll audio tracks up Alt+Up arrow  

Scroll audio tracks down Alt+Down arrow  

Moving of selected clip(s) (with left mouse button pressed) 

Move to upper track Up arrow  
Move to lower track Down arrow  
Shift 1 ms to right (audio/midi) Right arrow  
Shift 10 ms to right (audio/midi) Shift+Right arrow  
Shift 100 ms to right (audio/midi) Ctrl+Right arrow  
Shift 1 ms to left (audio/midi) Left arrow  
Shift 10 ms to left (audio/midi) Shift+Left arrow  
Shift 100 ms to left (audio/midi) Ctrl+Left arrow  
Shift 1 frame to right (video) Right arrow  
Shift 10 frames to right (video) Shift+Right arrow  
Shift 100 frames to right (video) Ctrl+Right arrow  
Shift 1 frame to left (video) Left arrow  
Shift 10 frames to left (video) Shift+Left arrow  
Shift 100 frames to left (video) Ctrl+Left arrow  

Clip/profile operations (see also summary) 

Add/Edit audio effects A  

Use/Bypass audio effects U  

Set Volume/Balance (or profile 
value) 

V (on an audio clip)  

Set/change Volume of selected 
clips simultaneously 

Shift+V (on an 
audio clip) 

 

Separate Video and Audio to two 
independent clips 

V (on a video clip)  

Separate Video and Audio of 
group of selected clips 

Shift+V (on a video 
clip) 

 

Split S  

Add mark/Edit mark info M  
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Fade F  

FadeIn I  

FadeOut O  

Add Fade Shift+F  

Add FadeIn Shift+I  

Add FadeOut Shift+O  

Add Crossfade to two clips R  

Crossfade two clips Shift+R  

Add/Remove profile point P  

Delete part of profile D  

Delete profile Shift+D  

Move profile points (see Note) Arrow keys PgUp/PgDn keys 

Change clip volume/balance Arrow keys PgUp/PgDn keys 

Edit clip in external editor E  

Edit selected clips in editor Shift+E  

Clip Sound Statistics C  

Local Clip Statistics Shift+C  

Normalize Clip volume N  

Launch external editor E  

Set range to clip G  

Expand range to clip Shift+G  

Zoom to clip Z  

Track operations 

Add/Edit audio effects A  
Use/Bypass audio effects U  
Set Volume/Balance V  
Half height 1  
Normal height 2  
Double height 3  
Small height (locked) 0  

Other operations 
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Activate Settings dialog box  F5 
Activate Clip Collection window  F6 
Activate Faders window  F7 
Activate DDSound Volume 
Control window 

 F8 

Activate Video window  F9 
Record audio Ctrl+R  
Exit Ctrl+Q  
Note: Operations with clips, profiles, tracks are accessible when the mouse 
arrow is placed respectively over a clip, clip profile, track state window (at the 
left). The keys for changing tracks height are active when the mouse arrow is 
placed on any place on a track. 
You may also read the section about Clip Collection accelerators. 

3.9 Clip operations summary 
Note: The mouse arrow can change its shape to indicate the editing operation 
that is possible. 

3.9.1 General clip operations 
Call clip local menu click the mouse right button on a clip. 
Start playback double-click on a click to start playback of the Project 

from a specified position to the end of the window 
(Working Area). 

Clip insertion when a clip is dragged from the Clip Collection (or a 
source file is opened on a track) to the Project, it is 
displayed as a black rectangle. The mouse arrow may 
have one of the following shapes: 

  – the clip can not be inserted (for example, its 
sample rate, frames frequency or frame size are different 
from those of the Project); 

 – the clip can be inserted to the current place of the 
black rectangle; 

 – the clip can be inserted with the right part of the 
track shifted as a whole to the right. A clip can be 
inserted to the Project by a mouse left button click. 

Set clip volume / balance select the Clip Volume command from the local menu or 
press the V key over a clip. 
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Split clip Select the Split command from the local menu or press 
the S key on the place of split over the clip. 

Add / Edit audio effects select the Audio Effects group from the local menu to add, 
edit, cut/copy/paste or enable/disable audio effects. You 
can also press the A key over a clip to add/edit audio 
effects. 

Add mark / Edit mark info select the Add Mark command from the local menu or 
press the M key on a desired place to add a new mark to 
the clip or edit one of the existing clips. 

View / Set properties select the Properties command from the local menu to 
activate the dialog box with clip properties. 

Sound Statistics select the Check overflow/Statistics… command from the 
local menu or press the C key on the keyboard when the 
mouse arrow is over a clip to check overflow/get 
statistics for a single clip. Press Shift+C if you want to 
view the statistics for a clip without track volume/audio 
effects and master volume/audio effects. 

Normalize select the Check overflow / Normalize… command from the 
local menu or press the N key on the keyboard when the 
mouse arrow is over a clip to normalize volume of a 
single clip. 

3.9.2 Selection 
Select one clip click on the desired clip. 
Select clips press the mouse left button on a place not occupied by 

clips and drag the mouse. All clips encompassed with a 
specified selection box will be selected. 

Select / deselect many clips 
 press the Shift key or turn on the Multiselection mode 

(Toolbar, Edit menu). When the mouse arrow has  
shape, the following actions revert the selection of 
clip(s) (selected to unselected and vice versa): 

 1) Click on a clip – for this clip; 
 2) Double-click – for all clips on a track starting from a 

specified position. Use the right Shift key to select all 
clips before a specified position. Note that on some 
keyboards the right and left Shift keys do not differ. 

 3) Press the Ctrl key instead of Shift and double-click on 
a track to select all clips on all tracks after/before a 
specified position. Note that on some keyboards the 
right and left Ctrl keys do not differ. 
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 4) Press the left mouse button and drag mouse – all clips 
rounded or touched by specified selection box. 

Clear selection click on area not occupied by clips or select Deselect all 
command from the Edit menu. 

Select next clip on a track 
 if you have selected any clip on a track, press Tab button 

to select next clip on the same track, or Shift+Tab to 
select previous clip. 

3.9.3 Moving 
Move selected clips  – press left mouse button and drag. 
Move Left clip edge  – press left mouse button and drag clip edge. If clip 

has video the first frame will be displayed on 
videoplayer. 

Move Right clip edge  – press right mouse button and drag clip edge. If 
clip has video the last frame will be displayed on 
videoplayer. 

Move mark  – press left mouse button and drag mark. 

3.9.4 Audio volume/balance profile editing 
Add key point to audio profile 
 press Ctrl key or turn on Add profile point mode (Toolbar, 

Edit menu). In this mode cursor has  shape. Each 
click inside audio clip rectangle adds new key point at 
specified position. You can also press and hold Ctrl and 
click on any place of clip to add new profile point or 
remove existing. P key will add/remove profile point 
without changing current profile value. You can use this 
to quickly add 4 points to a horizontal profile and move 
up/down a segment of profile (add 2 points at the left 
corner of segment and 2 points at the right one). 

Move profile key point – press left mouse button and drag. If you press and 
hold Alt key before this, the point preserves its profile 
value. You can also set mouse cursor over a point and 
use arrow keys and PageUp / PageDown keys on keyboard. 
Use Shift or Ctrl keys with arrow keys to change step of 
point moving. 

Move horizontal profile segment 
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  – press left mouse button and drag up or down 
horizontal segment of profile (between two key points 
of audio clip profile with equal profile values). 

Shift sloping / vertical profile segment 
  – click left mouse button and drag to left or to right 

the sloping/vertical segment of profile (between two key 
points of audio clip profile with different profile 
values). 

Delete profile point  – call local menu (right-click) and select 
Profile/Remove profile point or press P over a point. 

Clear audio profile call the local menu (right-click) and select the 
Profile / Delete profile command or press Shift+D when 
mouse cursor is over a desired clip. This resets profile to 
default 0 dB constant (0% for balance profile). 

Clear part of profile press D on a desired place of profile, a part of profile 
will be deleted. Left part of profile is deleted if you 
press D closer to left edge of clip, right part otherwise. 

FadeIn / FadeOut move mouse cursor to a point where fade should be 
applied, and press F key. FadeIn is applied if you press 
F closer to left edge of clip, FadeOut otherwise. Use I 
key to set FadeIn, O key for FadeOut. Fades replace 
part of profile. 

Add FadeIn / FadeOut if you press and hold Shift key before pressing F, I, O, 
fade is only added to profile, and not replaces existing 
profile. 

Crossfade select two audio clips that cross each other and press R 
button to crossfade volume between two clips. See also 
Crossfade command from the Edit menu. Crossfade 
profile is added to current profile of clips. Press Shift+R 
to replace current existing profile by crossfade profile. 

Set Profile value select Set profile value command on local menu or press V 
key when mouse cursor is over profile point  or 

horizontal fragment of profile . 
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4 Main menu 

4.1 File menu 
This menu is used to save/open Projects and to save the result of work to 
multimedia files (export). Most commands on this menu are also available on the 
Toolbar. 
Project files (having .TML filename extension) are normally associated with 
Clip Collection files (with .PRC file name extension). A clip collection can be 
used with different Project files. Save project and Open project commands are used 
to save/open both the Project and associated Clip Collection. 

New project create a new (empty) Project in the New Project dialog 
box. 

Open project open the Project and associated Clip Collection. 
Append project… open a project and append it to the end of current 

project. Its clip collection is added to the current clip 
collection. 

Add source File call the Open Clip dialog box to select the source file 
and add a clip with reference to the whole source file 
content. Simultaneously multiple files can be added 
only to a Clip Collection. 

Save project  save changes to Project and Clip Collection files. 
Save project As save the Project to a specified project file (in a new 

location). For a new Clip Collection the user will be 
requested to indicate the clip collection's file name. 

Save All copy the Project, Clip Collection and all source files to 
a specified directory. The source files present in the clip 
collection but not used in the Project can be excluded 
from copying. 

Move All move the Project, Clip Collection and all source files to 
a specified directory. All source files are deleted from 
their original location! Be careful while using this 
command as you may erroneously delete some source 
files that are used in other Projects. The source files 
present in the Clip Collection but not used in the Project 
can be excluded from moving. 

Close close current project and clip collection and leave all 
tracks and clip collection empty. You can start working 
with new project or open any other already existing 
project after that. 
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Saving the result of work to an external multimedia file: 
Export mix active tracks of the Project in a specified range (or 

the whole project if no range has been selected) and 
save the results to a file of the selected format (please 
note that MIDI files are not included in the mix!): 

AVI write the resulting video and audio data to a specified 
AVI-file or video file only if no audio is present in the 
Project. 

Wave write the resulting audio data to a specified WAVE-file 
(standard Windows audio format). 

Multiwave write the parts of the resulting audio data to several 
WAVE-files. By using this command you can prepare 
audio files for audio CD tracks. For more detail, read 
the section about exporting multiple files. 

Aiff write the resulting audio data to a specified AIFF-file 
(Mac audio format). 

Any Export command calls the export dialog box. 
Note that if the program you use is unregistered, only the first 10 seconds can be 
saved to the resulting file! 

Recent files call the list of the most recently used Project files. From 
the list you can select any file for opening. The error 
message appears if a Project file is not found in its 
original location. If the Project has been moved to 
another place, use the Open Project command to open it. 

Recent clip folders call a list of the most recently used folders for opening 
clips. Select any folder to add a file to the Project and 
Clip Collection. 

Exit exit from Forward AV Studio. 

4.2 Edit menu 
On this menu there are commands for various editing operations. Most 
commands on this menu are also available on the Toolbar. 

Undo cancel the last operation, if possible. 
Redo repeat the last canceled operation, if possible. 

Most of the following commands are available only if a group of clips (at least 
one) is selected (see also clip operations summary): 

Delete remove the selected clips from tracks; 
Cut move the selected clip(s) to the Clipboard; 
Copy copy the selected clip(s) to the Clipboard; 
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Copy from file copy all clips from a specified Project file to the 
Clipboard; 

Paste add all clips from the Clipboard to the Project at the 
current time position to free tracks; 

Insert split all clips at the current time, shift them to the right 
and insert in the gap clips from the Clipboard. If clips 
contain video data, the current time and gap width will 
be aligned to the frame boundaries; 

Split divide the selected clip(s) into two parts at the current 
time. If clips contain video data, the current time will be 
aligned to the frame boundary. The new clips will 
preserve the status of Clip Selection original files and 
have their own copy of volume/balance profiles and 
audio effects; 

Cross fade available only for the selection of exactly two 
overlapping audio clips. FadeOut is applied to the left 
clip and FadeIn to the right clip in the overlapping 
region; 

Delete profile delete profile on all selected clips (reset profile to 0 dB) 
after the confirmation; 

Declick set/remove declicks for the group of selected clips. The 
submenu commands include: Set FadeIn/FadeOut/Both (set 
declicks to start/end/both edges of clips), Clear 
FadeIn/FadeOut/Both (remove declicks from start/end/both 
edges of clips after the confirmation); 

Audio effects allow to add/delete, switch on/off audio effects on all 
selected clips. The submenu commands include: Delete 
(remove audio effects from the clips after the 
confirmation), Paste (replace effects on the clips with 
effects from the Clipboard after the confirmation), Add 
(add effects from the Clipboard to the effects already 
present on the clips). Both Paste and Add commands 
require that effects be copied to the Clipboard. Set 
using/Clear using – switch on/off (bypass) effects on the 
clips. 

Editing modes: 
Edit Volume profile switch to the mode of audio clip volume profile editing; 
Edit Balance profile switch to the mode of audio clip balance profile editing 

(for stereo projects only); 
Edit Effect profile switch to audio effects profile editing mode of audio 

clips. See also section about working with audio effects. 
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Add profile point mode allow to add new points to volume/balance profile in 
audio clips; 

Multiselection mode allow multiple clips selection; 
Select All select all the clips of the Project (reset other selection 

groups); 
Deselect All deselect all the clips of the Project (reset other selection 

groups); 
Invert selection select all unselected and deselect all selected clips in the 

current selection group. 
Forward AV Studio Clipboard 
Clips in the Clipboard preserve their relative time position and track number. 
Each Cut/Copy command is used to clear previous Clipboard contents. The 
Copy/Add commands in the Clip Collection window are used to add clips to the 
first track only. 
Add profile point mode 

If the mouse arrow shape is , the Add profile point mode is on (Toolbar, Edit 
menu, or when the Ctrl key is pressed). By clicking in the audio clip rectangle 
you add a new point to the volume/balance profile at a specified position. 
Multiselection mode 

If the mouse arrow shape is , the Multiselection mode is on (Toolbar, Edit menu 
or when the Shift key is pressed). In this mode, the following actions invert the 
clip selection state (change selected to unselected and vice versa): 
1) click on a clip - invert the selection of this clip; 
2) double click on a track - invert the selection of all clips on the track from a 
specified position; 
3) press the mouse left button and drag it to invert the selection for all clips 
touched by or encompassed with a specified selection rectangle. 
See also Clip Selection. 

4.3 View menu 
This menu is used to define the appearance of the elements in the Project 
window. Most commands of this menu are also available on the Toolbar. 

Next mark Group change the current Place marks group number in a 
cycle. See also the Active group number command in 
Alignment Settings. 

Next selection group change the current Clip Selection group number in a 
cycle. See also the Active group number in 
Selection Settings. 
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Show Video tracks enable the display of video tracks. 
Show Midi track enable the display of midi tracks. 
Show Audio tracks enable the display of audio tracks. 
Show audio meter (faders) 
 show the Audio meter (Faders) window. Analogous to 

the Audio meter (Faders) command in the Window menu (or 
press F7 key). 

Show mixer show the DDSound Volume Control window. 
Analogous to the DDSound Volume Control command in 
the Window menu (F8 key). 

Audio tracks Height the submenu commands Double, Normal and Half change 
the height of ALL audio tracks in the Project window. 
See also the Track State window. 

Using the following 3 commands you can select the current format for time 
values. 

Time in Frames time as a frame counter. 
Time in SMPTE “Hours: Minutes: Seconds: Frames”. 
Time in miLliseconds “Hours: Minutes: Seconds: Milliseconds”. 

Using the following 3 commands you can change the size of tracks 
Working Area. See also the zoom buttons and Project Overview window. 

Zoom In increment zoom factor retaining the current time 
position. 

Zoom Out decrement zoom factor retaining the current time 
position. 

Zoom to Project expand the working area to fit the entire project. 
You can also zoom to any clip using the Zoom to clip command on the clip local 
menu or pressing the ‘Z’ key on the keyboard when the mouse arrow is over the 
clip (see also the section about keyboard accelerators). 

4.4 Command menu 
This menu provides generic operations to work with Projects. Most of these 
commands are also available on the Toolbar or through hot keys on the 
keyboard. 

Play start playback of the current Project. 
Stop stop playback. 
Record audio… open the Audio Recorder dialog box. Prior to 

performing this command the program may request to 
specify the target file name. 

Next frame move the current time to the next frame. 
Previous frame move the current time to the previous frame. 
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Rewind move the current time to Playback start (to the start of 
either the Project or selected range). 

Playback entire project this command is used to switch to different playback 
modes. When on, this option provides for the Project to 
be played to the end. When off, it provides for only the 
current Working Area to be played (when the current 
time position runs up to the right edge of the 
Working Area, the playback stops). 

Master volume… set the Project's master Volume and Balance. If the 
Audio meter (Faders) window is opened, it gets 
activated with the focus being set to the master volume 
fader. 

Master Effect(s) these commands are used to work with master audio 
effects, which are applied to the entire project. The 
submenu commands are as follows: Edit (add or edit 
audio effects), Use (switch effects on/off), Delete 
(remove effects), Cut (move effects to the Clipboard), 
Copy (copy effects to the Clipboard), Paste (replace 
effects with effects from the clipboard), Add (add effects 
from the Clipboard to the current effects). 

Normalize audio… call the Normalize Level dialog box after responding to the 
request to set the maximum level of audio output. This 
dialog box is used to adjust the Project's master volume 
with audio to be normalized to a selected level. 

Normalize audio of selected Clips… 
 changes volume level of all selected clips so that 

maximal volume level of each clip coincided with a 
level specified in dialog Normalize Level. After a level 
it is specified, consecutive normalization of a sound is 
made for each of the selected clips. 

Statistics… (Check overflow) 
 mix audio on the active tracks in a selected range and to 

show the resulting audio volume as a color picture in the 
Range window. The colors in Audiometer Settings are 
used to indicate the volume level thresholds. Following 
the calculations, Sound statistics are displayed and can 
be analyzed. 
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4.4.1 Sound Statistics 
This dialog box is called with the Statistics (Check overflow) command from the 
Command menu or the Range window local menu. You can also press the C key 
on the keyboard for calling sound statistics of an audio clip, or Shift+C to view the 
statistics with no regard for the volume and audio effects of the track or project 
master volume/audio effects. 

 

The Sound Statistics dialog box displays the following information about sound 
in each channel: 
Total samples, Time – the number of samples and duration of the analyzed audio. 
Clipped samples – the number of clipped samples (the sample value over 0 dB). 
Note: 0 dB level is assigned to the maximum absolute sample value of 32768. All 
values below the maximum value are shown in sample and dB values relative to 
0 dB level (normally all values are less than 0 dB, otherwise the clipping is 
elsewhere). 
Positive max level – the maximum level of positive samples. 
Negative max level – the maximum level of negative samples. 
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Average level – the average absolute level of all samples. 
Average RMS level – the average RMS (root mean square) level. By adding 3 dB to 
this value you get the RMS power of the sound and, thus, can estimate the 
average power of the sound. 
DC offset – a constant offset of sound (is shown as a sample value and in percent). 
If not equal to 0%, this value indicates that the maximum positive and negative 
levels may differ implying that the sound is not centered on the zero sample. 
The Copy button is used to copy to the Clipboard all data displayed in the dialog 
box. The data will be saved in a text format and can be pasted to any text editor, 
saved to file, printed etc. 
Note: You can also use sound statistics as an audio “effect” in order to view 
these statistics during real-time playing. 

4.5 Range menu 
Range is a time interval set by the user for further use in various operations 
(playback, export to file etc). The selected interval is displayed as a blue box in 
the Range window. 

Zoom in range set the Working Area equal to the selected range. (see 
also Zoom buttons). 

Include all clips set the range so that it covers all clips in the Project, 
except the clips on the switched-off track. 

Select between Marks set the range between marks, including the current time 
mark. 

Clear selection undo the range selection. 
The editing commands below are used to operate on the clips on track within a 
selected range and/or on parts of clips within a range whose bounds intercept 
them. Each operation can be executed by the following submenu commands – 
all tracks, active tracks, selected clips, to select for editing all tracks in the Project, 
only tracks included into playback (active) or only selected clips from the current 
selection group. 

Copy copy the clip(s) and/or parts of the clips from all tracks or 
active tracks to the Clipboard. 

Cut cut the clips (parts of the clips) from all tracks or 
active tracks to the Clipboard, and then shift the right 
part of each track to the left to fill the gap. 

Clear clear part of the Project on all tracks or active tracks. 
FadeIn apply the FadeIn profile within a range to audio clips on 

all tracks, or active tracks, or to the selected clips only. 
FadeOut similar to the above for the FadeOut profile. 
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4.6 Tools menu 
Each menu item is used to launch an application as set up in the 
Configure external applications dialog box. 

 
Volume control launch the Volume control application (by default 

standard “sndvol32.exe”, which shall be installed by the 
user). 

Audio editor launch the Audio editor application. 
Midi editor launch the Midi editor application. 
Video editor launch the Video editor application. 

The menu can contain up to 5 commands defined in the 
Configure external applications dialog box. For example, for an image there will 
appear the following two commands: 

Recorder 
Calculator 

and the command: 
Configure… call the Configure external applications dialog box. 

4.7 Options menu 
Settings… call the Project Settings dialog box. 
Fade profile… call the Fade profile dialog box. 
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Font for Labels… call the dialog box for setting fonts for labels to be 
displayed in the Project window; in particular the time 
labels values in the Time Ruler, Current Time window. 

Font for clip Name… call the dialog box to set fonts for the displayed names 
of clips on tracks. 

Save Options save the program settings. Actually this is not necessary 
as all settings are saved automatically each time you 
exit the Forward AV Studio or save the Project. 

4.8 Window menu 
Clip Collection activate the Clip Collection window. 
Faders (Audio Meter) activate the Audio meter (Faders) window. 
DDSound Volume control 
 activate the window of DDSound Volume Control 

application. This application is used to adjust the 
settings of audio devices. See also Audio Devices Settings. 

Video show the Video preview window, if possible. 

4.9 Help menu 
This menu is almost the same as the menu in the Project and Clip Collection 
windows: 

Project window description 
 appears in the Project window; 
Overview show general characteristics of Forward AV Studio; 
Contents help contents; 
Audio Effects help for audio effects; 
DDSound Volume Control 
 help for the DDSound Volume Control application. 
Using help standard Windows Help (the use and customizing of the 

help system); 
About… information about Forward AV Studio developers and 

registration. 
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5 Settings 
This dialog box contains various settings and options for the current Project, 
which are on the following tab panels: 

General Project limits, undo and playback options; 
Audio audio settings (playback format and options); 
Devices audio devices selection; 
Effects audio effects settings; 
Video video options (frame rate and playback options); 
Troubleshooting special troubleshooting modes; 
Audio meter volume indicator settings; 
Alignment alignment and snapping to marks options; 
Selection selection options; 
Scrubbing scrubbing options; 
Save save and auto save options; 
Colors colors of user interface elements; 
Summary embedded info fields (text information saved with the 

Project and to output files). 
To call this dialog box in the Project window, use the Settings command from the 
Options menu or Toolbar (or just press the F5 key when the Project window is 
active). 
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5.1 General Settings 

 
Project limits - set the Project's basic parameters. 
Project size – set the duration of the entire Project. 
Audio tracks – set the number of audio tracks in the Project. 
Undo / Redo depth – set the number of Undo / Redo operations. 
Playback - select a playback mode. 
Repeat playback - set the number of playback repetitions initiated by the Play 
command. Note that mouse double-click on the Project overview window or on 
the tracks in the Project window starts the playback from a specified position, 
which then proceeds to the end of the Project. In this case there are no 
repetitions! You can use this option by starting the playback with pressing the 
Play button on the Toolbar or the Space key on the keyboard (see also the section 
about keyboard accelerators). 
Start video playback - set the mode of a video Project playback: immediately or on 
a keyboard event (you have to press the Space key after the Play command). 
Start playback from Current time position - turn on the VTR playback mode. If this 
mode is on, the Play command starts the playback from the current time position, 
which remains the same after the execution of the Stop command and playback 
stop. If this mode is off, the program sets the playback start position in the 
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Playback Start and Playback Duration windows. On the execution of the Stop 
command the current time position reverts to the previous time position that was 
current before the playback start. 
Hide cursor during playback – if checked, the current time mark (vertical line) will 
not be drawn over the Project tracks. Instead, the current time mark will be 
drawn in the Time Ruler and Range windows. This option reduces the system 
load during playback and can increase performance. 
Enable solo / mute control during playback – this command is used to dynamically 
include/exclude audio tracks from mixing during playback. If turned off, this 
option disables the Solo / Mute buttons during the playback. 

5.2 Audio Settings 

 

Output Format – this group is used to set the playback audio format for the current 
Project. 
Ratio – set audio sample ratio (in Hz or samples per second). All audio clips on 
tracks must have the same ratio (an audio file first added to an empty Project sets 
it automatically). The ratio values may be selected from the list (standard ratios 
up to 48 kHz are supported by almost all sound cards). Arbitrary values can be 
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set manually. If you change the Project ratio, all audio clips will be removed 
from the Project (upon confirmation). 
Resolution – set audio sample resolution (the number of bits per sample) for the 
current Project. In the professional Forward AV Studio package you can select 
20/24 bits per sample. If your soundcard does not support 20/24-bit formats and 
you want to playback such projects, you can choose the Limit playback to 16 bit 
option in Audio Device Settings. 
Stereo – number the Project's channels (mono/stereo). 
Advanced – call the advanced format selection dialog box to select different 24-bit 
format modes. 
Optimization – this group is used to tune the parameters that can improve the 
playback performance. 
Buffer size – set the premix buffer size in seconds. If the values are small, there 
may be breaks in the sound during playback. In this case try to set higher value, 
which may be of no help if your computer is not fast enough to mix and playback 
many tracks in real time. These parameters also affect the length of the delay 
between the moment when you manually change the track volume in the Faders 
window and the moment when the real change of the volume occurs. 
Waveform – is used to control the quality of waveform pictures displayed on audio 
clips. For better quality more resources are required, which may result in slower 
performance of Forward AV Studio in working with complex projects (with 
many clips on tracks). If you encounter very slow redrawing of audio clips, try to 
decrease the quality to ‘draft’ or turn off the waveform pictures. 
Background priority – is used to set the priority of background thread for filling the 
waveform pictures of audio files. When you add any audio file to a Project or 
Clip Collection, Forward AV Studio starts filling the waveform background 
picture for this audio file. Therefore, you need not wait for the picture to be filled 
and may continue your work. You may set high priority to filling thread and 
increase its performance, but this may lead to lower performance of the 
operations with the main project window. There may also result in delays in 
keyboard- or mouse-triggered actions during the filling of waveform pictures. 
Dither - this group is used to set dithering parameters for audio playback. 
Type of dithering: truncating, rounding (round and then truncate) or dithering 
(add noise and then truncate). If ‘dither’ type is selected, the following two lists 
are available. 
Depth – add the amplitude of noise to the audio signal. The default value 0.54 is 
good for most applications. Values may be in the range of 0.01 to 2.0 bits. 
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p.d.f. – the probability distribution function of a generated noise. Possible types 
are rectangular, triangular and Gaussian (different types result in different 
sound). Please note that noise generation requires additional calculation time. 
Auto-compensate DC-offset – if this option is on, all new audio files added to the 
Project will have an auto-compensated DC-offset. That means that the file will 
be centered around the zero sample, so you may change the volume of this file 
without distortions caused by a non-zero DC-offset. You may turn on/off the 
DC-offset compensation option for any audio file in a Clip Collection (see file 
audio properties). 
Show clip volume on clips – by turning this option on you call the information about 
the clip volume (shown in parentheses with clip name). Note that clip volume is 
not shown if it is equal to 0 dB (set by default). Clip volume is shown in the 
color of the volume profile with the color scheme to be set in Colors Settings. 
Line width of active profile – on audio clips in pixels (from 1 to 3). Increase it to 
make active profile better visible. 

5.2.1 Advanced audio Format 

 

In this dialog box you can select a specific type of 24-bit audio format. The 
standard format is ‘24-bit packed int’, professional 24-bit soundcards should 
support such a format for playback/recording. This format is used by default. 
Additional 4 formats may be unsupported, so, please, read the documentation for 
a particular soundcard. In any case, Forward AV Studio can open and save audio 
files of all types, you can play them on any soundcard in any mode supported by 
it (e.g. 16-bit). 
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Please note that all such formats are actually 24-bit only: float formats have 24-
bit mantissa (only 24 accuracy bits are significant), and ‘32-bit unpacked int’ 
format actually uses only 24-bits. 
Warning: please, be careful when trying to play audio on your soundcard in 
non-standard modes for the first time! Depending on soundcards’ settings you 
may get very loud noise that can damage your headphones, speakers and ears! 
Please, on your amplifier set the volume at minimum and/or take off the 
headphones prior to testing your soundcard in 24-bit modes for the first time. 
The normal volume can be set only after you have tested your soundcard in the 
mode you are going to use. 
Audio formats supported by Forward AV Studio are: 
Standard formats: 
  8-bit (packed int, type 1) 
  16-bit (packed int, type 1) 
Extended formats: 
  20-bit (packed int, type 1) 
  24-bit (packed int, type 1) 
  32-bit (unpacked int, type 1) 
Float formats (32-bit): 
  ‘24.0’ (type 1) 
  ‘16.8’ (type 1) 
  ‘0.24’ (normalized, type 3) 
Forward AV Studio can open/export uncompressed audio files of such formats, 
and playback/record audio (in formats supported by your soundcard). 
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5.3 Video Settings 

 

Frame rate sets the video frame rate of a Project. The video clip first added to a 
Project with empty video tracks resets this value.  
Show information about dropped frames. During playback some video frames may be 
dropped. Check this box to display the information about the dropped frames in 
the dialog box after playback. 
Draw first and last frames at clip Edges turn on drawing first and last frames at left 
and right edges of each video clip. 
Start from Key frame only. Video in AVI-files may also have frames other than key 
frames. If a video clip starts not from a key frame, during playback in the Video 
window its first frames (up to the next key frame) may be drawn with noise. 
Such frames will have red borders. Check this switch to prohibit setting the clip 
left edge (time In) at a non-key frame. In any case, an exported AVI-file will 
have correct video data. 
AVI group. 
Playback mode list is used to select the mode of video data decompressing and 
drawing. Video codec may not support some of the playback modes. 
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Full screen – decompress and draw frames on an external monitor or full screen 
by video codec. 
Decompress directly to window – decompress and draw frames directly in Video 
window by video codec. 
Decompress and then draw – decompress frames by codec and draw them on video 
player (Video window) by Forward AV Studio. 
Decompress to SLTM player (FDTM board) – decompress frames by codec and send 
them for playback on FDTM (FD300) board. See ‘Playing video on FD300 
boards’ for more details. 
None – do not playback video. 
Default – a playback mode for codec is automatically selected by 
Forward AV Studio starting from Full screen mode. 
Synchronize to audio - turn on synchronization of video playback to audio 
playback. In this mode any delay in audio playback causes the same delay in the 
next video frame. 
Never yield hardware device normally should be unchecked. It may be useful in 
special cases, for example, when Forward AV Studio works together with 
hardware video CODEC on the air. Check this box to prohibit the release of 
CODEC when the project window is minimized or an external application is 
launched by Forward AV Studio. 
Zoom list is used to select the scale factor for the Video window. 
Always on top – keep the Video window always on top of other windows. 
Minimize to taskbar – this function is used to minimize the Video window to the 
system taskbar. If checked it allows the activation of the Video window from the 
taskbar or via Alt+Tab, independently from the Forward AV Studio main project 
window. 
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5.4 Troubleshooting Settings 

 

Use playback starting delay in full-duplex mode. Successive start of playback and 
recording is used when some sound card drivers fail to playback and record 
audio simultaneously. Delay sets delay duration in milliseconds. 
Reopen video codec at any operation. In this mode, video codec is reopened at each 
access. This allows working correctly with hardware video codecs such as that 
for microVideo DC20. Attention! This mode may decrease video performance 
for most video codecs. 
Bypass DirectX plug-in chainer when opening project – turn on this mode if you 
encounter program crash during opening project with DirectX plug-in chainer 
(note that crash may be caused by plug-in, not Forward AV Studio itself). You 
will lose all instances of DirectX plug-ins in opened project, but you will be able 
to keep all other portion of your work. Suggestion: when you add DirectX plug-
in, tune its settings and save its state to preset using plug-in’s dialog – you will 
be able to quickly restore state of plug-in in the future by just selecting it from 
list of saved presets. 
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5.5 Audio meter Settings 

 

Audio volume color indicator is set in the Audio Recorder and A.Meter (Faders) 
dialog boxes. The Statistics (check overflow) command from the Range window 
local menu is also used to set correspondence between the volume level and its 
color representation. 
Thresholds group is used to set correspondence between audio volume level and 
indicator color. The delimiting values shall be in the range of 0 dB to –144 dB 
and the intervals may not overlap. 
Meter Size is used to set audio volume range represented by the indicator. The top 
value is always ‘absolute’ digital 0 dB (in Forward AV Studio, this value 
corresponds to the maximum absolute sample value of 32768.0). 
Peak hold enables the display of the peak mark (a thin color band in the meter). It 
shows the maximum peak level found during playback/recording. To clear the 
peak mark just click on the meter or select an appropriate command on the local 
menu. 
Always on Top – keep the audio A.Meter (Faders) window always on top above 
the Clip Collection and main Project windows. 
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Minimize to taskbar – this function is used to minimize the A.Meter (Faders) 
window to the system taskbar. If checked it allows the activation of the 
A.Meter (Faders) window from the taskbar or via Alt+Tab, independently from 
the Forward AV Studio main project window. 
 Labels group is used to control the volume text labels (shown close to the meter). 
Automatic – select some values in dB automatically and display them as text 
labels with reasonable spaces between them. Or you can set up to 10 pairs of 
Volume, Name labels manually. 
‘0’ position set the position of label 0 for automatic text labels. Note that zero shift 
or ‘0.000’ value is used by default. 
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5.6 Alignment Settings 

 

These settings control alignment (snapping) of objects (clips on tracks, clip edges 
and current time position mark) when you move them with the mouse. 
Time alignment group: 
Align current time mark to the nearest Frame - turn on the alignment of the current 
time mark to the nearest video frame. 
Align clip Edges to the nearest frame - turn on the alignment of clip edges to the 
nearest video frame. 
Snap group: 
Snap Distance – set the maximum distance of snapping objects in pixels. For 
example, if the Current time marker (see below) option is on, you can drag the 
current time cursor close to a mark and it just jumps exactly to the mark (‘snaps’ 
to it). Snap distance is a maximum distance between objects (in pixels) at which 
they can snap to each other. 
Snap clip edges to current time position – snap the edges of the clip you are moving 
to the current time cursor. It can be used to align the clip edges to the same time. 
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Snap selected clip edges to non-selected clip edges – edges of only selected clips will 
snap to edges of non-selected clips. 
Snap to marks group is used to set conditions of snapping objects to place marks 
during objects moving: 
Current time marker enables snapping of the current time position cursor to marks. 
Mouse position – snap the mouse cursor position to marks while dragging clips or 
time position. When the mouse cursor remains within the snap distance, the 
selected clips are not moved. 
Leftmost edge of selection – align the leftmost edge of selected clips to marks. 
Left edges of clips – align the left edge of each selected clip to marks. 
Rightmost edge of selection – align the rightmost edge of selected clips to marks. 
Right edges of clips – align the right edge of each selected clip to marks. 
Active marks – by choosing this option can snap marks of an active group to each 
other. 
Active mark group Number – set the number of active group marks (all objects snap 
only to the marks of an active group). 

5.7 Selection Settings 
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Active group number – set the number of active Clip selection groups. Other groups 
become inactive. 
Exclusive ‘Solo’. In this mode, only one track marked, as ‘solo’ will be included in 
the playback. 
Do not drag current time mark. If this option is unchecked and the time range is set 
in the Range window the current time mark can also be dragged. 

5.8 Save Settings 

 

Save with Clip Collection group is used to specify what additional information must 
be saved with clips in Clip Collection. 
Thumbnail picture – turn on the function of saving thumbnail picture for each video 
clip in Clip Collection. 
Waveform picture – turn on the function of saving waveform picture for each audio 
clip in Clip Collection. Opening clip collection next time requires no 
recalculation of waveform pictures for audio files. 
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AutoSave group is used to define the time and place for auto saving of the project 
and clip collection. If your system or Forward AV Studio crashes, you will be 
able to restore your work in the state as of the moment of auto saving. 
Save project and clip collection every XX minutes/YY actions. Turns on saving the 
current Project and Clip Collection at a specified interval (XX minutes) and/or 
after a specified number of changes (YY actions). 
Temporary directory – create a directory for autosaved files with the name 
autosave.tml and autosave.prc. Read/Write access to this directory is required 
(C:\ by default). If Forward AV Studio is run after the program or system crash 
and Forward AV Studio finds autosaved files in a specified directory, you will be 
requested to open the autosaved project. After opening the project you will have 
to save it to a desired place manually. 

5.9 Colours Settings 

 

Here you can adjust colors of almost all elements of Forward AV Studio user 
interface. You can select a desired item by choosing its name in the drop-down 
list or click on an item in the sample picture. It is possible to keep the mouse 
button pressed and move the cursor around. 
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Change color - call the standard color selection dialog box to set color for the 
selected item. Color settings are reflected in the picture. 
Colors combination can be stored in files with default .CLT extension. To save 
color settings, click Save scheme, then select a directory and file name. 
Load Scheme - restore the previously saved colors combination from a file. 
Default scheme - reset colors to a predefined color scheme. 
When you press the Apply button, all colors changes are applied immediately in 
Forward AV Studio. 

5.10 Summary Settings 

 

Various information fields can be embedded in the exported audio and video 
files (File / Export in the Project window). Some of these fields are present in this 
dialog box. Text strings with up to 255 characters can be entered as any field 
value. 
Don’t export fields – if unchecked, this function allows including all non-empty 
fields in the output file. Two additional fields are always saved. One is the name 
of the software package, ‘Forward AV Studio. Multitrack Audio and Video 
Editor’ (with the version you are using). The other field is for the date of output 
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file creation in the form YYYY-MM-DD; for example, ‘1998-05-01’ for May 1, 
1998. 
Extended allows viewing and editing ALL available fields in the 
Extended Summary dialog box. 
Set as Default allows saving all currently defined fields for later use as the default 
settings for newly created projects. 

5.10.1 Extended Summary dialog box 

 

Fields that can be embedded in the exported audio and video data files are 
available for editing in this dialog box. Some of them appear also in the 
Summary Settings. Each field is represented by its short name and human 
readable name. A text string of up to 255 characters can be entered as the field 
value. If the field has no associated text string, it is marked ‘(Empty)’ at the right 
part of the list box. Empty fields are not saved, see also Don’t export fields witch in 
the Summary Settings. 
Reset button is used to clear summary info fields. Set as Default button allows 
saving currently defined fields for later use as default settings for newly created 
projects. 
The dialog box can be called from the Summary panel in the Settings dialog box. 
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5.11 Devices Settings 

 

Devices group is used to select audio devices installed on your system for sound 
playback and recording. 
Output – a device for digital audio playback (in WAVE format). 
Input – a device for recording digital audio (in WAVE format). 
Midi – a device for MIDI music playback. Please, note that Forward AV Studio 
plays MIDI through system midi-stream that can work on the MIDI mapper only, 
so no actual MIDI device can be selected for this purpose. You should open the 
system Control Panel (open Settings / Control Panel from the Windows Start menu), 
double-click the Multimedia icon and select a desired default MIDI Out device in 
the MIDI tab. 
Click here to see an example of MIDI device selection in Windows-98 control 
panel (‘DS-XG Synthesizer’ is selected as default MIDI device. 
Forward AV Studio will use it to play MIDI). 
Limit playback to 16 bits – if you open a project with 20/24-bit audio output format 
(see Audio Settings) but your soundcard can play only 16-bit sound, turn this 
option on to limit the output quality to 16-bit. If you have a soundcard with 20-
24 bit sound capability, you may turn this option off. 
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DDSound Volume control (mixer) is an additional application of 
Forward AV Studio. It can be used to adjust your audio device settings: to set 
volume, to turn on/off audio outputs for playback and select source inputs for 
recording. This mixer is user-friendlier compared to similar standard system 
applications (you can run it using the Volume Control command on the Tools 
menu). With the mixer you can adjust volume in decibels (dB), save the status of 
any audio device and restore this status in future. 
Show mixer on startup – turn this option off if you do not want to see the mixer 
main window on Forward AV Studio start (still, it will remain active and 
operational). 
Automatically change mixer status – when you start playback/recording in 
Forward AV Studio, the mixer recalls and activates a saved status of the audio 
device appropriate for playback/recording. 
Configure mixer – activates the mixer’s window. You can also use the 
DDSound Volume Control command from the Window Menu or press F8 key. 
You can use DDSound Volume Control any time independently of 
Forward AV Studio. Run it by choosing its item on the Forward AV Studio 
folder in the system Start menu (for example «Start –> Programs –> 
Forward AV Studio –> DDSound Volume Control»). 
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5.12 Scrubbing Settings 

 

Scrubbing current time marker group parameters allows controlling application 
behavior when dragging current time position mark by left mouse button or 
setting current time in Time Ruler. These switches are duplicated on Time Ruler 
local menu. 
Show Video enables showing of current frame on video player. 
Play Audio enables audio scrubbing (drag current time position with left mouse 
button). Sound will be played in small pieces of Min. duration. If current time is 
changed during this small piece playback, next piece will start from new current 
time position. If current time does not change piece of audio up to Max. duration 
will be repeated until you release or move mouse. In other words, Min. value sets 
the minimal duration of playing; and if mouse is not moved when playback of 
next piece is started, duration will be Max. 
Auto-scroll rolls changes scrolling mode of working area. When current time 
position mark is dragged outside Project window, the Working Area shifts 
automatically to follow current position. If this option is turned on, the working 
area slides smoothly while left mouse button is kept pressed outside window. If 
it is turned off, the working area shifts at a step when current time mark reaches 
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the working area edge. It looks like as time position and its associated cursor 
jumps back in this moment. It may be useful if you do not want autoscrolling of 
working area. 
Pick current time marker on clips – if this option is on, you can drag current time 
position mark when it is over a clip, but you can’t access clip items and move 
clip when mouse cursor is on time position cursor. If you turn it off, you will be 
able to move clip in any case, but you can’t move current time position until 
mouse cursor is not on a clip. 
Shift current time marker group allows controlling behavior when current time 
position is moved with Left / Right arrow keys on keyboard. All values can be 
defined in frames, seconds and milliseconds. 
Step – moving with arrow keys 
Step + Shift – moving with Shift and arrow keys 
Step + Ctrl – moving with Ctrl and arrow keys 
Scroll Working area to current time position – if this option is on, current 
Working Area is autoscrolled during playback. It is useful when 
Playback entire project mode is on (see section about Command menu). 
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5.13 Effects Settings 

 

Quality of audio effects processing group is used for setting the quality of sound 
processing by audio effects in different modes. Poorer quality requires fewer 
calculations and may be useful if your computer cannot play complex projects 
with many audio effects in real-time. Please, note that some audio effects do not 
support this feature and process only top quality sound (see Audio Effects). 
Real-time quality sets the playback/preview quality (real-time operations). 
Final quality sets quality for exporting a project to the resulting file. 
Frequency response calculation sets the quality for calculating audio effect 
frequency and phase response. 
Other functions command is used to set the quality for normalize /statistics 
functions. 
There are three possible modes of quality processing: ‘draft’ (fastest), ‘medium’, 
and ‘fine’ (slowest). Normally, these three modes produce more or less identical 
sound. ‘Draft’ quality is recommended for real-time operations (playback) 
whereas ‘fine’ quality for exporting a project to the resulting file of the upmost 
quality. You may set ‘other functions’ quality to ‘draft’ to accelerate the 
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performance of normalize/statistics functions. Note that in this case the 
calculation of volume levels may produce some minor errors. 
Declick FadeIn / FadeOut group is used to define the parameters of declick 
FadeIns/FadeOuts on audio clips. 
Type is used to set either linear or bell profile of fade. Bell profile usually 
produces better sound than linear one, even with a very loud clip breaking out 
instantly. 
Length is used to define the length of declick fades. If you set declick without 
removing a very loud click at the clip edge, try to increase the length of declick. 
Possible values lie in the range of 0.01 to 100.0 milliseconds. 
Auto set FadeIn/FadeOut – if this option is on and a new audio clip is inserted in a 
track, both declicks will be set automatically. On the audio clip local menu you 
can turn on/off the declicks manually. If you want to set/remove declicks for a 
group of selected clips, use appropriate command on the Edit/Declick menu. 
Single click to open effect list – if this option is on, you can open the effect list on a 
clip, track or entire project by clicking the mouse left button at the triangle mark 
indicating the presence of audio effects. If this option is off, double-click the 
triangle to open the list of effects. 
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6 Saving results of work 
6.1 Export File dialog box 

 

To save the results of work to a multimedia file, call this dialog box by the Export 
command from the File menu. On the right of this standard system Save File 
dialog box there are a format field and Options button. After the resulting file is 
exported, it is automatically added to the current clip collection and/or project. 
The standard part of the dialog box (at its left) allows selecting the destination 
path and name of the resulting file. As soon as the name and path are selected, 
press the Save button to mix all active tracks in a specified range and write them 
to the resulting file. The file's type (audio/video) and format depend on the 
command selected from the File / Export menu. Projects with video can be saved 
to AVI-format only (Audio and Video Interleaved, standard Video for Windows 
format). Projects with audio (no video) can be saved to uncompressed WAV 
(standard Windows audio format), AIFF (Mac-format) or AVI (without video) 
formats. 
Note that unregistered Forward AV Studio saves only the first 10 seconds of the 
project to an external file! For more detail about registration and lifting this 
restriction, please, read the section on Forward AV Studio registration. 
Audio format of the resulting file is shown in the format field at the right part of 
the dialog box. To change audio format of the resulting file, press the Options 
button to call the export audio format dialog box. 
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You can insert the exported file to a current clip collection and/or project (for 
example, to immediately check the results in Forward AV Studio). In 
After export insert result to, select what you need: clip collection only, project and 
clip collection (insert the file both to the clip collection and to the project's track) 
or none (just export without inserting the results to Forward AV Studio). This 
option can be used, for example, to download several audio tracks to a single 
track. Select these tracks (press the Solo buttons on the tracks you want and then 
the Mute buttons on the tracks you do not want to include in the mix), then export 
them to a multimedia file by choosing the option 
Insert result to project and clip collection. You may also use this option for "ready" 
tracks that are not to be changed (edited) in the future – you can mix them to a 
track and clear the mixed tracks to vacate them for another work. This may be 
useful if minor packages of Forward AV Studio with restricted number of tracks 
are used for creating complex projects. 

6.1.1 Export Parameters dialog box 

 

In Audio panel of this dialog box you can specify audio format different from 
current settings of project when exporting audio to resulting AVI, WAVE of 

Forward AV Studio   66 



6. Saving results of work 

AIFF-file. You can also use any audio compression codec installed in your 
system to save compressed audio to AVI or WAV-file. 
Audio sample format is used to set the output format of the resulting file. 
Bits/Type is used to set the resolution and type of the resulting audio file. You can 
select the type from the list (from 8 to 32 bits with different types: 8, 16 and 
20/24 bits of integer type only for AIFF files). Please, note that next time the 
selected format will be used by default! Look at format information in the 
Export Audio dialog box before saving a file to make sure that you have selected 
the format correctly. 
The Channels parameter is used to check that the file is saved with the number of 
channels set up in the project (mono/stereo). You cannot change the number of 
channels here. This number can be set in the project's Audio Settings. 
Dither is used to set dithering parameters while exporting audio to 8/16 bit 
formats. 
The settings Type, Depth and p.d.f. are described in Project Audio Settings sections. 
These parameters are identical to those of the project (upon change the new 
parameters will be used for project playback). 
Convert sample rate is used to save audio with a sample rate different from that of 
the project. For example, if you have a professional soundcard, you can record, 
process and mix audio with maximum quality (24 bit/96KHz) and save the 
results of your work to a WAVE file(s) for audio CD (16 bit/44100 Hz). 
Forward AV Studio can resample audio to almost any sample rate (from 5000 to 
999999 Hz) using very fast and high-quality algorithm. 
From shows the original sample rate of the project. 
To allows selecting output sample rate as desired. You can select any predefined 
value from the list or just type the desired value manually. Please, note that if 
you resample to sample rates lower than the original value, you will lose high-
frequency components! 
Quality is used to set the quality of resampling. You can select a value from the 
list or choose «Custom» to set all parameters manually by the Configure button. 
Higher quality requires more calculations and gives better results, but ‘Fast’ or 
‘Default’ presets normally give satisfying results too. 
Preview button is used to examine the results of resampling in real time and to 
compare them with the original sound (available only if your soundcard supports 
playback at a required sample rate). High quality resampling may require a lot of 
computation, so your computer must be fast enough to mix several audio tracks 
and resample the results in real time. Please, note that pressing the Preview button 
may be followed by a short delay (up to a few seconds on slow computers) 
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before the playback actually starts (delay is shorter when Preview is pressed 
before starting playback next time). 
Configure button is available only if you select the «Custom» option for 
resampling. It calls the Resample Audio dialog box where you can set all 
resampling parameters manually. It is recommended for advanced users only. 
Compression group allows you to compress resulting audio (after resampling if it 
is selected in previous group) with any audio compression codec (ACM codec) 
installed in your system. Select button shows standard system audio compression 
dialog where you can select desired destination format (codec, sample rate, data 
rate etc.). When you selected desired format, it is shown before Select button. 
Select ‘PCM’ format if you want to turn off audio compression. 
Important: it is not recommended to change sample rate when using standard 
audio compression dialog, you may get terrible distortions in the resulting sound 
because of bad quality of standard system resampling codec. You should 
resample audio using Convert sample rate group first and then select desired audio 
format using Select button with output sample rate equal to one defined in To 
field in Convert sample rate group! 
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In Video panel of this dialog box you can specify video format different from 
current settings of project when exporting video to resulting AVI–file. You can 
resize video frame and/or recompress video using any Video for Windows-
compatible compression codec installed in your system. 
Compression group defines output video compression format of resulting file. 
Click at name of a control to get its description: 
Field From shows name of original video codec that was used to compress source 
video files in your project. Select Don’t recompress in the To field if you don’t 
need any video format conversion (recompression, crop and resize). 
From the list To you can select desired video codec to recompress your video. 
You can select any Video for Windows–compatible codec installed in your 
system. Select Don’t recompress in this field if you don’t need any video format 
conversion (direct video stream copy will be performed in this case – it is the 
fastest way to save AVI–file from your project). 
If you select the same codec that was used to compress source video files of your 
project (its name is shown in the From field), recompressing will be performed 
anyway! Use it if you want to crop and/or resize video frames before 
recompressing using the same video codec. 
Data rate: desired average data rate of resulting compressing video stream (in 
kilobytes per second). Reducing data rate reduces resulting file size, but quality 
of image is typically reduced too. Don’t change default value if you don’t know 
what value to use. Not all codecs support this setting; it will be disabled (grayed 
out) in this case. 
The Configure button allows you to call configuration dialog to set some 
additional video compression parameters of selected video codec. 
Parameter Compression Quality defines approximate compression quality in 
percents (100% gives maximum quality). Reducing quality usually gives 
reduction in average data rate and resulting file size, but quality of image is 
reduced too. Don’t change default value if you don’t know what value to use. 
Not all codecs support this setting, it will be disabled (grayed out) in this case. 
The About button shows some information about selected video codec (typically 
information about codec’s manufacturer). 
This dialog belongs to the codec itself, not Forward AV Studio! Not all codecs 
have it; the button will be disabled (grayed out) if codec does not have about 
dialog. 
Parameter Key frame every N frames defines how frequently key frames will be 
present in resulting file. Key frames allow random positioning through the file 
during its playback. The more frequently are key frames, the faster will be re-
positioning in the file when playing it with playback software (for example 
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Windows Mediaplayer). Don’t change default value if you don’t know what 
value to use. 
Not all codecs support setting of key frames not at every frame, this setting will 
be disabled (grayed out) in this case 
The Info button calls dialog Video Codec Info with detailed information about 
selected codec (codec name, path to its driver file, possible format restrictions 
etc.). Press this button if you can’t find video format supported by selected 
codec, see the info dialog to know more about codec’s format restrictions. 
The Deinterlace type option allows you to deinterlace video with fields (for 
example that was captured using video capturing hardware from external video 
source such as video tape) for better smooth playback on PC screen. Select None 
if you don’t need deinterlacing (for example, you are working with video that 
was rendered without fields on PC). Select Interpolate lower fields to skip and 
interpolate lower fields in image (recommended), and Interpolate upper fields to 
skip and interpolate upper fields. See also By field option in the Scale group. 
Select Don’t recompress in the To field if you don’t need any video format 
conversion (cropping, resizing and recompression). Direct copying of video 
stream without recompression will be performed in this case; it is the fastest way 
to save video from your project to AVI file. 
Crop group allows you to crop video frame edges (it can be useful to remove 
blank or distorted edges of frame in captured video material for example). Set all 
values to 0 (zero) if you don’t need cropping: 
Parameter Left shows how many vertical lines should be cropped at the left side 
of video frame. Set it to 0 (zero) if you don’t need cropping at the left of frame. 
Parameter Top shows how many horizontal lines should be cropped at the top of 
video frame. Set it to 0 (zero) if you don’t need cropping at the top of frame. 
Parameter Right shows how many vertical lines should be cropped at the right 
side of video frame. Set it to 0 (zero) if you don’t need cropping at the right of 
frame. 
Parameter Bottom shows how many horizontal lines should be cropped at the 
bottom of video frame. Set it to 0 (zero) if you don’t need cropping at the bottom 
of frame. 
Scale group allows you to resize video frame (decrease frame size to reduce 
video data rate and file size). Don’t change any settings or press Reset size button 
if you don’t need frame resizing: 
Width – resulting width of video frame. You can set it in pixels or percents of 
original size or size that you get after cropping (select it using % of original or % 
after crop). Press Reset button to restore original frame size. 
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% of original – select this option if you want to set frame size in percents from 
original size (not size that you get after cropping). 
Height – resulting height of video frame. You can set it in pixels or percents of 
original size or size that you get after cropping (select it using % of original or 
% after crop). Press Reset button to restore original frame size. 
% after crop – select this option if you want to set frame size in percents from size 
that you get after cropping (not original size). 
Keep aspect ratio – turn on this setting if you want to be sure that aspect ration is 
kept when you change Width or Height. When one value from frame width and 
height is changed, the other is changed too to keep frame aspect ratio. 
Option By field – resizing video frames by fields independently or not. Turn this 
option on if you are working with video with two fields in video frames. 
Typically fields are used in video that is used for playback on TV or external TV 
monitor. If you are working with such video (for example, you captured it from 
video tape using video capturing hardware board), it is strongly recommended to 
resize video by fields independently, or you will get field mixing in different 
video lines and image distortions during video playback. 
If you are using video that is created on PC and used for playback on PC display 
monitor only, turn this option off. 
In any case, Forward AV Studio can’t recognize itself is your video with fields in 
frames or not. If you encounter image distortions during playback of video 
resized with Forward AV Studio, try to turn this option on/off and save your 
video again. 
Press the Reset size button if you want to set frame Width and Height to their 
original values. 
Note: video frame resizing is performed after cropping if both cropping and 
resizing are selected (the program crops edges of video frame first and resizes it 
after). 
Important: selected video codec can be unable to compress video with selected 
frame size. String message at the bottom of the dialog shows is current frame 
size supported by selected codec or not. If current frame size is not supported, 
you will get an error message when trying to press Apply or Ok buttons. Use Info 
button to know more about possible codec’s format restrictions. 
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In Video Codec Info dialog box you can see detailed information about video 
codec selected for video compression. 
Codec info group contains general information about codec. This information 
includes: 
FOURCC code – four-byte string identifier of the codec. 
Short name – string with short name of the codec.Description – string with short 
description of the codec.Driver filename – full path on disk to the codec’s driver 
file. 

Format restrictions field shows some information about possible codec’s format 
restrictions. 
Not all codecs support any frame size and/or any pixel color depths for video 
compression. The programs try to test video codec for compatibility with some 
different frame formats, and shows if there were any restrictions encountered. If 
No known restrictions is shown, it seems that selected codec supports most of 
frequently used frame sizes and/or pixel color depths (typically 24/32 bits). 
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In the Interleaving panel of the Export Parameters dialog box you can specify 
audio and video interleaving parameters for output AVI file. These parameters 
are: 
In the field Preload audio for you can set amount of audio that will be written at the 
beginning of resulting AVI file. This portion of audio will be preloaded before 
start of playback; it helps to prevent audio skipping during playback. It is not 
recommended to set this value too low (less than 0.5 second).Interleave through 
shows interleaving length of audio and video streams in resulting AVI-file. Try 
to decrease this value to 1 frame if you encounter problems with playback of 
saved AVI-file with other software. 

Default values are good for most cases. Try to decrease interleaving to 1 frame 
only if you encounter problems with playback of AVI files with some other 
software. It is not recommended to set audio preload less than 1 second, change 
it only if you encounter problems. 
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6.1.2 Resample Audio dialog box 

 

Parameters – set the main parameters denoting the quality of resampling. 
Accuracy – set the accuracy of resampling by allocating the amount of memory to 
be used for the calculation. 
Pass and Side Attn - set the parameters of the resampling filter. Side Attn is used to 
set approximate filter attenuation in the stopband (the greater the attenuation, the 
better the filter), Pass is used to set approximate relative filter steepness in 
percent (the relative width of the filter’s passband is 100% minus Pass). If you 
change any of these two values, the filter's parameters shall be recalculated. On 
slow computers it may require a few seconds, so press the Recalculate button 
following the setting of these values. The Points parameter shows the length of 
resampling filter response (the greater the length of response, the better the 
filter). 
Pre/Post Filter - set the parameters of the anti-aliasing filter used before (pre-filter) 
or after (post-filter) resampling. 
Filter On - indicates that the anti-aliasing filter is used with the audio signal being 
resampled. 
If you resample audio to a sample rate lower than the original rate, it is most 
recommended to use the pre-filter (it removes high-frequency components that 
shall be absent from the audio with the resulting sample rate), especially if you 
significantly reduce the sample rate (e.g. from 48 kHz to 8 kHz). In such cases 
using pre-filter is necessary, otherwise there may arise audible distortions. 
If you increase the sample rate, the use of post-filter will suppress high-
frequency noise after resampling. This is not necessary if you set high quality of 
resampling filter (with greater length of response; see above). If you select the 
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quality of resampling from the list of preset values (in the Export Audio format 
dialog box), use pre/post-filter for best results. 
Length – set the length of response of anti-aliasing filter (only odd values are 
admissible). To see frequency response of the calculated filter, press the Response 
button. 
FFT Size – set the length of the fast Fourier transform to be used in the fast 
convolution algorithm for pre/post filter. The default value (1024 points) 
produces the best results in most cases, although other values depending on your 
processor may accelerate or slower the computation. 
Please, note that applying pre/post filter requires additional calculation time and 
may decrease the performance if you start audio resampling in real time with the 
Preview button. You may try to turn off the filter and listen to the results of 
resampling. If you are satisfied with what you hear, the pre-post filter is not 
necessary. 

6.1.3 Pre/Post-filter response 

 

The diagram in this dialog box shows the frequency response of the pre/post 
lowpass filter used with resampling audio to a new sample rate. Using this 
diagram you can visually estimate the quality of the pre/post filter applied before 
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or after resampling. The main requirement to such a filter is to suppress high-
frequency components of the audio being filtered (lowpass filter). 
The white curve shows the frequency response of a filter. The vertical line shows 
the edge frequency: you can see that to its left the response is flat (filter does not 
affect frequency components lower than the edge frequency), and to its right the 
filter does suppress frequency components. For the pre-filter, the edge frequency 
is one-half of the resulting sample rate (frequencies higher than this shall be 
removed from the resulting signal so the filter shall remove them prior to 
resampling). For the past-filter, the edge frequency is one-half of the original 
sample rate (high-frequency noise that was nonexistent in the original signal 
shall be filtered after resampling). 
Normally the filter shall suppress only high-frequency components of the signal 
by 60 dB or more (the greater the length of the filter, the greater the 
suppression). 
FFT Size - set the length of the fast Fourier transform to be used for calculating 
response. Greater values give more accurate response. 
Max dB/Min dB - set the vertical range of the diagram in decibels. 
Log Scale is used to switch between the logarithmic and linear horizontal scale of 
frequency values. 
The post-filter on the above diagram suppresses frequencies over 100 dB when 
applied after audio resampling from 44100 Hz to 96 kHz. Filter length is 255 
points. 

6.2 Multiple WAV files export 
With this command you can write parts of the project (resulting audio only) to 
separate WAVE-files. You must mark out places in the project where project 
will be divided into parts to be saved to separate resulting files. 
To divide a project into parts and save them to separate files, set the marks on the 
selected places in the timeline window (Time Ruler) where the project (not 
applicable to clips) must be sliced into parts. Select the mark group 
Export separator for marks to be used as separators of the project's parts. Press the 
right mouse button on the mark, select Mark info item on the local menu, then 
select Export separator in a dropdown list at the right top edge of the mark info 
dialog box. For example, if you have a project with 1 minute of audio and set the 
mark at 20 sec on the timeline (don’t forget about ‘Export separator’ flag!), you 
will have two parts lasting 20 sec and 40 sec, respectively. 
If you select the Multiwave export command from the File menu, each part will be 
saved to a separate file. Type the name of the resulting WAVE-files. The names 
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of files will be auto-incremented. For example, if you enter ‘track’ as a file 
name, you will get files ‘track01.wav’, ‘track02.wav’ and so on. 
You must select the following format for audio CD: sample rate 44100 Hz, 16-
bit format, Stereo. You can create a project with these audio parameters (see 
Audio Settings) or select the output format during file exporting (press the 
Options button in the Export dialog box to select the file name and set the 
required 16-bit format and 44100 Hz sample rate in the Export Audio format 
dialog box). In any case, you must have a Stereo project. 
The duration of the resulting audio files is always adjusted to 1/75th of a second. 
You can get audio CD with no pauses between tracks (you must have a CD-
recorder supporting the “Disk-at-once” mode. For more information, read the 
documentation or manufacturer's contract). When you get audio files in 
44100Hz/16-bit/Stereo format, you can record them to audio CDs using the 
software supplied with the CD-recorder (read the software documentation to 
know how to record audio CDs). 
Note: the duration of the last part of a project is adjusted to 1/75th of a second! 
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7 Dialog boxes 

7.1 Audio meter (Faders) window 

    

The Faders (Audio meter) command from the Project Window menu is used to 
activate a window that may have either A.Meter or Faders title, depending on the 
status of the Faders switch (see below). In this window you can control the tracks 
and master volume/balance (pan) and audio effects on tracks in a project. 
There is always the output volume indicator (audio meter) at the right part of the 
window. This indicator is divided into 5 intervals. Within each interval the 
output audio volume is painted in the corresponding color (dark blue, blue, 
green, yellow and red respectively for the minimal to maximum volume). Thin 
lines mark the maximum peak volume encountered during the playback (if 
Peak hold is enabled in the Audio meter Settings). These marks are reset at the 
playback start or by a click on the indicator. To change color intervals delimiting 
values, the displayed volume level range and level text labels representation, call 
the Audio meter Settings or the local menu (click the mouse right button on the 
indicator). 
Project master volume can be set with the vertical fader shown at the right part of 
the window or by editing the volume value in the text box above (see also the 
note about editing numerical values in Forward AV Studio). The horizontal 
slider and corresponding text box are used to control the project master balance 
(pan). 
Meter – enable monitoring the output audio volume on the indicator. 
Faders are used to control the presence of faders (volume controls of tracks) at 
the left. With this option off, the window contains only the volume indicator and 
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master fader (the window title is A.Meter). With Faders on, the window changes 
its title to Faders and shows the track faders with the Solo / Mute and audio effects 
buttons. 
The << and Play buttons allow rewinding the current time position to start the 
playback directly from the Faders window. 
Edit FX buttons allow calling the Effects List dialog box to add/edit track/master 
audio effects. 
Use FX – turn on (use)/off (bypass) track/master audio effects. 
You can use Edit / Use buttons to control audio effects during project playback. 
The Faders window shows faders for 6 tracks (track numbers are displayed on 
the top of the faders). If the current project has less than 6 tracks, the unused 
faders will be grayed and inaccessible. If the project has more than 6 tracks, the 
scrollbar at the window's bottom allows selecting for display 6 tracks. You can 
also use the Volume and Balance dialog boxes to set volume and/or balance 
(pan) for a project, track, clip or profile. 
It is possible to dynamically change the master and track volume/pan during 
playback. Attention! Changes will always be made with some delay depending 
on the value of Buffer size in Audio Settings. 

7.2 Volume and Balance dialog boxes 
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Volume and/or balance dialog boxes may be called from different menus. 
Depending on the context, the dialog box changes its name and may have either 
Volume or Balance group, or both. 
The dialog box has Profile or Clip names when called with the Set profile value and 
Clip volume commands on the Audio clip local menu. 
The dialog box is named Track when called with the Track Volume command on 
the Track State window local menu. 
The Master volume command on the Command menu is used to change the master 
volume and balance for the whole project. In this case the dialog box is named 
Project. 
Note that the master volume and balance for a project and audio tracks can be set 
in the AudioMeter(Faders) window, where it is possible to dynamically change 
the volume and balance during playback. 
Note that volume at each point of a clip with audio is a sum (in dB) of all master 
volumes (the project master volume, track master volume and clip master 
volume) and the volume profile value at this point (for an audio clip). The same 
is true for balance. 
The balance value can be set from –100 (Left) to 100 (Right). 
The nominal volume value is 0 dB or 100 %. 
Attention! The maximum volume amplification is 12 dB (4 times). At points 
where maximum amplification is reached, the profile touches the top of the clip 
rectangle and stays there while other profile key points are fluctuating with 
master volume change. Thus, the profile is distorted and the mixed signal may 
not fully correspond to your expectations. To avoid this, take care of the clip 
volume profile - visually it should not touch the top edge of the clip. 

7.3 Open Clip dialog box 
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This dialog box allows adding a clip with reference to the whole source file 
content. If a file is added to the Project from the track local menu, the new clip is 
inserted to both the track and Clip Collection. 
The Info area at the right of the dialog box displays information about the 
selected source file (audio format of the file etc.). Please note that 
Forward AV Studio cannot add to a project compressed audio files (such files 
can be decompressed to new files and then inserted into a project). Files with 
different sample rate cannot be added to the same project either (such files can be 
converted to new files with the project’s sample rate). 
Preview button starts playback of a selected file. 
The Auto preview flag enables automatic playback of a selected file. 
Add button appears only if the dialog box is called from the Clip Collection 
window. It is used to add a clip with a selected source file to the Clip Collection 
and does not close the dialog box. It is used to add multiple files to a clip 
collection at once. 
You can call this dialog box from the Project window dialog box with the Add 
source File command from the File menu and Working Area local menu (press the 
mouse right button at any place not occupied by clips) and also with the button 
on the Toolbar. 
In the Clip Collection window, this dialog box can be called with the 
Add source File command from the File menu and the local menu (on the 
background), and with the button on the Toolbar. 
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You can add source multimedia files by dragging them from the 
Windows Explorer to the Project window (a single file only) or Clip Collection 
(multiple files). 

7.4 New project dialog box 

 

This dialog box is called when you want to create a new project in 
Forward AV Studio. To create a new project, press the first button on the 
Toolbar in the Project window or use the New project command from the File 
menu. 
In this dialog box you should set all main parameters of a new project. 
Duration – duration of project in current time format. You can change duration 
any time later using the Set Size button. 
File Name – press this button to set location and name of project file on disk, or 
type it manually in edit box. If no name is set, it will be ‘Untitled’, and name of 
file will be asked when you save project first time (see also File menu). If you 
type it manually, you must specify full path to a file with drive letter and ‘TML’ 
filename extension (for example, ‘D:\Projects\project.tml’). 
Clip dir – press this button to set default location (directory on disk) of source 
media files for clips. This path will be used by default when you add new clip(s) 
to a Project and Clip Collection. The same path will be used by default when you 
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recorded audio and want to save it to file. This path is not obligatory and can be 
changed any time when you open/save any media files in Forward AV Studio. If 
you type path manually, you must specify full path including drive letter (for 
example ‘D:\Clips’). 
Note: you may need to create a new folder (directory) on disk for a new project 
and recorded audio clips. You can create a new folder before defining file name 
for a new project: after pressing File Name button in the standard Save file dialog 
box will be shown. Select path on disk where you want to create a new folder, 
press right mouse button on empty space in the field with folder names, select the 
New/Folder command from menu. New folder will be created in current folder, 
type desired name and press Enter. Now you can double-click at created folder 
and type filename of new project. Press the Save button to close dialog box. 
Video group defines main video parameters of a project. 
Use – turn this option on if you want to use video in your project, turn it off 
otherwise. It means that video tracks will be shown or not in a Project window, 
you can change it later with appropriate command from the View menu. 
Frame rate – video frame rate in frames per second. It is set automatically when 
you add first video file to project using the Add source file command in the local 
menu of video track (press the right mouse button on empty place of video 
track), or you can change frame rate later in Video Settings. 
Audio group defines main audio parameters of a project. 
Use – turn this option on if you want to use audio in your project, turn it off 
otherwise. It means that audio tracks will be shown or not in the Project window, 
you can change it later with appropriate command from the View menu. 
Ratio, Bits and Stereo and Advanced button define audio format of a project, see 
Audio Settings. When you add first audio file to a project using the Add source file 
command from the local menu of audio track, sample rate (Ratio) is set 
automatically equal to sample rate from the first file (all audio files used in a 
project must have the same sample rate). However, output bits and number of 
channels should be set manually. 
Tracks define number of audio tracks in the Project window; you can change it 
later with the Set Size button or in Audio Settings. 
Midi group: turn on/off Use option if you want to use MIDI or not in a new 
project. It means that midi track will be shown or not in the Project window, you 
can change it later with appropriate command from the View menu. 
You can use mouse to edit numerical values. 
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7.5 Clip Properties dialog box 

 

This dialog box can be opened in the Working Area by the Properties command of 
the clip on track local menu. Another dialog box, Clip Properties, can be called 
in the Clip Collection. 
In the Clip Name field, an arbitrary set of symbols can be assigned to a clip. By 
default, the source file's name is assigned. Clips with different parameters may 
have the same name. A clip is not uniquely defined by the Clip Name. 
File Name shows the path to the source file. 
Source position field groups the values of the following parameters: 
In, Out – start and end of a clip relative the start of the source file. 
Size – clip duration, the difference between the end and start (Out and In). 
Source – duration of the whole source file. 
Start and Stop – start and stop clip positions in a project. 
Audio group is available only in the properties of Audio Clip. 
Volume – clip volume. 
Balance – clip balance. 
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Use audio FX – turn on/off (bypass) audio effects on a clip (if available). 
Declick in / out – turn on/off the suppressor of clicks on the clip edges. The declick 
function can be set automatically on any clip added to the project (see 
Effects Settings). 
Show In/Out frame is identical to Show video in the General Settings and Time Ruler 
local menu. When activated this option outputs the corresponding frame on the 
monitor or video player (Video window) when you change the In or Out fields. 
Available only for Video clip. 

7.6 Repeat Сlip dialog box 

 

This dialog box is used to create additional copies of any clip on track in the 
Working Area and can be called by the Repeat clip command from the clip local 
menu. Each created copy is an independent clip, and the initially copied clips are 
almost identical (except their positions in the project). Each copy inherits the 
general clip parameters, such as clip duration, position in the source file, place 
marks, as well as properties specific for the clip's type, such as volume and 
balance profiles and audio effects for Audio clip. 
Values of time position or time interval are presented in the current time format. 
Copy count is used to set the number of new copies. For example, with the counter 
value set at 4 you will get 5 identical clips. 
Time shows the value of time interval occupied by newly created repeated units – 
‘period’ multiplied by the number of copies.  
Pause sets the duration of a pause inserted before each new copy. 
Clip shows the duration of a clip. 
Period sets the total duration of ‘pause + clip’ to be repeated. 
Maximum values of all parameters depend on the vacant space after the clip and 
are interdependent. Note after editing the field it is recommended to switch to 
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another field by using the mouse or the Tab button to check the actual field value 
prior to pressing the OK button. For example, the value of Period may not be set 
larger if there is not enough space for the set number of additional copies. 
Note that if time is measured in frames or SMPTE, the displayed time interval 
value is rounded to the start time of the nearest frame. This may be a bit 
misleading. To make sure everything is consistent, for a current format choose 
Time in milliseconds. The dialog box for the sample image is called for a project 
with the frame rate of 10 frames per second. It is easy to see that the time interval 
value is ’00:00:09:02’. 

7.7 Normalize audio 

 

Normalize Level dialog box requests the maximum output audio level and adjusts 
the project master volume to the required level (in percents or decibels). If you 
select the Normalize command from the audio clip local menu, the same operation 
will be executed to adjust the clip volume. 
The program mixes audio in selected range and finds maximum volume. Project 
or clip master volume is adjusted to match resulting maximum volume of audio 
to specified level. 
If the project volume is normalized, this operation does not change the 
volume/balance profile, master volume of clips or tracks, instead it changes the 
project master volume. If the audio clip volume is normalized, the clip master 
volume is changed. 
The Normalize audio command is available from the Command menu, Range 
window or audio clip local menus (to normalize an audio clip volume level, you 
may also press the N key on the keyboard when the mouse arrow is over this 
audio clip). 
Attention! The maximum volume amplification is 12 dB (4 times). Thus, the 
program cannot normalize a file with the maximum level less than 25%. Second, 
if the resulting amplification for a clip sample exceeds 12 dB, the mixed signal 
may fail to meet the expectations. To avoid adverse effect on the clip quality, 
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watch the audio clip volume profile carefully – it should not touch the top edge 
of the clip. 

7.8 Audio Recorder dialog box 

 
Using this dialog box you can record an audio clip and insert it in the current 
project. To call the recording dialog box, use the Command menu, the Toolbar 
button or press Ctrl+R on the keyboard (see also the section about keyboard 
accelerators). 
The Device field defines an audio device for recording. Prior to recording, please, 
make sure that your selection of the input source (line/microphone/CD input etc.) 
and cable connections are correct. 
Before opening this dialog box, Forward AV Studio may request the target file 
name (after you input the file name press the Save button to continue) if the 
Ask name before run option is on. 
The current name of the recorded file is shown in the File group. You may select 
another name using the Browse button (select or type the desired name and press 
the Save button to continue). 
Ask name before run – if this option is on, Forward AV Studio requests the target 
file name for the recorded audio prior to opening the recording dialog box. 
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Otherwise, the file name will be requested only when you have recorded the file 
and pressed the OK or Insert button. Auto increment name – use this option to record 
several fragments. After you have defined the name of the first file (for example, 
‘Sound00.wav’), the names of all fragments that follow will be incremented 
automatically (“Sound01.wav”, ‘Sound02.wav’ etc.) when you press the Insert 
button to add the recorded fragment to the project without closing the audio 
recording dialog box. 
Input format group defines audio format for recording. Ratio – audio sample rate, 
Resolution – audio sample resolution. 
You can select the number of channels from the dropdown list: Mono (one 
channel), Stereo (two channels), Left / Right (one channel will be recorded from the 
left or right channel of the selected audio device). 
Advanced button is available only for 24-bit resolution, it is used to call the 
advanced format selection dialog box. 
Note that your soundcard must support the selected format for recording. 
V.Control – if this option is on, Forward AV Studio displays the window of the 
DDSound Volume Control application to adjust the settings of the audio device 
selected for recording. 
Always on top option is used to keep the recorder window on top, over the project 
and clip collections windows. 
Synchronize playback option is used to turn on the playback of the current project 
during recording. This allows simultaneous playback of the current project and 
audio recording (during consecutive recording of many musical instruments). A 
project or its part will be played as specified in the General Settings. 
If option Stop when stop is on, recording is automatically stopped when playback 
of project is finished (current time position reaches end of project). If this option 
is off, recording is continued until you press Stop button (even if playback of 
project is finished). Note: This setting is available only if Synchronize playback 
mode is on. 
Note that your soundcard must support the full-duplex mode (simultaneous 
playback and recording in the selected format). 
DC Adjust – turns on/off the real time compensation of DC-offset during 
recording. You may also use automatic DC-offset compensation during 
playback. 
Rec.Delay sets the delay between a click on the Record button and the actual start 
of recording. 
Status shows the current state of the recorder. Time shows the current time 
position in the recorded file. 

Forward AV Studio   88 



7. Dialog boxes 

The Rewind  and Fast Forward  buttons are used to rewind to the 
beginning or forward to the end of the recorded file. The end of the resulting file 
will be at the end of the fragment recorded the latest. 

The Stop  button stops recording. To record the next fragment, press the 
Prepare / Record buttons again. Use the Rewind button to repeat the recording of a 
file from the beginning. 

The Record  button is used to start recording (not instantly if the Prepare 
button has been previously pressed). 
The Prepare button initiates preparations for the process of recording. It is used to 
start recording almost instantly as soon as the Record button is pressed. The 
preparation is of primary importance if the recording is in the full-duplex mode 
(when the Synchronize playback option is on). 
Note: The ‘Record’ and ‘Prepare’ buttons may be disabled if your soundcard 
cannot record audio in the current audio format. Check that you have selected 
an appropriate format and that ‘Supported’ is shown in the ‘Input format’ field. 
Meter – if this option is on, the input audio volume level is displayed on the 
indicator. This indicator is similar to that used in the Audio meter (Faders) dialog 
box; its parameters can be set in the Audio meter Settings. 
The OK button closes the dialog box and inserts the recorded file to a project and 
clip collection. In the Synchronize playback mode the file will be inserted at the 
current time position (on the first empty track) or should be placed manually 
with the mouse. 
The Insert button inserts the recorded file to a project and clip collection without 
closing the dialog box so you can record a great number of takes of the desired 
fragment and listen to the recorded fragment without closing the recording dialog 
box. 
Note: the recorded clip is inserted to the first empty track. You may need to move 
the clip to another track without changing the clip’s starting time. To do this, 
press the mouse left button on the clip, hold it and press the up/down arrow key 
on the keyboard. Release the mouse button when the clip is moved to a desired 
track. If you have recorded many takes, you may include not all of them in the 
playback. Use the “Mute” buttons on the track state window to exclude the 
unnecessary tracks from the playback. Use Always on top to ensure that the 
recording dialog box is not hidden on pressing the Mute / Solo buttons in the 
Project window. 
The Close button closes the dialog box and deletes the recorded file. 
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7.9 Configure external applications dialog box 

 

This dialog box is used to set the correspondence between the commands on the 
Tools menu and external applications (external editors, calculator etc.). 
Basic applications group defines external applications associated with the first 4 
commands on the Tools menu. 
Additional applications group defines additional applications, which are optional. If 
any text label in the Item name column is non-empty, it appears as a command in 
the Tools menu. 
Path contains the complete path to the files of external application. 
+clip filename – if this option is on, the clip source file name is added to the 
command line of an application. 
Browse button allows manual selection of an application executive file in the 
standard Open File dialog box. 
Wait / lock switch is used to change Forward AV Studio operation when an 
external editor for source file editing is opened (with the Edit / Editor command on 
the clip local menu). If wait is selected, Forward AV Studio gets locked until the 
file has been edited and saved and the external editor has been closed. Note that 
if the same editor is launched regularly, it may open the file you want to edit 
using an opened external editor. In this case Forward AV Studio is immediately 
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reactivated and the file is reopened so you cannot save it in the external editor. In 
this case, use lock instead of wait. 
If lock is selected, Forward AV Studio will show the warning message and get 
locked until the OK button in the message box is pressed. Do not press OK until 
you have finished editing and saved the file in the external editor! After the 
editing has been finished, press OK to return to Forward AV Studio and reopen 
the edited file. 
You may also launch editing of the multiple source files in the external editor in 
lock mode simultaneously. Select desired clips and select corresponding item in 
the Tools menu (or press Shift+E when desired clips are selected). 
Forward AV Studio will launch the external application for each selected source 
file. Many audio editors detect that an instance of editor is already running and 
open all files in only one running instance. It is recommended that you should 
keep the external editor always running before launching of editing of multiple 
files in it. There may be some problems (especially on slow computers) if the 
external editor was not already running before launching of editing of multiple 
files in it (multiple instances of the editor instead of one may be launched or 
some files may be skipped). 
If the empty field is selected, the external application will be launched 
immediately without closing/opening a file and locking Forward AV Studio. For 
example, this may be useful for calling the Calculator. 
This dialog box is called by the Configure command from the Tools menu. 

7.10 Fade Profile dialog box 
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The Options / Fade profile command from the Project window is used to call this 
dialog box. 
This dialog box specifies the shape of FadeIn profile. FadeOut profile is similar 
to FadeIn profile except that it is reversed in time. The profile is shown in both 
linear and logarithmic scales. Between any adjacent points the profile is 
interpolated linearly (in logarithmic scale it looks like a bend). Any selected key 
point is encircled by a pink square. 
Linear buttons are used to place points equidistantly in a relevant scale. 
Volume allows the volume of a selected point to be set in a relevant scale. 
Point shows the number of a selected point number. 
Time allows setting the time position of a selected point. 
Add point mode allows adding key points to a profile. Each click in the profile 
window adds a new key point. 
Delete point deletes a selected point from the profile. 
Save profile saves the current profile into a file. By default the file has .FPR 
extension. 
Load profile loads the saved profile from a file. 
When the cursor approaches the key point, it changes its shape to a cross-like 
figure. Click once to select the key point. The selected key point can be dragged 
with the mouse. The key point cannot be placed before and below the preceding 
point or after and above the following one. The first and last points cannot be 
moved. 
The FadeIn and FadeOut commands multiply current volume profile of clip(s) by 
fade profile. Profile scales to the specified time interval; interval definition 
depends on from where command is issued. 
The FadeIn command from the Audio clip local menu applies (multiplies) fade 
profile to clip volume from start of the clip to point, where local menu was called 
with the right mouse button; the FadeOut command applies fade profile from 
specified point to the end of clip. 
If commands are issued from the Range menu, profile is applied to range interval. 
The Edit / CrossFade command is available only if exactly 2 overlapping clips are 
selected, and is equivalent to FadeOut in first clip and FadeIn in second in 
overlapped interval. 
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7.11 Time marks 

 

Time marks can be used to align and synchronize clips and to mark clips and 
Time Ruler with text labels. Various objects can be attracted (snapped) to the 
marks: the current time position, clip edges and marks on clips being dragged. 
The types of object, snapping distance and other alignment parameters can be 
defined in Alignment Settings. 
The mark can be set in the Time Ruler or in a clip on track. In the Time Ruler the 
mark has a fixed, ‘absolute’ time position in the project. The mark on a clip has a 
fixed time position from the beginning of the source file and is moved together 
with the clip. Clip resizing does not affect the positions of marks on a clip. 

When the mouse cursor is close to a mark, it changes its shape to ; now the 
mark can be dragged and moved with the mouse left button. When the mark is 
dragged in the Time Ruler, the current time position also changes. 
The Time Ruler and clip on track local menus have the following commands: 

Add mark sets the time mark at a specified point. 
When the local menu is called on an existing mark (the mouse cursor's shape 
turns into ) and the Add mark command is replaced with the following 
commands: 

Set mark position… calls the dialog box to set the position of a time mark; 
Mark info… allows setting the mark name and text information and 

changing the number of group the mark belongs to, in 
the Mark Info dialog box; 

Remove mark removes the mark. 
Marks can be arranged in groups (up to 9 groups). Only one group can be active. 
Using the Next mark group button on the Toolbar or View menu you can make the 
groups become active in a cycle. The number of the active group can also be set 
in the Alignment Settings. 
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The mark of an active group is displayed as a solid green and the mark of an 
inactive group as a solid gray triangle. 
How all this works. By default any mark attracts the current time position. Suppose 
that you set a time mark on the Time Ruler. If the current time position is 
dragged and the distance between it and the mark becomes less than the preset 
snap distance, the current time position jumps to the position of the mark. As 
long as the distance between the cursor and time mark remains less than the snap 
distance, the current time position is kept at the position of the mark. The 
alignment of all other objects can be done in a similar way: the clip edges, mouse 
cursor (the point on a clip where the mouse button is pressed for dragging) and 
marks on clips. In the Alignment Settings, you can define the objects to be 
snapped to marks. 

7.12 Mark info dialog box 

 

In the Mark Info dialog box, you can set the text label (name) of a mark, input 
text information (comments, remarks etc) and select the group that the mark 
belongs to (in the list at the topmost right edge of the dialog box). The text label 
is shown together with the mark symbol (triangle), text information is shown 
when the mouse cursor has been moved and held on a mark for about one 
second. 
On the Time Ruler (not on clips), two special types of marks can be placed.  

Export separator use this type to mark the places where the project is to 
be divided into parts for their exporting into a few 
WAV-files. 
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Stop playback when you start playback and the current time position 
reaches a mark of this type, the playback is terminated. 
Note that if you start playback with a double-click on 
the Project Overview window or on tracks in the Project 
window, or if you start the preview in the audio effects 
list, the playback would start from a specified position 
to the end of the project with all Stop playback marks 
being ignored! To use such marks, you should start 
playback with the Play button on the Toolbar or from the 
keyboard with the Space key (see also the section about 
keyboard accelerators). 

Marks of these two types have their own colors different from other marks. Other 
colors can be set for these marks in Colors Settings. 

7.13 Clip selection 
Each clip on track is displayed as a rectangle with the clip name in its upper left 
corner. The rectangle height is equal to that of the track. The rectangle width is 
determined by clip duration and current zoom factor. Clip background color 
depends on whether the clip is selected or not. 
One or many clips may be selected, see Selection in Clip operations summary. 
Clips of the current selection group are displayed in dark green. Clips of other 
groups are displayed in dark blue. Unselected clips are displayed in dark gray 
color. 
Up to 9 clip selection groups may be defined. It is possible to change the number 
of the current selection group in the Selection Settings. The Next selection group 
command on the Toolbar or View menu is used to make the group become active 
in a cycle. 
Delete, Move, Cut, Copy and some other operations (see the Edit menu, 
Clip operations summary) work with all clips of the current selection group. 

7.14 Time Format 
Forward AV Studio can show time values in the following formats: 
Time in Frames 
The time is measured in frames. The current Frame rate (see Video Settings) is 
used to convert the time into frames. For example, at the frame rate of 25 fps one 
second of time will be displayed as ‘25’ or ‘25fr’. 
Time in SMPTE 
SMPTE format – ‘Hours : Minutes : Seconds : Frames’ 
One second time label will be displayed as ‘00:00:01:00’ or ‘00:00:01:00fr’. 
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Time in milliSeconds 
This is the following format: ‘Hours : Minutes : Seconds : Milliseconds’. 
For example, one second time label will be displayed as ‘00:00:01:000’ or 
‘00:00:01:000ms’. 
To set the current time presentation format, call the Clip Collection window from 
the View menu on the Toolbar, and from the View menu in the Project window. 

7.15 Numbers editing 
Almost in all dialog boxes, you can use the mouse to edit numeric fields. 
Place the cursor over a desired digit, press and hold the mouse right button (the 
digit will be selected). Hold the button while dragging the mouse up/down to 
increment/decrement the digit value. 
You may also use up/down arrows (at a step of 1) and PageUp / PageDown keys (at 
a step of 10) on the keyboard to increment/decrement numeric values of integers. 
The values of fractional numbers (such as decibels in the Clip Volume window) 
can be edited by up/down or page up/down keys for adding/subtracting 0.1 and 
1.0, respectively. 

7.16 Clips volume offset dialog box 

     

In this dialog box you can change or set the volume of a group of selected clips 
at once. This dialog box can be called with the Clip(s) Volume Offset command 
from the local menu on any selected clip or by pressing Shift+V (see the section 
about keyboard accelerator). 
When Offset is selected, you can type any offset of the volume to increase or 
decrease the volume of all selected clips at once. For example, if you have 
selected two clips with the volume of –1dB and 2dB set the volume offset at 3 
dB and you will get the clips with the volumes of 2 dB and 5 dB, respectively. 
When Set is selected, you can set the volume equal for all selected clips. 
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8 Clip Collection 

 

Clip Collection may be considered as a handy storage of multimedia data, which 
can be used in projects. It contains the list of source multimedia files with 
additional information, for example, pictures of audio waveforms (it is used to 
open a project almost instantly without re-scanning the audio files) and preview 
images for video clips. 
By default a clip collection can be saved to a file with *.PRC file name 
extension. By opening a project you automatically open the associated collection 
file. While working on a project you can also open and save other clip 
collections. 
There are different ways to add source files to a collection: you can drag files 
from the Windows Explorer window by using the Add source file command from 
the File menu or you can open you from the local menu (by clicking the mouse 
right button over the collection's background and then choosing the Add source file 
command). Another way is to double-click in the Clip Collection window (the 
last three commands open the Open Clip dialog box where you can add many 
files at once). When a source file is opened in Forward AV Studio, a new clip 
with reference to the whole file content is added to the Clip Collection. To 
change the position of the Clip Info window, drag it with the mouse left button or 
use the Up/Down / Left / Right keys with the Shift key pressed (select the clip by 
clicking on it before doing this). 
Each clip in the Clip Collection window is represented by the Clip Info window. 
Clips can be dragged from the Clip Collection to the Project window – move the 
black box to a desired place and release the mouse button to place the clip on 
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track (if you decide not to add a clip to the project, do not release the mouse 
button but drag the clip back to the collection). In the collection you can keep not 
only source files, but also some clips with the edge position and duration 
different from those of the source file (copy the clip from the track to the 
clipboard and paste it to the collection). 
Right click on the collection background to call the local menu with the 
following commands: 

Add source File call the Open Clip dialog box to add clip(s) with 
reference to the whole source file(s) content. 

Paste add all clips from the Clipboard to the Clip Collection. 
The following 4 commands are used to customize the appearance of the Clip Info 
windows: 

Full Info show maximum information about clips. 
Basic Info show basic information about clips. 
Large Icons show clips as large icons. 
Small Icons show clips as small icons. 

In the Clip Collection window there are accelerator keys, the Toolbar and the 
following menus: File, Edit, View, Command, Tools, Options, Window, Help. 

8.1 Clip Info window 
Each clip in the Clip Collection window is represented by its Clip Info window. 
There are four variants of its representation: 
Full Info is the most informative window. It displays the clip name, source file 
path, audio parameters (sample rate, bits per sample or audio format type, 
stereo/mono or No sound), video parameters (width*height, frame rate in frames 
per second or No Video), time In and time Out (the beginning and end position in 
the source file), duration. A thumbnail picture is drawn at the left. 
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Basic Info window is more compact. It provides the same information as Full Info, 
except the source file path, time In and time Out. 

Large Icons   

and Small Icons   that contain only the clip name and 
have different sizes. 
Note that if a clip from the Clip Collection is not used in the current project, its 
information is drawn in blue. 
The current presentation of the Clip Info windows can be selected on the 
Toolbar, in the local menu (a right-click over the background) or in the View 
menu. Thumbnail picture (frame) for a Video clip can be selected on the 
Thumbnail panel of the Clip Properties dialog box. Audio and Midi clips have 
predefined pictures. 
The type(s) of multimedia data in a clip are shown by the following icons: 

 ,  - video.  , - audio.  ,  - Midi-sound. 
If an icon is grayed, the clip parameters are different from those of the project. 
Clip parameters can be adjusted in the Tools menu. 
A clip may contain both audio and video data. If so, both icons are displayed. To 
disable audio or video in a clip (for example, in the opened source file there are 
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both video and audio, but you want to use video only), use Use Video or Use Audio 
in the Clip Properties dialog box. If audio or video is disabled, the corresponding 
icon becomes red-crossed: 

, ,  or . 
Local menu of the Clip Info window 
A right-click on the Clip Info window calls the local menu with the following 
commands: 

Play playback this clip; 
Change project video parameters 
 reset video parameters of a project (such as frame rate 

and video frame size) so that they match those of the 
current clip; 

Change project audio parameters 
 reset audio parameters of a project (such as audio 

sample rate) so that they match those of the current clip. 
These two commands are available only if the project's tracks are empty. 

Launch Video editor 
Launch Audio editor 
Launch Midi editor the items of the Launch ‘data type’ editor commands appear 

if the clip has multimedia data of the corresponding 
type(s). The Editor path can be set in the 
Configure external applications dialog box. The Editor 
application is launched by adding the clip's source file 
name to the application’s command line; 

Select source file in project 
 the same command as in local menu of clip on track. 

Selects all clips in project that correspond to the same 
source file as current clip corresponds to. 

Purge remove all clips that are not used in the current project 
from the clip collection; 

Copy clear the Clipboard and add the selected clip to the 
Clipboard (the clip is placed on the first track); 

Add add this clip to the Clipboard (clips are added 
consecutively on the first track); 

Paste paste all clips from the Clipboard to the Clip Collection; 
Delete remove the current clip from the Clip Collection. 
Properties call the Clip Properties dialog box. 

8.2 File menu 
New collection create a new (empty) Clip Collection. 

Forward AV Studio   100 



8. Clip Collection 

Open collection… open the selected Clip Collection file. 
Add source File… add a clip with the whole source file content. 
Add from collection… add all clips from selected clip collection file to the 

current collection. 
Save collection save changes to the current clip collection file. 
Save collection As… save changes to a new clip collection file. 
Close close the current clip collection file. A clip collection 

file's name has extension *.PRC. 
Recent collection files here there is a list of the most recently used clip 

collection files (with *.prc filename extension). You can 
select any of the recent collection files to open it by its 
name in the list. If a collection file does not exist in its 
original location there appears an error message. If a 
clip collection has been moved to another place, open it 
with the Open Project command. 

Recent clip folders here there is a list of the most recently used folders to be 
used for opening the clips. Select any of the folders to 
add a source file to the clip collection. You can select 
and add many files at once. 

The commands from this menu are also available on the Toolbar. 

8.3 Edit menu 
Change project video parameters 
 redefine project's video parameters such as frame rate 

and video frame size. 
Change project audio parameters 
 redefine project's audio parameters such as sampling 

rate. 
Video editor 
Audio editor 
Midi editor the ‘data type’ editor command(s) appears if a clip 

contains multimedia data of the corresponding type(s). 
The Editor path may be set in the 
Configure external applications dialog box. To launch 
the Editor application, add the clip source file name to 
its command line. 

Add all Files from project 
 add all files that are used in current project to clip 

collection. It may be useful if you have a project 
without clip collection or if you have lost clip collection 
file. 
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Purge remove clips that are not used in the current project 
from the current clip collection. 

Copy clear the Clipboard and add the selected clip to the 
Clipboard (the clip is placed on the first track). 

Add add the current clip to the Clipboard (the clips are added 
consecutively on the first track). 

Paste paste all clips from the Clipboard to the Clip Collection. 
Delete remove the current clip from the Clip Collection. 
Properties… call the Clip Properties dialog box. 

8.4 View menu 
The first 4 commands are used to customize the appearance of the Clip Info 
windows: 

Full info maximum information about clips; 
Basic info basic information about clips; 
Large icons clips as large icons; 
Small icons clips as small icons. 

The following 3 commands are used to sort clips in the Clip Collection window: 
Auto Sort sort clips in a collection each time a new clip is added; 
Sort by Type sort clips in a collection by type in the following order: 

Video&Audio clips, Video clips, Audio clips, Midi clips; 
Sort by Name sort clips in a collection by clip name. 

The following 3 commands are used to select current time format: 
Time in Frames display time as a frame counter. One second 25 or 25fr 

for the video frame rate of 25 fps. 
Time in SMPTE ‘Hours : Minutes : Seconds : Frames’. One second 

00:00:01:00 or 00:00:01:00fr; 
Time in MilliSeconds ‘Hours: Minutes : Seconds : Milliseconds’. One second 

00:00:01:000 or 00:00:01:000ms 
The buttons on Toolbar duplicate the above commands. 

8.5 Command menu 
Move selected clip to the project 
 add the selected clip to a project. You can just drag clips 

to the Project window using the mouse. 
Move Unused clips to the project 
 add to the project all clips that are in a clip collection 

but not used in the project. 
Move All clips to the project 
 add all clips from a clip collection to the project. 
Select source File in project 
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 this command is analogous to the command in the local 
menu of clip on track. Select all clips corresponding to 
the source file of the selected current clip. 

Play start playback of a selected clip. 
Stop stop playback of the clip. 

8.6 Tools menu 
Convert WAVE convert the source audio file into a WAVE-file with 

different parameters. 
Convert AVI launch the AviEdit application to convert a source AVI-

file into another AVI-file with different parameters. In 
AviEdit, select the Save Options… command from the File 
menu, choose video or audio stream and press the 
Options… button, etc. 

Convert MScamcorderAVI 
 prior to using this command, consider a possibility to 

update the corresponding CODEC, see URLs below. 
This update allows you to use the standard Convert AVI 
command. Otherwise use Convert MScamcorderAVI. 
Choose a source file, and then define an output AVI-
file. The source AVI-file will be played on the screen 
and grabbed into the output AVI. Wait until the end of 
conversion, do not open or minimize the windows, do 
not move the mouse etc. 

8.7 Options menu 
Font… set a font for clip information display. 
Color… set a color for clip name's presentation in the Small Icons 

Clip Info windows. 
Skip Video don’t use video from all source files while adding new 

clips to a project from the Clip Collection. 
Skip Audio don’t use audio from all source files while adding new 

clips to a project from the Clip Collection. 
Save Options save the program settings. 

Forward AV Studio automatically saves the current program settings on exit. 
These settings will be used the next time you run Forward AV Studio. On 
Forward AV Studio abnormal termination, the program settings will not be 
saved. The Save Options command from the Options menu in the Project window 
and Options menu in the Clip Collection are used to save the program setting at 
any time. 
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8.8 Window menu 
Project activate the Project window. 
Faders (Audio Meter) activate the Faders window. 
DDSound Volume Control  
 activate the DDSound Volume Control window (see also 

Devices Settings). 
Video show the Video preview window if possible. 

8.9 Clip Properties dialog box 
This dialog box can be called in the Clip Collection by the Properties command 
on the local menu of the Clip Info window or Edit menu. The following tab 
panels present various clip parameters: 

General clip name, source file name, size, etc; 
Video, Audio, Midi multimedia data specific info. Use Video and Use Audio 

switches; 
Thumbnail video frame for a thumbnail picture; 
Summary information fields embedded into the source media file. 

8.9.1 Clip Properties. General 
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Clip Name is an arbitrary label associated with the clip. The name of the source 
file is assigned by default. Clips with different parameters may have the same 
name. A clip is not uniquely identified by its name. 
File Name shows the path to the source file. File Size shows the size of the source 
file in bytes and kilobytes (KB), 1 KB=1024 bytes. 
Created and Modified show the dates of the source file creation and modification. 
The group of Time group contains the following information: 
In, Out – start and end of a clip in the source file. 
Duration – clip duration, the effective difference between Out and In. 
All values are displayed in the current time format and depend on the current 
value of video Frame rate on the Video tab panel. 
Copy info to the clipboard button is used to copy all clip-related information to the 
Clipboard in text format. You can paste it into any text editor, save to a file, print 
etc. 

8.9.2 Clip Properties. Video 

. 
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This panel appears if the clip's source file contains video data. If unchecked 
Use Video disables the use of video data from the source file. This makes sense 
when the source file contains both video and audio. 
Frame rate is measured in frames per second. It determines the duration of 
playback for video. The frame rate of the source file is displayed in the info area 
at the right of the Open Clip dialog box. The frame rate can be changed provided 
in the current project there are no clips referred to video data of the source file. 
Width and Height present geometrical parameters of the video frame. 
Codec name and short name provide two variants of video CODEC name. 
Data size shows the size of video data in the source file. 
Data rate shows the averaged video data stream. 
Duration shows the duration of video data of the source file in the current time 
format. 
NOTE, that the current frame rate is used to calculate Data rate and Duration, see 
above, as well as the values in the In, Out, Duration fields on the General panel. No 
change in the frame rate can affect the duration of audio playback. If both 
Use Video and Use Audio are enabled and the current frame rate value is greater or 
lower than that of the source file, audio data inserted into the project will be 
truncated or padded with zeros, respectively. It may be convenient for 
duplicating clips when only Use Video is enabled for one copy and only Use Audio 
for the other. 
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8.9.3 Clip Properties. Audio 

 

This panel appears if the clip's source file contains audio data. 
Use Audio – turning this option off disables the use of audio data from the source 
file. This makes sense when the source file contains both video and audio. 
The Ratio parameter shows the sample rate of audio in the source file. 
The Bits parameter shows the number of bits per sample (audio format). 
Channels show mono / stereo for one or two channels, respectively. 
Data size shows the size of audio data in the source file. 
Data rate shows the averaged audio data stream. 
Duration shows the duration of the playback of audio from the source file in the 
current time format. 
Compensate DC offset is used to compensate DC-offset of the audio in the source 
file automatically. See also Audio Settings. Note that this requires additional 
computations and may slow down the performance during playback. 
Left / Right – show DC-offset in each audio channel in sample values (maximum 
value of 32576). If it is equal to 0, no DC-compensation is needed. You can 
adjust it manually (however, it is unnecessary in most cases). 
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Refill waveform and DC – press this button to re-read audio from the source file, 
refill its waveform picture, recalculate DC offset and show it in Left / Right. 

8.9.4 Clip Properties. Midi 

 

This panel appears for midi clips only. 
The Duration parameter shows the duration of playback of the source midi-file in 
the current time format. 
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8.9.5 Clip Properties. Thumbnail 

 

This panel appears if the clip source file contains video data. The slide bar allows 
selecting the video frame that will be displayed on the clip in the Clip Collection 
window. 
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8.9.6 Clip Properties. Summary 

 

A clip of the source file may have various embedded information fields. Some of 
these fields are presented on this tab panel. See also the section 
Summary Settings. 
Use the Extended button on the Summary tab panel of the Clip Properties dialog 
box to call the Extended Summary dialog box. 
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8.10 Clip Properties. ID3-tag Summary 

 

Audio clip compressed in mp3-format can contain summary stored in ID3-tag 
header. Its fields describe song title, artist, album name and year of release, 
musical genre and some text comments. 
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8.11 Toolbar. Clip Collection 

 

The first 5 buttons on the Toolbar duplicate the commands on the File menu. 

 create a new (empty) clip collection. Confirmation 
requested for saving changes to the current 
Clip Collection or canceling the creation of a new 
collection; 

 open the selected clip collection file; 

 save changes to the current clip collection file. For the 
newly created collection, a file name is requested. By 
default, clip collection file has *.PRC extension; 

 save changes to a new clip collection file; 

 call the Open Clip dialog box to add a new clip to the 
current clip collection; 

 switch to the Project window. See also Project on the 
Window menu; 

 when the button is pressed and grayed, video will be 
skipped when you drag clips from clip collection to 
Project window. Use this button to use audio only from 
clips with video and audio; 

 when the button is pressed and grayed, audio will be 
skipped when you drag clips from clip collection to 
Project window. Use this button to use video only from 
clips with video; 

 playback the selected clip. See also Play on the clip local 
menu; 
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 stop the playback. See also Stop on the clip local menu; 
Clipboard commands are also available on the Edit and clip local menus. Note 
that from the Clipboard clips of the Clip Collection will be inserted on the first 
track of appropriate type in the Project; 

 clear the Clipboard and add the clip to the Clipboard 
(the clip is placed on the first track); 

 add this clip to the Clipboard (clips are added 
consecutively on the first track); 

 paste all clips from the Clipboard into the 
Clip Collection. 

 

Buttons in this part of the Toolbar duplicate the commands on the View menu. 
First 4 buttons in this part control appearance of Clip Info windows: 

 (Full Info) maximum information about clips; 

 (Basic Info) basic information about clips; 

 (Large Icons) clips as large icons; 

 (Small Icons) clips as small icons. 
The following 3 buttons are used to control the order of clips in the 
Clip Collection window: 

 sort the clips in the collection upon addition of a new 
clip; 

 sort the clips in the collection by type in the following 
order: Video and Audio clips, Video clips, Audio clips, 
Midi clips; 
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 sort the clips in the collection by clip name. 
The following 3 buttons allow selecting current format for time values: 

 Time in Frames, time as frame counter. One second 25 or 
25fr for video frame rate 25 fps; 

 Time in SMPTE, Hours : Minutes : Seconds : Frames’. One 
second 00:00:01:00 or 00:00:01:00fr 

 Time in milliSeconds, 
“Hours : Minutes : Seconds : Milliseconds”. One second 
00:00:01:00 or 00:00:01:00fr 

8.12 Clip Collection Accelerators (‘Hot keys’) 
Action First accelerator Second accelerator 

File operations 
Open source file(s) Insert F4 
New clip collection Ctrl+N Shift+F3 
Open clip collection Ctrl+O F3 
Add from clip collection(s) Ctrl+Shift+O Ctrl+F3 
Save clip collection Ctrl+S F2 
Save clip collection as Ctrl+Shift+S Shift+F2 

Edit operations 
Delete  Delete 
Add to clipboard Ctrl+Shift+C Ctrl+Shift+Insert 
Copy to clipboard Ctrl+C Ctrl+Insert 
Paste from clipboard Ctrl+V Shift+Insert 
Remove unused clips  Shift+Delete 

Arrange operations 
Move current clip up Shift+Up arrow  
Move current clip down Shift+Down arrow  
Move current clip to right Shift+Right arrow  
Move current clip to left Shift+Left arrow  
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Select operations 
Select upper clip Up arrow  
Select lower clip Down arrow  
Select right clip Right arrow  
Select left clip Left arrow  

Other operations 
Playback clip Enter Space 
Stop clip playback Enter Space     Esc 
Show Project window  F6 
Show Faders window  F7 
Show DDSound Volume
control window 

  F8 

Show Video window  F9 
Exit Ctrl+Q  
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9 Playing video on FD300 boards 
If there are some FD300 boards correctly installed in the system, you can 
perform video playback on any of these boards from Forward AV Studio (version 
3.51 or higher). Open Options dialog (press F5), select Video tab and select the 
following Playback mode from the drop-down list: Decompress 
to SLTM player (FDTM board). 
If there is no such choice in the list, be sure that: 
• software and drivers for FD300 boards of the latest version are properly 

installed; 
• the boards are functioning properly (in the system Device Manager); 
• the FDConfig application can be launched successfully and it does not show 

any error messages; 
• you are using the latest version (3.51 or higher) of Forward AV Studio. 
Typically proper installation of the latest version of FD300 software and 
Forward AV Studio should resolve the problem. 
When you select Decompress to SLTM player (FDTM board) playback mode, the 
Properties button appears. Pressing this buttons shows dialog that allows you to 
select desired FD300 board and tune its settings for video playback. 
This dialog contains three tabs: 
• General – general parameters; 
• Format – board and video format selection; 
• Output – settings of video-output of selected board. 
You should tune parameters in these tabs before playing video. 

9.1 General – general parameters 
This page contains general video playback parameters. 

Video Playback Status this field contains currently selected FD300 board index 
(you can select desired board in the Format property 
page) and current status of playback, for example: 
Playback on the board #0 is Enabled. Status string can 
include: Enabled – playback on current board is enabled; 
Disabled – registration of current board does not allow 
playback of video, please select other board or obtain a 
valid registration key for it; Locked – some other process 
is already performing playback on current board, select 
other board or stop playback in other process; Blocked – 
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some other process (usually OnAir) used all scenes for 
video playback on current board, select other board or 
close other process. 

Automatically save / restore boards settings 
 turn this option on if you want settings of all FD300 

boards (such as video standard, video size, etc. – all 
parameters in the Format and Output property pages) to 
be saved and restored next time. 

Upper field first by default this setting is off, it means that interlaced 
video will be shown with lower field first. It is normal 
for DV and MPEG2-compressed video. Some other 
video formats assume inverted fields order (for 
example, Forward), turn this option on in this case to 
make upper field first. 

 Try to turn this option on/off if you encounter image 
flickering (broken moving etc.) on external TV monitor, 
possible reason can be that video fields order is 
inverted. Don’t turn this option on for deinterlaced 
(progressive-scan) video material. You may also try to 
use option Automatically detect fields order by 
compression type. The right fields order will be detected 
automatically by video compression type. 

Autodetect fields order by compression type 
 this option is turned on by default – it means that fields 

order will be detected automatically by video 
compression type. If you encounter incorrect fields 
order (the image is flickering on external TV monitor), 
turn this option off and try to change fields order 
manually with the previous Upper field first option. 

Show video on board as 
 select what video mixer input will be used to show 

video being played: Foreground – foreground, or artist 
(set by default); Background – background (will be 
hidden if there is a non-transparent video in the 
foreground); Alpha – alpha channel (only alpha channel 
of video will be shown, or luminosity component of the 
image will be used as alpha channel if there is no alpha 
channel in the video); Title – title (will be shown over 
any other video). 

 Important: if you want to play video with alpha channel, 
use only Title mode, because in other modes only video 
without alpha channel (Foreground and Background 
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modes) or only alpha channel (Alpha mode) will be 
shown! 

 The video might not be shown if it is hidden by other 
non-transparent video in some mixer input. Turn on the 
next option if you want to be sure that video is shown 
on the board output. 

Force show video and hide other mixer inputs 
 turn on this option if you want to be sure that video is 

shown on the board output. Video on all other mixer 
inputs will be turned off in this case. 

The Video Format Information group includes the following: 
Input / output format this field shows two types (FOURCC codes) of formats: 

the first one is format of source (compressed) video, and 
second one is output format on the FD300 board (can be 
Y16/Y16A – without/with alpha channel). 

Important: registration of selected FD300 board must allow video playback on 
it! Be sure that the status string is ending with Enabled before working. 
There should be no other applications (like OnAir) that perform video playback 
on the same FD300 board (status string can be ending with Locked or Blocked). 
Close such applications or select other FD300 board for video playback in the 
Format page. 

9.2 Format – board and video format selection 
This page allows you to select desired FD300 board for playback, select video 
format and image size on selected board. 

Board index – index of currently selected FD300 board. 
TV Standard – output TV-standard, can be PAL or NTSC. 
Image size – output image size, can be half or full resolution. 
Width – current width of output image in pixels. 
Height – current height of output image in pixels. 

Width and height depend on the selected TV standard and image size. 
Important: some values can be restricted by the registration of selected FD300 
board or by running application, and you will not be able to select some values of 
some settings in this case. 
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9.3 Output – settings of video-output of selected board 
This page allows you to adjust parameters of video output of selected (in the 
Format tab) FD300 board: video output path, output analog signal type, and 
genlock settings. 

Video output switching output bus mode of FD300 board. It can be one of: 
Internal –> analog encoder – analog output only; Internal –> 
analog encoder + digital bus – both analog and digital 
outputs; Digital bus –> analog encoder – get video data 
from digital input of FD300 board and transport it to its 
analog output. 

 Important: if you don’t have digital video source 
connected to FD300 board, use only first mode! 

Analog video encoder type 
 the type of output analog video signal. If you want to 

have composite signal in the output, select YUV+CVBS 
type. 

 Important: please read the Breakout box section in the 
VS2000 user’s guide for more details about signal types 
and video output connections. 

Genlock Internal Video Output group allows you to select mode of video 
synchronization (genlock): 

Source selected synchronization (genlock) source. It can be one 
of: Master – genlock by internal clock source of FD300 
board; Line 1 – genlock by video signal from the input 
line 1; Line 2 – genlock by video signal from the input 
line 2. 

X offset horizontal synchronization offset. Default value is 550. 
Y offset vertical synchronization offset. Default value is 2. 
SC Phase synchronization delay of color splash phase. Can be 

used for synchronization of composite signals, default is 
0. It is not recommended to change this setting unless 
necessary. 

Changing of X and Y-offset allows you to obtain accurate synchronization to 
genlock source signal. 
Important: some values can be restricted by the registration of selected FD300 
board or by running application, and you will not be able to select some values of 
some settings in this case. 
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10 Audio effects 

10.1 Working with audio effects 
Audio effects are special modules included with Forward AV Studio for real time 
processing of sound (without using any temporary files and without changing the 
source files). The types of processing are different: equalizers (control volume 
balance between different frequency components of sound), digital filters 
(suppress various frequency components to get various effects), delays (to get 
effects like echo) and some others (even not processing sound at all, but getting 
some information about sound being processed). You can also use any external 
Direct-X plug-insprovided by third-party manufacturers. 
Audio effects can be applied to audio clips, tracks and whole projects (a mix of 
all audio tracks). 
Effects are grouped in lists that can have almost unlimited chains of effects. All 
effects can process audio in real time (you must have a computer fast enough to 
mix many tracks with audio effects applied in real time; however, any effect can 
be applied even on slow computers during the export of a project to the resulting 
file) without changing the source file and using temporary files. You can change 
any processing parameter during playback of an audio clip, a track or the whole 
project and hear the results almost instantly. For some audio effects you can 
change the quality of processing (see Effects Settings), which allows increasing 
Forward AV Studio performance during playing in real-time. 
Effects can be applied and edited using the local menus of audio clips and tracks 
or the Edit and Command menus. You can cut/copy single effects and effects chain 
to the Clipboard, paste and save/load them using the Effects List dialog box. 
Any effect or chain of effects can be turned on (used)/off (bypassed) without 
their removing or re-adding. If you have added an effect to a clip or track, it will 
be shown as a small triangle in the bottom left corner of the clip/ track state 
window (the triangle for master effects is shown on the current time window). 
The triangle is green if the effect is on, and red otherwise (these colors may be 
changes in the Colors Settings). You can access the effects list by clicking or 
double clicking on the triangle (you may change it in Effects Settings), or 
pressing A key on the keyboard when the mouse cursor is on the clip or track (see 
also the section about keyboard accelerator). 
You can add/paste effects from the Clipboard to many selected clips 
simultaneously: copy the desired effects to the Clipboard, select a group of clips 
and use the Audio effects submenu of the Edit menu. Use the same menu if you 
want to remove or turn on/off effects on many clips. 
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You can control the parameters of audio effects in real time in different ways: by 
using the Preview button in the Effects List dialog box or by starting playback of 
the project and calling the effects list of any track or the whole project (master 
effects), by using A key on the track or through the Faders window. This latter 
way allows you to control the parameters of audio effects during playback on 
different tracks and master effects simultaneously. 
All these features provide very effective and flexible work during audio mixing 
and processing by Forward AV Studio. 
All audio effects process audio during real-time playback without any changes of 
source audio files and without use of temporary files. You can change any 
parameter of processing during playback of audio clip, track or project and hear 
the result almost instantly. You can change quality of processing for some audio 
effects; it allows you to increase performance of Forward AV Studio during real-
time playback (read description of particular effects to know if they support 
different processing qualities or not). 
You must have computer fast enough to mix many tracks with audio effects 
applied in real-time. However, any effects can be applied even on slow 
computers when exporting project to a resulting audio file (when saving it using 
Export command in the File menu). 
Audio effects can be applied to audio clips, tracks and entire project (mix of all 
audio tracks). Audio effects are organized as effects lists that can include almost 
unlimited chains of effects. Sound is being processed in correspondence with 
order of effects in chain. 

Presence of audio effects is shown as small triangle on the bottom left corner of 
clip, track state window or current time window (for master audio effects). If 
triangle is green, effects are on (active), if it is red, effects are off (bypass). 
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Colors of triangles can be changed in Colors Settings. Click or double-click on 
triangle opens audio effects list dialog (depending of Audio effects Settings). 
You can use various ways to add or edit lists of audio effects: 
To add or edit audio effects on a clip or an audio track via local menu, press right 
mouse button when mouse cursor is over an audio clip or track state window (at 
the left of an audio track). Press right mouse button on current time window to 
add or edit master audio effects for processing of entire mix of all audio tracks 
(you can do it from Command menu too). Find Audio effects item in a local menu, 
its submenu contains the following commands: 

Add / Edit calls audio effects list dialog to add or edit effects list 
Use turns effects list on/off (bypass) 
Delete removes effects list 
Cut removes effects list to clipboard 
Copy copies effects list to clipboard (you can also copy 

effects via drag-n-drop: see editing operations for details) 
Paste inserts or adds effects previously put to clipboard with 

one of previous two commands. If some effects were 
already present in current effects list, you will be asked 
what to do: replace current effects with ones of 
clipboard, or add effects from clipboard to the end of 
current effects list. 

You can also use keyboard shortcuts to access audio effects list (see also section 
about other accelerators). 
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Tip: if you want to turn on/off, delete or paste audio effects on many clips 
simultaneously, select desired clips and use Edit/Audio effects menu commands. 
Additional local menu is called by pressing right mouse button when mouse 
cursor is over a triangle indicating present of audio effects. You can also call it 
by pressing Shift+A when mouse cursor is over an audio clip, track state window 
or current time window (for master effects).  

 

This menu allows you to quickly access desired audio effect or activate desired 
effect profile by selecting it from menu. If there were no audio effects when you 
want to activate additional local menu, audio effects list is opened to add new 
effects. 
You can use keys on keyboard to perform audio effects editing operations. Move 
mouse cursor over an audio clip, track state window or current time window and 
press the following keys to: 

A open effects list to add or edit audio effects 
Shift+A call additional local menu for quick access to audio 

effect or effect profile 
U turn audio effects on/off 

If audio effects are already present on clip, track, or entire project, move mouse 
cursor over triangle (that indicates presence of audio effects) and press the 
following key to: 

Del remove effects 
Note: you can open effects list and turn effects on/off on tracks and entire project 
during playback (you can do it from Faders window too). 
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You can use Faders window to call audio effects lists for tracks and entire 
project (master effects) using Edit FX buttons. Use FX checkboxes allow you to 
turn on/off effects on desired tracks or master effects. All these operations can be 
performed during real-time playback. 
You can tune settings of audio effects on different tracks and project 
independently and hear the result in the mix of all tracks during playback. 
Using Audio effects submenu of Edit main menu, you can delete, paste/add and 
turn/on off audio effects on many selected clips simultaneously. For more details 
please read section about Edit menu. 
Use Master effects submenu of Command main menu to add or edit master audio 
effects (for processing of mix of all audio tracks). For more details please read 
section about Command menu. 
You can edit master audio effects using local menu of Current time window or 
using keyboard shortcuts on it. 
For quick access to particular effects or effect profiles, you can use additional 
local menu. It can be called by pressing right mouse button when mouse cursor is 
over triangle indicating presence of audio effects. 

10.1.1 Audio effects editing operations summary 
Applying effects. Effects can be applied and edited through corresponding local 
menus of audio clips and tracks, through Edit and Command menus and Faders 
window. You can cut/copy single effects and effects chains to clipboard, paste 
and save/load them using Effects List dialog box. 
Accessing effects. You can access effects list by clicking or double-clicking at 
triangle indicating presence of audio effects (you may change it in 
Audio Effects Settings), or by pressing A key on keyboard when mouse cursor is 
over an audio clip or track state window. Pressing Shift+A activates additional 
local menu for quick access to particular effect or effect profile. 
Copying effects. Effects can be copied via drag-and-drop: move mouse cursor on 
triangle (that shows presence of audio effects), press and hold left mouse button 
(mouse cursor will change its shape), move mouse cursor to any clip, track state 
window (to copy effects to audio track) or current time window (to copy effects 
to master effects), and release mouse button. If there already were some audio 
effects on object that you want to copy effects to, you can replace them or add 
effects to the end of already existing effects list (you will be asked a question 
about it). 
Turning effects on/off. Any effect or chain of effects can be turned on (used)/off 
(bypass) without removing and re-adding them. Effects can be turned on/off with 
U key and deleted with Del key on keyboard. 
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You can add/paste effects from clipboard to many selected clips simultaneously: 
copy desired effects to clipboard select a group of clips and use Audio effects 
submenu of Edit menu. Use the same menu if you want to remove or turn on/off 
effects on many clips. 
Tuning effects. You may control parameters of audio effects in real-time playing 
by various ways: use Preview button in Effects List dialog, or you can start 
playback of project and call effect list of any track or entire project (master 
effects) using A key on tracks or through Faders window. This way allows you 
to control parameters of audio effects during playback on different tracks and 
master effects simultaneously and independently. 
All these features provide very effective and flexible work when mixing and 
processing audio with Forward AV Studio. 

10.1.2 Audio effects with profiles 
Some audio effects that are included with Forward AV Studio allow you to 
define ‘scenario’ (profile) of change of their parameters in time. It means that 
you can not only set static values of effect’s parameters, but you can also 
draw profiles on audio clips that denote how parameter(s) should be changed in 
time. Profiles of audio effects are edited with the same manner as when editing 
volume/panorama profiles, with mouse and keyboard shortcuts. 
Name of each audio effect that supports profiles always start with Profile (see also 
description of particular effects to know what ones support profiles for their 
parameters). Such effects can be applied on audio clips only. All profiles of one 
audio effect are shown on clip simultaneously, but only one active profile can be 
edited. You can increase line thickness of line of active profile up to 3 pixels to 
make it better visible using Audio settings. To switch between profiles, use 
additional local menu on audio clips or audio effects list dialog. 
Note that you must switch to audio effects profiles editing mode if you want to 

edit profiles of audio effects (use the  icon on the toolbar). When you select 
active profile from audio effects list dialog or press Edit button in the dialog box 
of audio effect to edit desired profile, this mode is turned on automatically. 
You can perform the following operations with profiles of audio effects: 

1. Edit with mouse and keyboard shortcuts with the same manner as when 
editing volume/balance profiles on audio clips. 

2. Switch between profiles. Select desired profile to make it active for editing 
– you can do it with additional local menu on audio clips, audio effects 
list dialog or Edit buttons in dialogs of audio effects. 
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3. Turn profiles on/off. If profile is turned on, static value of parameter is 
used instead of profile, and you can set the value manually in effect’s 
dialog. You can turn profiles on/off in audio effects list dialog or in 
dialogs of audio effects. 

Important: smooth change of parameters of audio effects with profiles requires 
significant amount of calculations during playback. Your computer must be 
powerful enough to use audio effects with profiles. If you encounter breaks in 
sound during playback, try to increase audio buffer size in Audio settings or 
select faster modes of processing for real-time playback in Audio effects settings 
(press F5). 

10.2 Audio Effects List dialog box 

 

This dialog box allows creating and modifying a sequence (chain) of audio 
effects to process audio clips, tracks or whole projects depending on where you 
add or edit audio effects (the title of this dialog box is ‘Clip effects list’, ‘Track 
effects list’ or ‘Master effects list’, respectively). The sound will be processed in 
the order the same with the order of effects on the list, from the top of the list to 
its bottom. 

Forward AV Studio   126 



10. Audio effects 

 

All buttons have tool tips, so you can see short text function descriptions of all 
buttons. Just move the mouse cursor and hold it above any button with an image. 
Effects group is for working with one effect. You can add/remove or locally 
rename an effect, edit its parameters, view frequency and phase response of the 
selected effect (available only in ForwardAVStudio Pro). You can change the 
order of effects in the chain, copy/paste effects to/from the Clipboard, turn on/off 
any audio effect using checkboxes at the left of its names in the list (when the 
box is checked, the effect is on) or in the effect dialog box using the Bypass 
checkbox (when Bypass is checked, the effect is off and does not process sound). 

 Add Above select an effect from the list of available effects and add 
it above the currently selected effect in the list. 

 Add Below select an effect from the list of available effects and add 
it below the currently selected effect in the list. 
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Note: you can get the message ‘No audio effects are installed on your system’. 
You may see it if you have both Windows 95/98 and Windows NT on your 
computer and have installed Forward AV Studio Pro under one system and run it 
under the other. You should install ForwardAVStudio Pro under both systems. 

 Remove remove a selected effect from the list. 

 Edit run the setup dialog box to set the parameters of the 
current effect. You can also double-click on the name of 
the effect to run its setup dialog box. 

 Move Up move the currently selected effect one step up in the list. 

 Move Down move the currently selected effect one step down in the 
list. 

 Name type a new name of the effect to rename it. You can 
restore the original name of the effect in the local menu. 

 Frequency Response 
 show the frequency and phase response of the currently 

selected effect. 
You can also use the Ins and Del keys on the keyboard to add/delete audio effects. 
Click on a desired effect in the list to delete it with the Del key or add another 
effect after the selected one with the Ins key 
Names of profiles (parameters of current audio effect that can be changed in time 
with profile) are shown in the list in Profiles group (if number of profiles is 
greater than 3, it is shown in brackets). Each profile can be turned on/off using 
checkboxes at the left of profile name. When checkbox is on, profile is used, and 
off otherwise (it means that a static value of this parameter instead of profile is 
used; this value can be set in effect’s dialog), and profile is not shown on clip in 
this case (you can hide a profile without turning it off using Hide checkbox at the 
right of profile’s name). 
If you double-click at profile name, effects list will be closed, current profile will 
be set as active and you will be able to edit this profile on clip immediately. 
If checkbox Colors is turned off, current predefined color of profile is shown on 
this button, and you cannot change it here (you can define five standard colors of 
effect profiles in Colors Settings). If you want to set custom color of profile, turn 
on checkbox, press button and select desired color in standard system color 
selection dialog. 
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If checkbox Log Scale is enabled (not grayed), current selected profile allows to 
use logarithmic vertical scale when editing it graphically on clip. This is useful 
for editing profiles of parameters like frequency of a digital filter, because of 
features of human’s perception of musical tone pitch. Linear change of frequency 
in octaves is more natural than in Hz, and linear scale in octaves (logarithmic in 
Hz) is more comfortable in use. 
If current profile allows it, turn on this checkbox to switch to logarithmic scale of 
current parameter (usually it is turned on by default for such profiles). 
Visible Top / visible Bottom values define visible vertical range of current profile 
when editing it on clip (current range is shown on clip at its right). It does not 
mean that values of parameter in all points on profile are limited by these two 
values, it only means that range between these two values will be shown on clip, 
and points outside this range are kept without any change. Use it for fine editing 
of profile in desired range. 
Note: you can edit values in edit boxes using right mouse button. 
Effects List group is used to work with the entire list. You can save, load and clear 
the list, run real-time preview to hear how the chain of effects affects the 
processed sound or view the frequency and phase response of the entire chain of 
effects. You can copy/paste effects to/from the Clipboard (use the local menu to 
copy a single effect). You can turn on/off the entire list of effects using the 
Skip All checkbox (when it is checked, the effects do not process the sound). 

 Copy copy the entire effects list to the Clipboard. 

 Paste paste effect(s) from the Clipboard after the currently 
selected effect in the list. 

 Clear list clear the entire list (remove all effects from the list). 
You will be requested to confirm the cleaning. 

 Preview run real time preview. This button starts the playback of 
the current part of the project (audio clip, track or entire 
project) processed with the current effects chain. During 

playback you can press  button or double-click on 
the name of any effect to run its dialog box where you 
can change any parameter of sound processing. All 
changes will take effect almost immediately, so you can 
control the processing of sound during playback. 
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Playback is repeated until you press  (the same) 
button. 

Note: Preview in real time is performed without breaking the sound only if your 
computer is capable of processing sound with the current chain of effects in real 
time. You have to have a sufficiently fast central processor. To increase the 
performance of some effects, you may also select a faster processing for real-
time preview in the Effects Settings. 

 Load restore the effects chain (saved earlier) from an external 
file. 

 Save save the current effects chain with all the settings to an 
external file. 

 Frequency Response of List 
 show the frequency and phase response of the entire 

chain of effects. 

10.2.1 Local menu 
Local menu is called by pressing the mouse right button on any effect in the list. 
There are the following commands in this menu: 

Edit same as  button. 
Bypass turn on/off the current effect. When Bypass is checked, 

the effect is off (you can use Bypass checkbox in the 
effect dialog box). You can use the checkbox at the left 
of effect's name. If it is checked, the effect is on (bypass 
is off). 

Change name same as  button. 
Restore name restore the original name of the effect. 
Show frequency response 

 same as  button. 
Copy this effect only copy the currently selected effect to the Clipboard. 
Paste effect(s) paste the effect(s) from the Clipboard and insert it after 

the current effect. 

Delete same as  button. 
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10.3 Select Audio Effect dialog box 

. 

In this dialog box, there is a list of audio effects for Forward AV Studio installed 
on your system. You can choose any effect by double clicking on its title or by 
pressing the OK button. 
Audio effects with profiles can be used on audio clips only, so when you want to 
add an effect on a track or entire project, effects with profiles will not be shown 
in the list of available effects. 
Note: when you run this dialog box the first time, Forward AV Studio searches 
for any installed effects. This may take some time. The next time no searching 
will be needed. 
You can get the message ‘Can’t create audio effect’. In this case, you should 
reinstall Forward AV Studio or get a newer Forward AV Studio version. 
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10.4 Frequency and phase response dialog box 

 

The diagram in this dialog box allows carrying out visual analysis of the 
frequency and phase response of any audio effect or chain of effects (effects list). 
In other words, you can see how audio effects affect the processed sound at any 
frequency. In stereo mode, the response can be shown for both channels or 
separately for the left/right channel. You can also use a sinusoidal test signal to 
analyze frequency shifts and harmonics made by the effects. 
Data group defines the main parameters of data analysis. 
FFT Size (128 up to 64K) – a number of points in the fast Fourier transform. 
Select greater values to obtain more accurate response. In this case the 
calculation will take longer. 
Window – defines which of the window functions (or none) is applied to 
frequency response. This setting is available only for sinusoidal test signal (when 
Sin instead of Impulse is selected in the Test with group). 
Scale group defines the horizontal scale type and frequency range. 
Freq Scale (Log/Linear) – logarithmic/linear frequency scale. Logarithmic scale is 
useful for the analysis of such effects as graphic equalizer, where the center 
frequencies of filters differ from each other in octaves (relatively). Linear scale is 
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useful for such effects as delay, where the frequency notch points are equidistant 
with respect to their frequencies. 
Min Freq (Hz) – minimal frequency of a shown range. You can select any 
predefined value from the list or just input any desired value. The minimal 
frequency must be less than Max Freq and greater than zero for the logarithmic 
scale. 
Max Freq (Hz) – maximum frequency of a shown range. You can select any 
predefined value from the list or just input any desired value. The Maximum 
frequency must be greater than Min Freq and less than on half of the sample rate. 
Note: you can use Zoom function to magnify any frequency range to fit the entire 
diagram. To do this, press and hold the mouse left button on the first point of the 

desired range, then drag the lens mouse cursor  to the second point and 
release the mouse button. Click the mouse right button on the diagram or press 
the Out button to return to the previous frequency range. Press the Full button to 
return to the full frequency range immediately. 
Show group defines the response(s) to be shown and the type and range of the 
shown values. 
Freq – show/don’t show frequency response. 
Hz/Norm – show the frequency at the cursor in Hz or normalized to the sampling 
frequency form in Data at cursor group. On the diagram the frequency is always 
shown in Hz. 
Value (dB/Dec) – show the frequency response in decibels or decimal form. 
Range: Auto – use/don’t use automatic vertical range zoom if the frequency 
response is shown in decibels. Range is automatic only for the decimal form. 
Positive – positive range in decibels if Auto Range is off. You can select any 
predefined value from the list or just type it. 
Negative – negative range in decibels if Auto Range is off. You can select any 
predefined value from the list or just type it. 
Phase – show/don’t show phase response. Phase response is not shown if the 
testing signal is sinusoidal (when Sin instead of Impulse is selected in the Test with 
group). 
Note: At least frequency or phase response must be shown or you can show both. 
If you use a sinusoidal testing signal, the frequency response is shown 
obligatorily. If frequency response is shown in decibels, the dotted horizontal red 
lines show the minimal, maximum and 0 dB levels. To see the minimal and 
maximum levels of phase response, turn off the frequency response option. 
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Colors button shows the color selection dialog box for frequency and phase 
response. 
Refresh button updates the diagram. You can see the evolution of response in 
time for the effects that change its characteristics in time (such as flanger or 
variable filter etc.). 
Reset button sets all effects to its initial state and updates response. 
Note: you do not need to press these two buttons when you change any effect 
parameter settings to reflect changes in response. When you change the list of 
effects or any parameter, response is updated automatically. 
Test with group denotes which form of signal is generated for analysis. 
Impulse – generates a single impulse that is normal for frequency and phase 
response. 
Sin (Hz) – generates sinusoidal wave to show how effects affect to signal of a 
specified frequency. You can see additional harmonics and appreciate distortions 
of the sound being processed. You can select any predefined value from the list 
or just type it. Frequency must be greater than zero and less than one-half of the 
sample rate. It is useful to set Auto Range or show frequency response in decimal 
form in this mode. You can use the window functions in this mode if you turn on 
the Window checkbox in Data group and select a desired function from the 
dropdown list. 
Note: when you type any value manually, you can update the diagram by clicking 
on it with the mouse left button or by waiting for about half of a second for the 
diagram to be updated automatically. 
The following three groups show the corresponding data in two columns in the 
stereo mode: the first column shows data in the left and the second in the right 
channels. In the mono mode, only the first column is active. 
Data below cursor group shows the values below the cursor when it is on the 
diagram as a vertical line. 
Freq – the current frequency below the cursor. You can show it in Hz or 
normalized to the sampling frequency form with the use of the Hz/Norm combo 
box. 
Value – the current value of frequency response below the cursor. 
Angle – the current value of phase response (phase shift) below the cursor. 
Value Range group shows the minimum and maximum of frequency response. 
Max Value at… – the maximum of frequency response for a specified frequency. 
Min Value at… – the minimum of frequency response for a specified frequency. 
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You can visualize these values in decibels or decimal form using the dB/Dec 
combo box. 
Angle Range group shows the minimum and maximum of phase response. 
Max Value at… – the maximum of phase response for a specified frequency. 
Min Value at… – the minimum of phase response for a specified frequency. 
Stereo Mode group is active only for stereo sound and allows selecting a channel 
of response to be shown. 
Both Ch flag is used to display the response of both channels. 
Left Only flag is used to display the response of the left channel. 
Right Only flag is used to display the response of the right channel. 
Note: In stereo mode the frequency response is shown for the effects list that is 
applied to a stereo clip or when the project is stereo and the list of effects is 
applied on a track or the project. At the top of the diagram you can see which 
responses are shown in which colors. 
Note: when you press the Close button, all parameters of this dialog box will be 
stored according to program settings. 

10.4.1 Response Colors dialog box 

 

This dialog box allows changing the colors of all elements of the frequency and 
phase response diagram. 
You can click on any color square to select the corresponding color from a 
standard system color selection dialog box. 
Freq Response group is used to set the colors of frequency response elements. 
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Freq Min/Max – the color of the dash-dotted line indicating the minimum and 
maximum levels of frequency response. 
Left/Mono Freq – the color of frequency response for the left channel in stereo 
mode or for a mono sound. 
Right Freq – the color of frequency response for the right channel in stereo mode. 
Phase Response group is used to denote the colors of phase response elements. 
Phase Min/Max – the color of the dash-dotted line indicating the minimum and 
maximum levels of phase response. 
Left/Mono Phase – the color of phase response for the left channel in stereo mode 
or for a mono sound. 
Right Phase – the color of phase response for the right channel in stereo mode. 
Diagram group is used to denote colors of other diagram elements. 
Background – background color. 
Grid – grid color. 
Text – text color. 
Cursor – vertical line (diagram cursor) color. 
Load button is used to load a color scheme from a file. 
Save button is used to save the current color scheme to a file. 
Defaults – restore all diagram colors to default settings. You are asked to confirm 
this command. 
Note: when you change any color or load/save/restore a color scheme the 
diagram immediately changes its colors so you can see the results. Press OK to 
keep current colors or Cancel to restore the previous color scheme (you can also 
restore previous colors after pressing the Defaults button). 
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10.5 Audio effects warning 

 

This dialog may appear when you open a project with audio effects, and the 
program can’t open some of them. It can be caused by some reasons: 
1.Some modules of audio effects were removed from your disk by mistake. 
2.The program was installed under one system (for example, Windows 98) and 
you launched it when working under other one (for example, Windows 2000). 
You must install the program under all systems if you want to work with it under 
all of them! 
3.You are trying to open a project created with later version of the program with 
audio effects that are compatible only with newer version of the program. Note 
that most audio effects included with version 3.5 or later all incompatible with 
version 3.0x! 
In any case, you must reinstall the program with needed version to have audio 
effects working properly. For example, if you worked with version 3.5 or later 
and then you want to return to version 3.0x for some reasons, you must uninstall 
program with version 3.5 and reinstall version 3.0x. 
Selected effect GUID field shows unique identifier of effect selected in the list of 
effects that couldn’t be opened. 

10.6 Audio Effects 
Equalization/filtering effects: 
Graphic Equalizer 
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Variable Filter 
Parametric Equalizer 
Allpass Filter 
FIR Graphic Equalizer 
Delay/echo effects: 
Delay 
Chorus 
Echo 
Phaser 
Flanger 
Sound analysing effects: 
Sound Statistics 
Spectum Analyzer 
Other effects: 
Channel Mixer 
DirectX plug-in Chainer 
Advanced Pan 
Effects with profiles: 
Advanced Pan 
Parametric Filter 
Allpass Filter 
Resonant Filter 
Bandpass Filter 
Shelf Filter 
Delay 
For more detail, please, read the section about audio effects operation in 
Forward AV Studio. 
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10.7 Equalization/filtering effects 
10.7.1 Graphic equalizer 

 

Graphic equalizer is a set of digital filters enabling you to control (equalize) the 
amplification of sound in 10 frequency bands. 
Equalizer is commonly used to improve the balance between different frequency 
components of sound. It is almost impossible to get a clear sound without 
equalizing the sound of the recorded voice and ‘live’ instruments. 
The first filter is a so-called ‘low-shelf’ filter, for which you can set 
amplification at 0 Hz. The last filter is a so-called ‘high-shelf’ filter, for which 
you can set amplification at one-half of the sampling frequency. 
The middle filters are the peaking ones, for which you can set amplification of 
the center frequency of the corresponding frequency band. 
In a given equalizer all band frequencies are fixed, which makes it even more 
convenient to use. The medium band frequencies differ by an octave. If you want 
to equalize the sound more flexibly, use a parametric equalizer rather than the 
graphic one. 
Equalization group is used to denote the amplification in each frequency band in 
decibels (from -20 dB to 20 dB). 
Note: high amplifications (above 6 dB) may cause distortions and audible phase 
shifting in the processed sound. 
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Flat button is used to reset all amplifications to zero (for sound not to be 
processed). 
Graphic equalizer supports the bypass function and presets (see also the note 
about presets storing). 

10.7.2 Parametric equalizer 

 

Parametric equalizer is a set of 5 digital filters that allow you to control 
(equalize) the amplification of sound in 5 frequency bands. It is more flexible 
than graphic equalizer so you can set not only the amplification but also the 
central frequency and relative width (in octaves) of each frequency band. You 
can see how the equalizer amplifies a signal at all frequencies in the diagram. 
The first filter is a ‘low-shelf’ filter, so you can set the amplification at 0 Hz and 
the cut-off frequency, i.e. the width of the low-frequency band. The last filter is a 
‘high-shelf’ filter, so you can set the amplification at one-half of the sampling 
frequency and the cut-off frequency, i.e. the width of the high-frequency band. 
You can also set the ‘steepness’ of these two filters (change it and see the results 
in the diagram). 
Middle filters are peaking. You can set the band center frequency (instead of the 
cut-off frequency for high/low-shelf filters) and the relative width of the band in 
octaves (instead of the steepness for high/low-shelf filters) and the amplification 
of the center frequency. 
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Bands Gain group is used to denote amplification for each filter in decibels (from -
20 dB to 20 dB) for the frequency shown at the bottom of the scrollbar (for 
high/low-shelf filters this value is the cut-off frequency). Use check boxes to turn 
on/off filters in real time playing to compare the sound processed with/without 
corresponding filters. Use buttons  to reset the amplification of a filter to zero 
(for no filter). 
Note: great amplifications (over 6 dB) may cause distortions and audible phase 
shifting of the processed sound. 
Bands group is used to denote the parameters of filters. 
Frequency – center or cut-off frequency of a filter. This value is shown also at the 
bottom of the corresponding filter gain. Frequency must be greater than zero and 
less than one-half of the sampling frequency of the sound is being processed. 
Bandwidth – the relative width of a frequency band (in octaves) or steepness for 
high/low-shelf filters. Use this setting to change the relative range of frequencies 
within which the filter affects the sound. 
Note: for high/low-shelf filters, normal steepness would be 1.0 (if you set it 
greater than 1.0, the filters will have additional gain/notch peaks around the cut-
off frequencies) 

Master gain – output amplification of the resulting sound. Use  button to reset 
master amplification to zero. 
The All zero button resets all amplifications (filters and master) to zero. 
The diagram in this dialog box shows real frequency response of the parametric 
equalizer with current settings. It is updated to reflect any changes in filter 
parameters. The white curve shows the amplification at all frequencies from 
20Hz to one-half of the sampling frequency of the sound being processed. 
Cursor at… shows amplification at the frequency corresponding to the position of 
the mouse cursor on the diagram (shown as a vertical green line). 
Parametric equalizer supports bypass function and presets (see also the note 
about presets storing). 
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10.7.3 Allpass filter 

 

Allpass filter is a special filter that affects only the phase of the sound being 
processed. If you mix it with the original sound, you get the volume weakening 
effect at certain frequencies. This effect is similar to that produced by phaser, but 
the sound has a slightly different timbre. 
This effect may be used for processing the guitar or sound effects like noise (or 
any other). 
1st Frequency (Hz) - the first frequency of allpass filter. 
2nd Frequency (Hz) - the second frequency of allpass filter. 
Filter's central frequency of phase shifting varies between these two values. 
These frequencies must be greater than zero and less than one-half of the 
sampling frequency of the sound is being processed. 
Note: the frequency varies logarithmically to match the peculiarities of human 
perceptions of sound (i.e. the frequency variation is linear in octaves). 
Stereo Phasing (in degrees) denotes the phase difference of the frequency variation 
in the left and right channels (only for stereo sound). For example, if you set it to 
180 degrees and the reading for the frequency in the left channel starts from the 
minimal value (1st Frequency), in the right channel the reading for the frequency 
will start from the maximum value (2nd Frequency). 
Input signal mix – amplification (from 0% to 100%) of the input (not processed) 
sound. Set it to 0% if you want to hear only phased sound but do not want to hear 
any variations in volume. 
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Filtered signal mix – amplification (from 0% to 100%) of the processed sound. If 
you set it to 0%, the filter will have no effect. 
Rate group denotes the rate of filter frequency variation (frequency sweep). 
Freq – frequency of filter frequency variation in Hz. 
Period (in seconds) denotes the period of filter frequency variation. 
Note: when you change one of these values, the other also changes because 
Freq = 1/Period. So you cannot set it to 0. Setting Period too small could result in 
considerable sound distortions. 
Sinusoidal – sets the type of frequency sweep to sinusoidal or linear (such a delay 
sweep is shown on the diagram for flanger). Sinusoidal sweep produces a 
smoother sound. 
Invert sweep – sets the pattern of frequency variation in time, from 1st Frequency to 
2nd Frequency or vice versa. 
Allpass Filter supports bypass function and presets (see also the note about 
presets storing). For this filter you can also set the quality of processing. 

10.7.4 Variable filter 
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Variable filter is a digital filter for which you can set two states (frequencies) 
and a period. The filter's parameters vary between these two states within a 
specified period of time. 
This effect allows obtaining different types of modulation. By modifying 
different filter parameters you can give various effects. 
Type group is used to denote the type of filter to be used. 
LowPass – lowpass filter, HighPass – highpass filter, BandPass – bandpass filter. 
Note: the type of the filter can be set only for both states; otherwise this setting 
has no sense. 
Rate group is used to denote the rate of filter frequency variation (frequency 
sweep). 
Freq – frequency of filter frequency variation in Hz. 
Period (in seconds) denotes the period of filter frequency variation. 
Note: when you change one of these values, the other also changes because 
Freq = 1/Period. So you cannot set it to 0. Setting Period too small could result in 
considerable sound distortions. 
Repeat – if is off, the frequency changes from the first state to the second, then 
backwards (see the diagram): 

 

Or from the first to the second, then jumps back to the first etc. (see the 
diagram): 
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Invert – set the order of frequency change from State 1 to State 2 or vice versa. 
You may get various modulation effects by applying these two settings. 
Signal mixing group is used to control the mixing of the original and filtered 
sounds. 
Input – amplification (from 0% to 100%) of the original (unprocessed) sound.  
Filtered – amplification (from 0% to 100%) of the filtered signal.  
By combining amplifications of the input and filtered sound you can get a variety 
of effects. 
The State 1 group denotes frequencies for the first state of the filter. 
The State 2 group denotes frequencies for the second state of the filter. 
Freq (Hz) – cut-off (for lowpass and highpass filters) or center (for bandpass filter) 
frequency. It must be greater than zero and less than one-half of the sampling 
frequency of the sound is being processed. 
Note: the frequency is changed logarithmically to match the peculiarities of 
human perceptions of sound (i.e. the frequency change is linear in octaves). 
Bandwidth (Hz) – the width of frequency band (for bandpass filter only). It must 
be greater than zero and less than one-half of the sampling frequency of the 
sound is being processed. 
Note: the digital filter cannot ‘delete’ components of a sound with the 
frequencies outside the filter frequency band. It can only suppress them by a 
certain number of decibels. So you cannot get a lowpass filter that completely 
“removes” the components of high frequencies in the processed sound. The 
farther the frequency of a sound from the cut-off frequency in the stop-band, the 
more suppressed the sound. 
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Veriable filter supports bypass function and presets (see also the note about 
presets storing). For this filter you can also set the quality of processing. 

10.7.5 FIR Graphic Equalizer 

 

This effect is used for the same purpose as Graphic Equalizer (controlling of 
balance of volume between frequency components of sound), but it provides 
much better quality of processing (almost the highest possible). 
Phase response of FIR Equalizer is absolutely flat, so it does not distort phase of 
sound being processed at all. However, it requires more processing power.  
This type of equalizer is based on the use of FIR filter with symmetric finite-length 
impulse response (symmetric impulse response provides absolutely flat phase 
response). Length of filter’s impulse response is in points. Select a desired value 
from the list or type it manually (possible values are from 100 to 32000 points). 
1000…100-point filter length is enough for controlling volume of high frequency 
components (1…5 kHz or more), and 10000…20000 points are required if you 
want to control volume balance in low frequencies (100 Hz or less) or if you 
want to significantly suppress sound volume in a band (by 40…100 dB). 
Flat phase response guarantees the highest-quality processing with clearest sound. 
Independent of gain value in any frequency band volume of sound will be just 
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changed as you want and without any phase distortions (that are encountered 
when using Graphic and Parametric equalizers). 
You can control length of filter’s impulse response – the greater it is, the more 
accurate actual frequency response of the filter is, but more calculations (and 
processor power) are required for processing. Fast convolution algorithm is used 
for FIR filtering, so the equalizer can be used even on slow computers with 
default length of filter’s impulse response (1000 points). With such length you 
will be able to accurately control balance of volume in frequency range from 
about 1 kHz up to a half of sample rate of the sound being processed. Increase 
length of filter’s response (use FIR Length control) to get more accurate frequency 
response in low frequencies (below 1 kHz), but you will need more processor 
power for calculations. 
The other advantage of this equalizer is that if you set the same gain in two 
neighbor bands, you will get one flat band in actual frequency response. This 
feature and absolutely flat phase response are impossible to get in analog 
equipment and ordinary Graphic and Parametric equalizers that are based on the 
use of IIR filters (with infinite-length impulse response). 
You can select between three types of equalizer: 10, 20 or 30-band (depending on 
how accurately you want to control balance of volume between frequency 
components). For 10-band equalizer you can use edit boxes above scrollbars to 
type desired gain in any band manually. For 20 and 30-band equalizers you 
should select a band first by clicking at band’s scrollbar or by selecting desired 
band from Current band drop-down list, and then you can type desired gain value 
in Band gain edit box for selected band. 
Maximal gain value is 20 dB, default minimal value is –20 dB. You can change 
minimal gain using Neg range control (select desired value from drop-down list or 
type it manually), maximal possible negative range is –100 dB. Note that if you 
really want to suppress sound volume in a band by 40 … 100 dB (especially in 
low-frequency bands), you may need to increase FIR length significantly.  
Neg range defines negative range of gain values. Default value is 20 dB, so you 
can suppress sound volume in a frequency band by 20 dB. If you want to 
suppress more, increase this value. It will also increase negative range of all 
scrollbars. 
Gain controls define only desired band gains. Actual frequency response of the 
equalizer is shown on the diagram below gain controls. If it differs significantly 
from desired response in low frequencies, try to increase FIR Length (length of 
filter’s impulse response), but it will require more processing power. 
Press Flat button if you want to reset equalizer to flat frequency response (is does 
not process sound in this case). 
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FIR Graphic equalizer supports bypass function and presets. 

10.8 Delay/echo effects 
10.8.1 Delay 

 

This effect allows you to delay the sound for some time to obtain an echo-like 
sound effect. 
This effect is commonly used for processing the recorded voice or for pseudo 
stereo effects (for example, for rhythm guitar). 
Left group is used for delaying the sound in the left channel or for a mono sound. 
Right group is used for delaying the sound in the right channel solely for stereo 
sound. 
The following settings in both groups are used to control the delays in both 
channels independently.  
Delay – the value delay in milliseconds. 
Input signal mix – amplification of input (not delayed) sound in percent (from 0% 
to 100%). You can set it to 0% to obtain only the delayed sound at output. 
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Delayed signal mix - amplification of the delayed sound in percent (from 0% to 
100%). Use this setting to control the volume of the delayed sound (echo). 
Lock L/R flag is used to lock the controls of the left and right channels so that you 
can simultaneously change the delay and mixing in both channels using only the 
controls of one channel. 
Ping-pong flag is used to mix the input sound with the delayed one from another 
channel (for stereo sound only). This is the so-called “ping-pong” or “bouncing” 
echo. 
Note: As the delayed sound in this mode is from another channel, the time of 
delay is also borrowed from the settings of another channel. For example, if you 
set a 500 ms delay for the left channel and a 400 ms delay for the right channel 
in the “ping-pong” mode, the first sound reflections will appear in 400 ms or 
later in the left channel (with the sound from the right channel) and in 500 ms or 
later in the right channel (with the sound from the left channel). 
Feedback is the volume of the resulting sound (mixed from the input and delayed 
sounds) in percent (from 0% to 100%) that is returned to the input of the delay 
channel to get sound repeated reflections effects. 
Warning: Use this setting with care! Values greater than 50% may cause 
overloading of the delay line! 
Both the bypass and presets functions are supported by delay effects (see also the 
note about presets storing). 
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10.8.2 Echo 

 

Echo is an improved (still more complex) modification of delay. There are 3 
bandpass filters for 3 delay lines for each channel. You can set different delay 
times for each frequency band to get complex reflections of the sound. All these 
settings are made separately for each channel to get stereo effects. 
This effect may significantly improve the perception of the recorded voice or 
instrumental solo (guitar, saxophone etc). 
Band mixing group is used to set the amplification in percent (from 0% to 100%) 
for each frequency band. You can control the volume of each filtered echo in the 
output. 
Band delays group is used to set the time of delay for each frequency band in both 
channels (L - left, R - right) independently. 
Lock L / R flag is used to lock the controls of the left and right channels so that 
you can simultaneously change the delay and mixing in both channels using only 
the control of one channel. 
Input -–the amplification of the input (not delayed) sound in percent (from 0% to 
100%). You can set it to 0% to obtain only the delayed sound in the output. 
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Echo – the amplification of mixed delayed sounds in percent (from 0% to 100%). 
Use this setting to control the volume of echo. 
Feedback – the value of the resulting sound (mixed from the input and delayed 
sounds) in percent (from 0% to 100%) that is returned to the input of the delay 
line to get sound repeated reflections effects. 
Warning: Use this setting with care! Values greater than 50% may cause the 
overloading of the delay line! 

10.8.3 Flanger 

 

Flanger is a guitar effect of ‘floating’ sound. Really flanger is a delay with the 
time of delay varying periodically. The diagram describes this process. 
Linear delay change of flanger in time 
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This effect is widely used for processing electric guitar sound. 
Delay (in milliseconds) denotes the minimal delay within the range of its variation 
(see the diagram). 
Depth (in milliseconds) denotes the value of delay variation. The time of delay 
varies from Delay to Delay+Depth (see the diagram). 
Delay and Depth are the main parameters with strong impact on the sound being 
processed. 
Stereo Phasing (in degrees) denotes the phase difference in the change of delay in 
the left and right channels (only for stereo sound). For example, if you set it to 
180 degrees and the reading of the delay time in the left channel starts from the 
minimal value (Delay), the reading for the delay time in the right channel will 
start from the maximum value (Delay+Depth). 
Feedback – the value of the resulting sound (mixed from the input and delayed 
sounds) in percent that is returned to the input to get "harder" sound. Setting it 
too high (more than 50%) could result in distortions (more than 50%). 
Input signal mix – amplification (from 0% to 100%) of the input (not delayed) 
sound. Set it to 0% if you want to hear only the delayed (modulated) sound. 
Delayed signal mix – amplification (from 0% to 100%) of the delayed sound. If you 
set it to 0%, the flanger will produce no effect. 
Rate group denotes the rate of delay time variations (delay sweep). 
Freq – frequency of delay variation in Hz. 
Period (in seconds) denotes the period of delay time variation (see the diagram). 
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Note: when you change one of these values, the other also changes because 
Freq = 1/Period. So you cannot set it to 0. If you set Period too small, this could 
result in considerable sound distortions. 
Sinusoidal – sets the type of delay variation as sinusoidal or linear (such as on the 
diagram). Sinusoidal sweep produces a smoother sound. 
Invert sweep – sets the pattern of delay variation in time, from Delay to Delay+Depth 
or vice versa. 
Flanger supports bypass function and presets (see also the note about presets 
storing). For this effect you can also set the quality of processing. 

10.8.4 Chorus 

 

Chorus is a modification of flanger with many delayed signals added to the 
input to make the effect of ‘many voices’. This version of chorus has two 
‘voices’ for which you can independently set the delay time and period. 
This effect is used to get richer sound when processing voice and solo 
instruments (for example, the acoustic guitar or piano). 
Voice 1 group sets the parameters of the first varying delay (first ‘Voice’). 
Voice 2 group sets parameters of the second varying delay (second ‘Voice’). 
The following parameters are present in each Voice group and have an effect 
similar to flanger. 

Forward AV Studio  153 



10. Audio effects 

Delay (in milliseconds) – minimal delay time, Depth (in milliseconds) – value of 
delay variation. 
Note: these values may be set greater than in Flanger to get deeper effects. 
Freq – frequency of delay variation in Hz. 
Period (in seconds) denotes the period of delay time variation. 
Note: when you change one of these values, the other changes too because 
Freq = 1/Period. So you cannot set it to 0. If you set Period too small, this could 
result in considerable sound distortions. 
Note: only sinusoidal delay variation is used in chorus to get a smoother sound. 
Output group is used to set the parameters of sound mixing in the chorus output. 
Input signal mix – amplification (from 0% to 100%) of the input (not delayed) 
sound. Set it to 0% if you want to hear only the delayed (modulated) sound. 
Voice 1 mix – amplification (from 0% to 100%) of the first delayed sound 
(‘voice’).  
Voice 2 mix – amplification (from 0% to 100%) of the second delayed sound 
(‘voice’).  
Stereo Phasing (in degrees) denotes the phase difference in delay variation in the 
left and right channels (only for stereo sound). For example, if you set it to 180 
degrees and the reading of the delay time in the left channel starts from the 
minimal value (Delay), then in the right channel the reading of the delay time will 
start from the maximum value (Delay+Depth). 
Note: this setting affects both – ‘voices’. 
Chorus supports bypass function and presets (see also the note about presets 
storing). For this effect you can also set the quality of processing. 
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10.8.5 Phaser 

 

Phaser is a modification of flanger but has a very short time of delay so you can 
hear the phase shifts in the sound being processed. You can set the central 
frequency so that the input and delayed sounds give the maximum weakening of 
the volume. 
This effect may be used for processing, say, the guitar or sound effects like noise 
(or any other). Center frequency (Hz) – the central frequency of phaser. 
Sweep depth – the range (from 0% to 100%) of delay variation. By setting it to 
0%, you get a constant phase-shifter and to 100% gives, the maximum delay 
variation. 
Signal mixing – amplification (from 0% to 100%) of the delayed sound. If you set 
it to 0, the phaser produces to effect. Setting signal mixing to 100% produces the 
deepest effect. 
Feedback – value of the resulting sound (mixed from the input and delayed 
sounds) in percent that is returned to the input to get a more expressive effect.  
Stereo Phasing (in degrees) denotes the phase difference in delay variation in the 
left and right channels (only for stereo sound). For example, if you set it to 180 
degrees and the reading for the delay time in the left channel starts from the 
minimal value (Delay), in the right channel the reading of the delay time will start 
from the maximum value (Delay+Depth). 
Rate group denotes the rate of delay time variation (delay sweep). 
Freq – frequency of delay variation in Hz. 
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Period (in seconds) denotes the period of delay time variation. 
Note: when you change one of these values, the other also changes because 
Freq = 1/ Period. So you cannot set it to 0. Setting Period too small could result in 
considerable sound distortions. 
Invert sweep – sets the pattern of delay variation in time, from the minimal to the 
maximum value or vice versa. 
Phaser supports bypass function and presets (see also the note about presets 
storing). For this effect you can also set the quality of processing. 

10.9 Sound analysing effects 
10.9.1 Sound Statistics 

 

This ‘effect’ does not process the sound. It is used to calculate and show the 
following information about the sound being processed: 
Total samples, Time – number of samples and duration of analyzed audio. 
Clipped samples – number of clipped samples (that have the sample value more 
than 0 dB). 
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Note: 0 dB level is assigned to the maximum absolute sample value 32768. All 
values below are shown in sample and dB values relative to 0 dB level (normally 
all values should be lower than 0 dB or you may have clipping elsewhere). 
Positive max level – maximum level of positive samples, Negative max level – 
maximum level of negative samples. 
Average level – average absolute value of all samples. 
Average RMS level – average RMS (root mean square) level. If you add 3 dB to this 
value you will get the RMS power of the sound. 
DC offset – constant offset of a sound (is shown in sample value and percent). If it 
different from 0%, the maximum positive and negative levels may be different as 
the sound is not centered around zero sample. 
Copy button is used to copy all data in the dialog box to the clipboard in text 
format, so you can paste it in any text editor, save to file, print etc. 
This effect also allows viewing sound statistics in real time (during playback). 

10.9.2 Spectrum Analyzer 

 

Spectrum Analyzer shows spectrum of signal being analyzed. You can see 
approximate level of different frequency components of sound on the diagram 
during playback (when dialog window of spectrum analyzer is closed, analysis is 
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turned off). Maximum levels are not shown (Show max is turned off) in the dialog 
box above. 
Spectrum analyzer is widely used for estimating power balance between different 
frequency components, detecting distortion harmonics and undesirable 
frequency components. 
1.Colors of appropriate spectrum graphs are shown at the top of the diagram. 
2.You can resize dialog to see more detailed diagram, but performance may drop 
and you may get breaks in sound during playback. 
3.The 0 dB level corresponds to maximal level of sound without overload, and all 
spectrum values are calculated and shown correspondingly to this level. 
4.Audio buffer size in Audio settings is the main value that denotes how 
frequently the diagram is updated. Set this value smaller to get shorter data 
blocks and more frequent update of the diagram, but it may cause breaks in 
sound during playback. 
5.Some audio effects (for example FIR Equalizer and some DirectX plug-ins) can 
process audio using very large data blocks; it also affects frequency of diagram 
update (the larger data blocks are, the less frequently diagram is updated). Click 
at name of a control to get its description: 
Number of points in the Fast Fourier Transform used for spectrum analysis. The 
more is the length of FFT, the more accurate frequency estimation is, but it 
requires more CPU power for calculations, and the diagram is updated less 
frequently. If you want the diagram to be updated more frequently with larger 
FFT size, increase value of Overlap, but it will require more CPU load (for 
example, 50% overlapping requires 2 times, and 99% overlapping about 100 
times more CPU power for calculations than no overlapping!), so use it with 
care! 
Note: audio buffer size in Audio settings is the main value that denotes how 
frequently the diagram is updated. Set this value smaller to get shorter data 
blocks and more frequent update of the diagram, but it may cause breaks in 
sound during playback. 
Turn option Show max on to see maximal levels calculated during playback. Look 
at the sample image to see the difference between modes when Show max is 
turned on and off. Maximum levels are not shown (Show max is turned on) in the 
dialog box below. 
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Note: you can see colors of spectrum and maximal level graphs looking at the 
top of the diagram. 
Window. Type of windowing function that is applied to signal data block before 
performing FFT. Rectangular window means that no windowing function is 
applied, but it is highly recommended to use any other function (Kaiser window 
is used by default) to get spectrum image more believable. Actually it means that 
prominent frequency components will be visible better. 
Turn option Log scale on to get logarithmic (linear in octaves) frequency scale 
(horizontal) on the diagram (frequency scale is linear otherwise). 
Stereo mode denotes order of drawing of spectrum graphs for left and right 
channels (for stereo sound only). Use it to get spectrum graph of desired channel 
better visible or to see spectrum of mono mix. 
Available modes are: 
Left, Right – draw spectrum graph of left channel first, then right channel; 
Right, Left – draw right, then left; 
Left only – draw spectrum graph of left channel only; 
Right only – draw spectrum graph of right channel only; 
Mono mix – mix left and right channels (calculate average between them) and then 
draw spectrum of the result. 
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Overlap. Overlapping of data blocks being analyzed in percents (0% means no 
overlapping, it is used by default). Increase this value to get the diagram updated 
more frequently with greater FFT size values (and better frequency estimation). 
Note that is will require more CPU power (for example, 50% overlapping 
requires 2 times, and 99% overlapping about 100 times more CPU power for 
calculations than no overlapping!), so use it with care! 
Parameter Max dB defines top spectrum value shown on the diagram. For most 
cases spectrum values are less than maximal level (0 dB) by some dB, so there is 
no sense to see greater values. For example, set it to –12 dB if you do not want to 
see spectrum values greater than –12 dB. 
Set appropriate values of Max dB and Range to see desired spectrum value range 
more detailed. 
Parameter Range defines vertical range (in decibels) of the diagram. Set 
appropriate values of Max dB and Range to see desired spectrum value range more 
detailed. 
Use bypass function to turn off spectrum analysis. When dialog window of 
spectrum analyzer is closed, analysis is turned off too. 

10.10 Other effects 
10.10.1 Channel mixer 

 

Forward AV Studio   160 



10. Audio effects 

Channel mixer allows mixing and inverting stereo channels as well as 
redirecting the resulting sound to any channel (left, right or both). 
You can get a ‘pseudo stereo’ effect by just inverting the sound in one channel 
(for example, in the right channel only). 
Left Channel Mix group denotes the sources of the resulting sound in the left 
channel. 
Right Channel Mix group denotes the sources of the resulting sound in the right 
channel. 
The setting described below refer to both groups: 
Left Source – amplification (from 0% to 100%) of the left channel. If you set it to 
0%, the channel will not be mixed to the resulting channel. 
Right Source - amplification (from 0% to 100%) of the right channel. If you set it 
to 0%, the channel will not be mixed to the resulting channel. 
Invert – invert the sound in the channel. In the resulting channel, you can get the 
difference between the channels (for example, if in the left channel the Left source 
is set to 100% and the Right source to 100%, after inverting the left channel, in the 
resulting left channel you get the difference between the right and the left 
channels). 
Channel mixer supports bypass function and presets (see also the note about 
presets storing). 

10.10.2 DirectX Plug-in Chainer 
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Important! Read section about supported plug-ins before working! 
DirectX plug-in chainer allows inserting chain of DirectX audio plug-ins 
(DirectShow audio filters) to audio effect list. Please note that only plug-ins that 
get and process audio data in 32-bit float format are allowed to use (plug-ins that 
get audio data in 16-bit integer format are not supported). 
Use buttons at the top of the dialog box to manipulate plug-ins chain. You can 
add/remove plug-ins, edit its parameters, change order of plug-ins in chain, turn 
on/off any audio plug-in using checkboxes at the left of its names in a list (when 
checkbox is checked plug-in is on). 

 Add Above – select audio plug-in from a list of available plug-ins and add it 
above current selected plug-in in list. 

 Add Below – select audio plug-in from a list of available plug-ins and add it 
below current selected plug-in in list. 
Note: you can get message ‘Can not use plug-in’. Possible reason is that plug-in 
does not support current audio format (some plug-ins process only mono or only 
stereo audio data). Plug-ins that does not work with 32-bit float format are not 
supported and cannot be inserted to chain (some plug-ins work with 16-bit data). 
Plug-ins that work with mono data only can be used on mono audio clips or in 
mono projects only. 

 Remove – remove selected plug-in from a list. 

 Edit – run property the dialog box of current plug-in to change its 
parameters. You can also double-click at a name of plug-in to run its setup dialog 
box. 

 Move Up – move current selected plug-in up to one step in list. 

 Move Down button – move current selected plug-in down to one step in a 
list. 
Use Skip All checkbox to turn on/off entire chain of plug-ins (when it is checked 
plug-ins don’t process sound). Please note that only entire a list can be turned 
on/off during real time preview/playback, one plug-in can be turned on/off 
(bypassed) only when playback is stopped. 
When you insert any plug-in in a chain, dialog box with plug-in’s property 

page(s) is shown (you can recall it any time later using  button to edit/change 
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plug-in’s parameters). List named Presets at the top of the dialog box allows to 
select any preset with plug-in’s saved states. 
Use the Save As button to save current state of plug-in to your own preset. You 
will be asked a name of preset, type it and press OK to save preset. When you 
selected any preset from a list and want to change any parameters in it, use the 
Save button to save current state to preset with the same name. Please note that 
typically plug-ins have some factory presets (built-in with plug-in), you can not 
overwrite (change) nor delete them from a list of presets. 
Note: presets are saved to the directory on hard disk where you installed 
Forward AV Studio (for example, C:\Program Files\Forward AV Studio). You 
must have write access to this directory if you want to save your own presets 
(such rights may be restricted under Windows NT/2000). 
Press the OK button to keep current state of plug-in and close its dialog box, or 
Cancel if you want to cancel changes that you made. The Apply button is the same 
as OK, but it doesn’t close plug-in’s dialog box and keeps current state. It means 
that this state will be restored if you change any plug-in’s parameters and press 
Cancel after it. 
Use the Help button to read help information about current plug-in provided by 
plug-in’s manufacturer. Help file must be included and properly installed with 
plug-in. 
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10.10.3 DirectX Plug-ins List dialog box 

 

This dialog box shows a list of available DirectX audio plug-ins installed on your 
system and not included in the list of removed plug-ins (see below). Select title 
of desired plug-in and press OK to insert it to current plug-ins chain (note that 
you can’t insert plug-in during playback). 
Please note that some plug-ins shown in the list may not be allowed to be used. 
Only plug-ins that get and process audio data in 32-bit float audio format are 
supported (plug-ins that get data in 16-bit integer audio format are not allowed to 
use). Some plug-ins can not be inserted because process only mono or only 
stereo audio data, such plug-ins can be used on audio clips and in the projects 
with corresponding number of channels only (mono or stereo). You can remove 
plug-in from a list answering ‘Yes’ if you get message box ‘Can not use plug-in’. 
When you run this dialog box first time, DirectX plug-in Chainer searches for 
installed plug-ins, it can take some time. Next time searching is no longer 
needed. If you installed new plug-ins, you will need to press the Refresh List 
button to refresh a list of installed plug-ins. If you do not want to see some plug-
ins in the list, select one of them and press the Remove button. It does not mean 
that plug-in is physically removed (uninstalled) from your system; it will be only 
excluded from a list of available plug-ins. 
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Removed plug-ins can be shown again if you restore them with the Restore 
button. It calls plug-ins restoring dialog box where you can restore desired plug-
ins to be shown them in the list and allowed to be used. 

10.10.4 Supported/unsupported DirectX Plug-ins 
Important: you must have Microsoft DirectShow Media runtime installed on your 
system to work with DirectX plug-ins (DirectShow filters). 
Forward AV Studio allows you to use any DirectX plug-ins, except ones that get 
and process audio data in 16-bit format (only 32-bit plug-ins are supported). 
Most modern plug-ins are 32-bit compatible and are fully compatible with 
Forward AV Studio. 
Some plug-ins can work with only mono or only stereo audio. Such plug-ins can 
be used only on audio clips and in projects with appropriate number of audio 
channels (mono/stereo). For example, some Cakewalk plug-ins without Stereo in 
their name works with mono audio only, and some Waves plug-ins work only 
with stereo audio. 
Most plug-ins work well with Forward AV Studio, but there is a possibility that 
some of them can cause program crash and loss of unsaved data in some rare 
situations. Please check all plug-ins before using them in serious work (try to 
insert them to simple test project and playback it with use of plug-in, check also 
that project can be saved and opened again). If you encounter crash during 
opening of a project, you can disable loading of DirectX plug-ins to restore your 
work – see Troubleshooting Settings for details. If you encounter that some plug-
ins cause problems and you do not want to use them, you can remove such plug-
ins from list of available plug-ins with Remove button (see description of plug-in 
selection dialog for more details). 
We have tested many plug-ins for compatibility with Forward AV Studio, here is 
a list of some most popular supported plug-in packages: 

SonicFoundry plug-ins 
Cakewalk plug-ins (some work with mono audio only) 
DSP/FX plug-ins 
Hyperprism-DX plug-ins 
Waves plug-ins (some work with stereo audio only) 
TC Native plug-ins 
Timeworks plug-ins 
Steinberg plug-ins 
and others. 

Plug-ins that can not be used because they support only 16-bit audio data: 
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CANAM (QUARTZ) plug-ins 
There may be other plug-ins that are supported or not supported by 
Forward AV Studio. If you have problems with some plug-ins, contact us and 
write what plug-ins you are trying to use (please include WEB-address of plug-
ins’ manufacturer’s Internet site if possible) and what is the problem. 

10.10.5 Installing DirectShow runtime 
In order to use DirectX plug-ins, you must have Microsoft DirectShow runtime 
(formerly called ActiveMovie) installed in your system. Latest versions of 
Windows (Windows 98 and Windows 2000) already have it installed, but it may 
be absent in the old versions of Windows 95 and Windows NT (however, 
DirectShow may be installed with latest version of Microsoft Internet Explorer 
or Windows Mediaplayer). 
If you have problems and are not sure that have DirectShow in your system, 
download and install latest version of Microsoft DirectShow runtime via 
Microsoft DirectX page: 
http://www.microsoft.com/DirectX 
Follow to ‘DirectX downloads’ section and find ‘DirectX Media’. Read 
instructions on the page about how to download and install it to your computer. 

10.10.6 Restoring removed plug-ins 
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This dialog box shows titles of removed DirectX plug-ins that are not shown in 
the plug-ins list. Some of them may be marked as ‘dangerous’ to avoid them 
from being shown in the list even after installing other plug-ins and refreshing 
list of them. Some plug-ins are currently not supported by plug-ins chainer for 
some technical reasons and may cause program crash or hang-up. It is highly 
recommended to mark them as ‘dangerous’ and don’t try to use them. Note that 
there are many plug-in packages in the market that may satisfy most of audio 
processing needs, and most of them are supported by Forward AV Studio’s plug-
in chainer. 
All removed plug-ins (note that they are not really uninstalled from system, they 
are only excluded from list) can be restored back to be shown in the list (for 
example if some plug-ins were removed by mistake). Select plug-ins that you 
want to restore (click checkbox at left of desired plug-in’s title in the list) and 
press the OK button. List of plug-ins will be rescanned, and all plug-ins that you 
have selected will be shown in the list again. 
Use the Set as dangerous button to mark any removed plug-in as ‘dangerous’ (that 
can cause program crash, hang-up etc.). Titles of plug-ins that are marked as 
‘dangerous’ are shown in red color. When you try to select them for restoring by 
clicking checkboxes at the left of its titles, warning message is shown. 
The Restore all button allows to select (turn on checkboxes) all removed plug-ins 
to restore them with the OK button. Note that plug-ins that are marked as 
‘dangerous’ are not selected with this button; if you want to restore them for 
some reasons, you must select them manually. 
The OK button closes this dialog box and starts rescanning of the plug-ins list. All 
restored plug-ins will be shown in the list. 
The Cancel button closes this dialog box and doesn’t restore any plug-ins. 
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10.10.7 Advanced Pan 

 

This effect allows you to change stereo balance (panorama) of a clip, track or 
entire project. It can perform panning not only by just changing volume of sound 
in left/right channels. You can also use delay and low filter (with slow or fast 
decay of its frequency response for panning. 
Use this effect to get more natural and audible panning effects. 
First feature of advanced pan is keeping of perceived volume of sound, so when 
you change panorama value, sum power of sound in both channels is kept 
constant. But its more important feature is possibility of use of delay and 
lowpass filter for panning. 
As known from psychoacoustics, human’s brain perceives direction of sound 
source not only by perceived volume in left and right ears, but also by delay and 
difference of frequency components between ears. Advanced pan allows using 
this knowledge to get more natural, deep and audible panning. 
So, when you change panning value (that is you “move” perceived source of 
sound to the left or right), one channel can be delayed and/or filtered with 
lowpass filter (for example, if you move panorama to the left, right channel can 
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be delayed and/or filtered; the more panorama is moved, the more delayed and 
filtered right channel is). 
You can turn off use of amplification in one or both channels if you want 
panning to be performed with use of delaying and/or filtering only. Filtering can 
be performed with use of soft or hard filter (with slow or fast decay of filters’ 
frequency response). 
Click at name of control to get its description: 
Panorama. Panning value in percents: –100% moves balance to the left, 100% 
moves balance to the right, 0% keeps it without change. 
Amplified pan group defines amplification parameters used for panning: 
Panning depth parameter defines how deeply amplification is used to perform 
panning. 100% gives full depth, so when you set panorama to –100% for 
example, volume of left channel will be maximal, and zero in right channel (if 
Use amplify is on). If you set it to 0%, it will turn off amplification at all. Setting it 
to values less than 100% will give slight panning, so volume in channels will be 
changed less significantly that if you set full depth. 
Use amplify mode turns on usage of amplification in both channels, so when you 
change panning value, volume of both channels will be affected. For example, 
when you set panorama to –100%, volume of left channel will be maximal, and 
zero in right channel in this mode. 
Use in one channel only mode turns on usage of amplification in one channel only. 
For example, when you set panorama to –100%, volume of left channel will be 
maximal, and volume in right channel won’t be changed. 
This mode is useful when using delay and/or filter for panning. When you use 
filter, it suppresses high-frequency components of sound, and it may be enough 
to decrease power of sound with filter only. 
Don’t use amplify at all mode turns off usage of amplification for panning. Use this 
more if you want to perform panning using delay and/or filter only. 
Delayed pan group defines delay parameters used for panning: 
Maximal delay parameter defines maximal panning delay. If Use delay is on, and 
you set panorama value to –100% for example, right channel will be delayed to 
time amount equal to Maximal delay value. The greater is panorama value (the 
farther it is from center), the more delayed one of channels is. 
Note: it is not recommended to set this value too high (more than 1-2 ms), but 
setting greater values can give interesting and deep stereo effects. 
Turn on Use delay mode to use delay for panning. It gives more deep and natural 
panning effects. 
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The greater is panorama value (the farther from center), the more delayed one of 
channels is. 
Lowpass filter group defines filtering parameters used for panning: 
Minimal freq parameter defines minimal cut-off frequency of lowpass filter used 
for panning. If Use filter is on, and you set panorama value to – 100% for 
example, right channel will be filtered by lowpass filter with cut-off frequency 
equal to Minimal freq value. The greater is panorama value (the farther it is from 
center), the more filtered one of channels is (the less is filter’s cut-off frequency). 
Turn on Use filter mode to use lowpass filter for panning. The greater is panorama 
value (the farther it is from center), the more filtered one of channels is (the less 
is filter’s cut-off frequency). 
You can select kind of filter using Soft filter and Hard filter modes. 
In Soft filter mode soft 1st-order lowpass filter is used for panning if Use filter is on. 
Frequency response decay of such filter is slow, so high frequencies are 
suppressed less than when using Hard filter. 
In Hard filter mode soft 2nd-order lowpass filter is used for panning if Use filter is 
on. Frequency response decay of such filter is rather fast, so high frequencies are 
suppressed greater than when using Soft filter. 

Note: if you want to use panorama profile with advanced delayed/filtered 
panning on audio clips, use Profile Advanced Pan effect instead of this one. 
Advanced pan supports bypass function and presets. 
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10.11 Effects with profiles 
10.11.1 Profile Advanced Pan 

 

This audio effect allows you to change stereo balance (panorama) of a clip. It can 
perform panning not only by just changing volume of sound in left/right 
channels. You can also use delay and lowpass filter (with slow or fast decay of 
its frequency response for panning. 
Use this effect to get more natural and audible panning effects.  
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
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If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Click at name of control to get its description: 
Panorama. Panning value in percents: –100% moves balance to the left, 100% 
moves balance to the right, 0% keeps it without change. 
Amplified pan group defines amplification parameters used for panning: 
Panning depth parameter defines how deeply amplification is used to perform 
panning. 100% gives full depth, so when you set panorama to –100% for 
example, volume of left channel will be maximal, and zero in right channel (if 
Use amplify is on). If you set it to 0%, it will turn off amplification at all. Setting it 
to values less than 100% will give slight panning, so volume in channels will be 
changed less significantly that if you set full depth. 
Use amplify mode turns on usage of amplification in both channels, so when you 
change panning value, volume of both channels will be affected. For example, 
when you set panorama to –100%, volume of left channel will be maximal, and 
zero in right channel in this mode.  
Use in one channel only mode turns on usage of amplification in one channel only. 
For example, when you set panorama to – 100%, volume of left channel will be 
maximal, and volume in right channel won’t be changed. 
This mode is useful when using delay and/or filter for panning. When you use 
filter, it suppresses high-frequency components of sound, and it may be enough 
to decrease power of sound with filter only. 
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Don’t use amplify at all mode turns off usage of amplification for panning. Use this 
more if you want to perform panning using delay and/or filter only. 
Delayed pan group defines delay parameters used for panning: 
Maximal delay parameter defines maximal panning delay. If Use delay is on, and 
you set panorama value to –100% for example, right channel will be delayed to 
time amount equal to Maximal delay value. The greater is panorama value (the 
farther it is from center), the more delayed one of channels is. 
Note: it is not recommended to set this value too high (more than 1-2 ms), but 
setting greater values can give interesting and deep stereo effects. 
Turn on Use delay mode to use delay for panning. It gives more deep and natural 
panning effects. 
The greater is panorama value (the farther from center), the more delayed one of 
channels is. 
Lowpass filter group defines filtering parameters used for panning: 
Minimal freq parameter defines minimal cut-off frequency of lowpass filter used 
for panning. If Use filter is on, and you set panorama value to –100% for example, 
right channel will be filtered by lowpass filter with cut-off frequency equal to 
Minimal freq value. The greater is panorama value (the farther it is from center), 
the more filtered one of channels is (the less is filter’s cut-off frequency). 
Turn on Use filter mode to use lowpass filter for panning. The greater is panorama 
value (the farther it is from center), the more filtered one of channels is (the less 
is filter’s cut-off frequency). 
You can select kind of filter using Soft filter and Hard filter modes. 
In Soft filter mode soft 1st-order lowpass filter is used for panning if Use filter is on. 
Frequency response decay of such filter is slow, so high frequencies are 
suppressed less than when using Hard filter. 
In Hard filter mode soft 2nd-order lowpass filter is used for panning if Use filter is 
on. Frequency response decay of such filter is rather fast, so high frequencies are 
suppressed greater than when using Soft filter. 
Note: if you want to use panorama profile with advanced delayed/filtered 
panning on audio tracks or entire project, use Advanced Pan effect instead of this 
one. 
Profile advanced pan supports bypass function and presets. You can also set 
quality of processing for this effect. 
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10.11.2 Profile Allpass Filter 

 

Allpass filter affects only phase of sound being processed. If you mix it with 
original sound, you will get weakening of volume at some frequencies. It gives 
sound like phaser but with slightly other timbre. This modification of effect 
allows you to define and edit change of filter’s parameters with profiles on audio 
clip. 
Allpass filter can be used for processing guitar or sound effects like noise (or 
any other). 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
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the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Central frequency of the filter is being changed with profile 
in logarithmical scale in correspondence with features of human’s perceptions of 
sound (frequency change is linear in octaves). 
Click at the name of control to get its description: 
Central frequency of allpass filter. This frequency must be greater than zero and 
less than a half of sampling frequency of sound being processed. 
Q-factor (resonance) parameter defines bandwidth of filter’s band. 
Original signal mix. Amplification of original (not processed) signal in the output of 
filter (in dB). 
Filtered signal mix. Amplification of filtered (processed) signal in the output of 
filter (in dB). 
Note: current frequency response of the filter is shown on the diagram. It is 
being updated when you change values of parameters manually or during real-
time playback when you press Play button in effects list dialog. You can also use 
frequency and phase response dialog to analyze effects more deeply. 
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10.11.3 Profile Bandpass Filter 

 

This audio effect allows you to filter sound with bandpass or bandreject filter. 
Bandpass filter suppresses sound volume of frequency components outside 
passband, bandreject filter suppresses components inside reject band. 
Bandpass filter can be used for processing voice to get ‘telephone’ sound. 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
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the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Central frequency of the filter is being changed with profile 
in logarithmical scale in correspondence with features of human’s perceptions of 
sound (frequency change is linear in octaves). 
Click at the name of control to get its description: 
Central frequency of filter’s band. This frequency must be greater than zero and 
less than a half of sampling frequency of sound being processed. 
Bandwidth – relative width of filter’s band (in octaves).Original signal mix. 
Amplification of original (not processed) signal in the output of filter (in dB). 
Filtered signal mix. Amplification of filtered (processed) signal in the output of 
filter (in dB). 
Bandpass filter. Selects bandpass type of filter: frequency components of sound 
outside passband are suppressed.Bandreject filter. Selects bandreject type of filter: 
frequency components of sound inside stopband are suppressed. 

Note: current frequency response of the filter is shown on the diagram. It is 
being updated when you change values of parameters manually or during real-
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time playback when you press Play button in effects list dialog. You can also use 
frequency and phase response dialog to analyze effects more deeply. 

10.11.4 Profile Delay 

 

This effect allows you to delay sound for some amount of time to obtain sound 
effects like simple echo. When delay amount is about 100 ms or more, it gives 
effect of reflections of sound (like echo), and when delay is some milliseconds, it 
gives effect of phase-shift (you can get pseudo-stereo effect – just delay sound in 
one channel by some milliseconds). This modification of delay allows you to 
define and edit change of filter’s parameters with profiles. 
Delay is widely used for processing recorded voice or to get pseudo stereo 
effects (for the rhythm-guitar for example). 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
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the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Click at the name of control to get its description: 
Delay – the value delay in milliseconds. 
Input signal mix – amplification of input (not delayed) sound in percent (from 0% 
to 100%). You can set it to 0% to obtain only the delayed sound at output. 
Delayed signal mix – amplification of the delayed sound in percent (from 0% to 
100%). Use this setting to control the volume of the delayed sound (echo). 
Feedback is the volume of the resulting sound (mixed from the input and delayed 
sounds) in percent (from 0% to 100%) that is returned to the input of the delay 
channel to get sound repeated reflections effects. 
Delayed signal panorama – panorama of delayed signal (in percents). You can move 
delayed signal to left/right in stereo image using this parameter. – 100% moves 
signal to the left, 100% – to the right. 
This parameter is active only in a stereo project. 
Lowpass cut-off frequency. Cut-off frequency of lowpass filter on delayed signal (in 
Hz). This parameter allows you to filter delayed signal with lowpass filter and 
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remove high-frequency components. Dynamic change of these parameters gives 
interesting effects. This frequency must be greater than zero and less than a half 
of sampling frequency of sound being processed. 
Highpass cut-off frequency. Cut-off frequency of highpass filter on delayed signal 
(in Hz). This parameter allows you to filter delayed signal with highpass filter 
and remove low-frequency components. Dynamic change of these parameters 
gives interesting effects. This frequency must be greater than zero and less than a 
half of sampling frequency of sound being processed. 
Cut-off frequency of filters is being changed with profile in logarithmical scale 
in correspondence with features of human’s perceptions of sound (frequency 
change is linear in octaves). 

10.11.5 Profile Parametric Filter 

 

This audio effect uses the same filter as middle filters of Parametric Equalizer: you 
can peak or notch volume in some frequency band with it. This modification of 
parametric filter allows you to define and edit change of filter’s parameters with 
profiles. 
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Parametric filter can be used for processing guitar solo for example to get some 
kind of ‘wah-wah’ pedal effects. You can also use Profile Resonant Filter for the 
same kind of effects. 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Central frequency of the filter is being changed with profile 
in logarithmical scale in correspondence with features of human’s perceptions of 
sound (frequency change is linear in octaves). 
Click at the name of control to get its description: 
Central frequency of filter’s band (in Hz). Dynamic change of this parameter with 
profile gives interesting effects like ‘wah-wah’ pedal. This frequency must be 
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greater than zero and less than a half of sampling frequency of sound being 
processed. 
Bandwidth – relative width of filter’s band (in octaves).Gain at central frequency 
(in dB). You can both peak (gain > 0 dB) and notch (gain < 0 dB) sound at 
central frequency of filter’s band. 
Note: current frequency response of the filter is shown on the diagram. It is 
being updated when you change values of parameters manually or during real-
time playback when you press Play button in effects list dialog. You can also use 
frequency and phase response dialog to analyze effects more deeply. 

10.11.6 Profile Resonant Filter 

 

This audio effect allows you to filter sound with lowpass or highpass filter. You 
can also use resonance to peak gain at filter’s cut-off frequency. 

Forward AV Studio   182 



10. Audio effects 

Resonant filter is widely used for processing guitar solo to get ‘wah-wah’ pedal 
effects. You can also use Profile Parametric Filter for the same kind of effects. 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. Cut-off frequency of the filter is being changed with profile in 
logarithmical scale in correspondence with features of human’s perceptions of 
sound (frequency change is linear in octaves). 
Click at the name of control to get its description: 
Cut-off frequency of filter’s low or high-frequency band (in Hz). Filter suppresses 
volume of sound outside its passband, and resonance defines peak at this 
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frequency. This frequency must be greater than zero and less than a half of 
sampling frequency of sound being processed. 
Q-factor (resonance) parameter defines peak in filter’s frequency response at cut-
off frequency.Original signal mix – amplification of original (not processed) signal 
in the output of filter (in dB). 

Filtered signal mix – amplification of filtered (processed) signal in the output of 
filter (in dB). 
Lowpass resonant filter. Selects lowpass type of filter: high-frequency components 
of sound are suppressed. 
Highpass resonant filter. Selects highpass type of filter: low-frequency components 
of sound are suppressed. 
Note: current frequency response of the filter is shown on the diagram. It is 
being updated when you change values of parameters manually or during real-
time playback when you press Play button in effects list dialog. You can also use 
frequency and phase response dialog to analyze effects more deeply. 
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10.11.7 Profile Shelf Filter 

 

This audio effect uses the same filter as first and last filters of Parametric 
Equalizer: you can lift or notch volume in low-frequency or high-frequency 
band with it. This modification of shelf filter allows you to define and edit 
change of filter’s parameters with profiles. 
Shelf filter can be used for boosting or suppressing low or high frequencies of 
sound. 
This audio effect supports profiles for its parameters: Cut-off Frequency, Steepness 
and Gain at cut-off frequency. Edit buttons and Use switches. Some audio effects 
that are included with Forward AV Studio allow you to define ‘scenario’ 
(profile) of change of their parameters in time (name of such effects always start 
with Profile). It means that you can not only set static values of effect’s 
parameters, but you can also draw profiles on audio clips that denote how 
parameters should be changed in time. Profiles of audio effects are edited with 
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the same manner as when editing volume/panorama profiles, with mouse and 
keyboard shortcuts. 
Note: effects with profiles can be applied on audio clips only. 
Use Edit button at the left of parameter’s controls (scrollbar and edit box) to 
make its profile active and edit it on audio clip where this audio effect is placed. 
If you turn off Use switch, profile will be turned off, and you will be able to set 
constant value of parameter manually with scrollbar or edit box: 

 

Profile of effect’s parameter is turned on; manual setting of value of parameter with 
scrollbar and edit box is disabled. 

 

Profile of effect’s parameter is turned off; manual setting of value of parameter with 
scrollbar and edit box is enabled. 

Tip: profiles of audio effects can be turned on/off and selected for editing from 
audio effects list dialog. See also section about working with audio effects in 
Forward AV Studio. 
Cut-off frequency of the filter is being changed with profile in logarithmical scale 
in correspondence with features of human’s perceptions of sound (frequency 
change is linear in octaves). 
Click at the name of control to get its description: 
Cut-off frequency. Cut-off edge frequency of filter’s low or high frequency band 
(in Hz). This frequency must be greater than zero and less than a half of 
sampling frequency of sound being processed. 
Steepness parameter defines steepness (slope) of filter’s frequency response. 
Gain at zero frequency for lowpass filter or at a half of sample rate for highpass 
filter (in dB). You can both peak (gain > 0 dB) and notch (gain < 0 dB) sound in 
filter’s band. 
Lowpass shelf filter selects lowpass shelf type of filter: gain is set for 0 Hz. 
Highpass shelf filter selects highpass shelf type of filter: gain is set for a half of 
sample rate frequency. 
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Note: current frequency response of the filter is shown on the diagram. It is 
being updated when you change values of parameters manually or during real-
time playback when you press Play button in effects list dialog. You can also use 
frequency and phase response dialog to analyze effects more deeply. 
Profile shelf filter supports bypass function and presets. You can also set quality 
of processing for this effect. 
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11 DDSound Volume Control 
DDSound Volume Control is an application included with Forward AV Studio. It 
allows adjusting the settings of audio devices: changing the volume, turning 
on/off audio outputs for playback, selecting source inputs for recording, saving 
and restoring the states of audio devices. 
For more detail, please, select one of the following sections: 
DDSound Volume Control overview 
Main window overview 
Toolbar 
Device selection 
Saving and Restoring states 
Using with Forward AV Studio 
Local Menu 
Settings 
Some tips 

11.1 DDSound Volume Control overview 
DDSound Volume Control is an additional application included with 
Forward AV Studio. It allows adjusting the settings of audio devices: changing 
the volume, turning on/off audio outputs for playback and selecting source inputs 
for recording. The application window can be activated from 
Forward AV Studio: press F8 when the main Project window is active or use the 
DDSound Volume Control command from the Window menu. 
DDSound Volume Control is user-friendlier than the standard volume control 
system (however, you can run it using the Volume Control command on the Tools 
menu). In DDSound Volume Control you can adjust the volume in decibels (dB) 
and percent save the state of any audio device and restore any state with a mouse 
click. You may also define two different states for playback and recording that is 
set automatically when playback/recording actually start in Forward AV Studio. 
It may be used, for example, to mute some audio input channels during playback 
and turn them on automatically when the playback is stopped.  
DDSound Volume Control can run independently of Forward AV Studio: you 
may launch it by its item on Forward AV Studio folder in the system Start menu 
(for example, Start –> Programs –> Forward AV Studio–> 
DDSound Volume Control). 
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11.2 Main window overview 

 

The main window of DDSound Volume Control consists of two parts: a toolbar 
at the left and audio devices controls with faders and selection buttons at the 
right. 
The window title contains the name of the currently selected audio mixer device 
(soundcard), for example, Yamaha PCI Audio or FD300 Wave 1B0 (see figure 
below). 

 
Each fader corresponds to one audio input/output (control), such as the main 
volume control, audio CD, microphone, line input, MIDI synthesizer etc. The 
name of an audio control is shown at the fader top (for example, ‘Audio CD’). A 
long name can be truncated, but if you move the mouse cursor over the fader and 
hold the cursor for about one second, a tooltip with the full name will pop up. 
The first numeric field below the name allows the adjustment of the audio 
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balance (to the left/right). The slider can also be used for this purpose (move it to 
the left/right). The second numeric field and vertical fader allow changing the 
volume of sound. The volume can be represented in percent or decibels (100% 
and 0 dB correspond to the maximum volume). Press  icon on the toolbar to 
switch between % and dB. Button  below the fader allows selecting (including 
in playback/recording) or muting (disabling) the audio control. When selected, 
playback controls are shown with green and record controls with red buttons. 
You can see if a control is selected or not by putting the mouse cursor over the 
button and holding it they’re for about a second. Press  icon on the toolbar to 
switch between playback/recording controls for the current audio device 
(soundcard). Typically ‘Volume Control’ or ‘Recording control’ is shown at the 
bottom of the main window to indicate which control is currently displayed (the 
displayed text may differ depending on the soundcard).  
The number of faders may also vary depending on the soundcard used, and some 
controls may be disabled and not shown. Press  icon on the toolbar to select 
the current audio device (soundcard) and choose the controls to be shown as 
faders. 
Note that some professional soundcards (for example ‘Card Deluxe’ by Digital 
Audio Labs) do not have an audio mixer device. You cannot adjust the 
input/output volume level without a mixer device, and for such soundcards 
DDSound Volume Control does not show controls at all. 
Most commands are accessible via the toolbar and local menu. 

Forward AV Studio   190 



11. DDSound Volume Control 

11.3 Toolbar 

 

Toolbar is located at the left of the DDSound Volume Control main window. It 
consists of two vertical lines with the following icons. 

 select audio mixer device (soundcard) and audio 
controls to be shown in the main window. Calls the 
device selection dialog box. 

 change the program settings. 

 switch between playback/recording controls for the 
current audio device (typically ‘Volume Control’ or 
‘Recording control’ are shown at the bottom of the main 
window to indicate which controls are currently 
displayed). 

 show the volume in decibels (dB) or percent (%). 

 save the current state of devices. Calls the Save state 
dialog box. 

 close DDSound Volume Control main window. 

 show About dialog box. 
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Icons in the second line allow restoring (recalling) any state of a previously 
saved device. 

 a state saved for recording. 

 a state saved for playback. 
These two states can be restored automatically when the recording/playback 
actually starts in Forward AV Studio. See the section about using with 
Forward AV Studio for details. You may recall recording/playback states 
manually by pressing these two icons (see also Saving and restoring states). 
The last icons with numbers restore user-defined states of devices 
(Forward AV Studio will never automatically restore such states). For example, 
you may save some of the preferred states with different volumes and audio 
controls selected (or muted) for listening CD, playing multimedia files, recording 
something etc. and recall any state with a mouse click. 
When you move the mouse cursor over any icon on the toolbar and hold the 
cursor there for about a second, there pops up a tooltip with the icon's text 
description. For the first line of icons, the tooltips contain short descriptions of 
actions that can be performed by pressing on these icons. For the second line of 
icons, there appears the name of the saved state. If ‘No saved state’ is shown, 
indicating that no state has been saved for this icon, pressing the icon would give 
no result (the current state of audio devices cannot be changed in any way). 
Note that most commands are also accessible via the local menu! 
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11.4 Device selection dialog box 

 

Device selection dialog box can be called by  icon on the toolbar or via the 
local menu. This dialog box allows selecting the current audio mixer device 
(soundcard) and choosing audio controls to be shown in the main window with 
faders and selection buttons. 
Mixer device contains the list of audio mixer devices installed on your system. 
Note that some professional soundcards have no mixer device. You cannot 
control playback volume and recording level on such soundcards. 
DDSound Volume Control does not include them in the list of available mixer 
devices. 
Adjust volume for group allows selecting the current group of audio controls for a 
selected audio mixer device. The list of audio controls of a selected group is 
displayed at the bottom of the dialog box. If the checkbox at the left of audio 
control title is on, this control is displayed in the main window. 
On the sample image, you can see that ‘MIDI’ control is not selected. Thus, the 
faders for this control are not shown in the main window. 
Typical names of playback controls are as follows: 
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Volume Control – master volume of audio output, 
Line – line input volume of audio output, 
Mic – microphone volume of audio output, 
Audio CD – volume of audio CD, 
MIDI – volume of internal MIDI synthesizer. 
Modern soundcards may have many other controls. To know the capabilities of a 
soundcard, are referred to its documentation or the manufacturer. 

11.5 Saving and restoring states 

 

DDSound Volume Control allows saving any state of all mixer audio devices 
(soundcards) installed on your system and restoring any saved state with a mouse 
click on the toolbar. Up to 8 different states (with different volume and recording 
levels of audio controls) can be saved. Two special states saved for recording and 
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playback can be restored automatically when playback/recording start in 
Forward AV Studio (see section about using with Forward AV Studio). 
To define a state of audio device, select or mute desired audio controls and set 
appropriate levels in the main window of DDSound Volume Control. You may 
need to switch between playback and recording controls of the current audio 
device with  icon on the toolbar. Press  icon to select a current audio device 
(if you have more than one soundcard installed) and choose the audio controls to 
be shown in the main window of DDSound Volume Control. Use the selection 
buttons to mute/select audio controls and vertical faders to set their volume. 
If Save mute / select only option is on, only the state of mute/select buttons is saved 
(volume levels are not saved and remain unchanged when the state is restored). It 
may be useful if you want to mute or enable some audio controls when the state 
is restored without changing the current volume levels. Turn Save mute / select only 
off if you want the volume levels to be saved into state. If you want to change 
this option globally set it in the program settings. When you open the dialog box 
to save state next time, this option will be automatically set in accordance with 
program settings. 

To save the current state press  icon on the toolbar to call the Save state dialog 
box. Select the type of the state you want to save: Recording, Playback or any of 
user-defined states. Any name can be set for the latter. For example, you may 
save state number 1 with Audio CD control enabled (selected) and name it 
Listen to audio CD. State number 2 with ‘Audio CD’ control disabled (muted) can 
be named Work with audio and used while working in Forward AV Studio to mix 
audio without CDROM-inherent noise (especially when you work in 
headphones). Any of these states can be restored with a click on appropriate 
icons on the toolbar. 

11.6 Using with Forward AV Studio 
DDSound Volume Control can be used with Forward AV Studio to automatically 
restore two special states of audio devices saved for recording and playback. 
When you have saved state of audio controls for playback and press Play in 
Forward AV Studio, DDSound Volume Control saves the current state (that was 
before the start of playback), and restores the state saved for playback. When 
playback is stopped, the previous state is restored. 
For example, you may need to mute line input of soundcard during playback, and 
automatically turn it on when playback is stopped. To do this, follow the 
following instructions. 
First, check that Automatically change mixer state is on in Devices tab of the Settings 
dialog box (press F5 and select Devices). 
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Save the state for playback with line input muted: 
1. Check that Volume Control (not Recording control) is shown at the bottom of the 
main window of DDSound Volume Control. If recording controls are currently 
shown, switch to playback controls with  icon on the toolbar. 
2. Check that line input is enabled (selected) or muted (unselected). If line input 
is enabled, the selection button under fader with title ‘Line’ is green:  and cyan 

 if line input is muted. You may also check it by moving the mouse cursor 
over the selection button and holding the cursor there for about a second. The 
tooltip with the name of the control will be shown. Read the text in braces 
(Now selected or Now unselected). 
3. If line input is enabled, mute it by pressing the selection button under the fader 
of line input control. The selection button must become cyan: . If you cannot 
see the fader for line input, check that it is selected in the device selection dialog 
box. Note that the actual title of the fader depends on the soundcard you use. 
4. Save the current state for playback: press  icon on the toolbar, select 
Playback in the Save state dialog box and press OK. 
Now enable line input again using the selection button. When you press Play 
button in the main Project window of Forward AV Studio, 
DDSound Volume Control will restore the state saved for playback and mute line 
input. When playback is finished (or Stop button is pressed), Forward AV Studio 
will restore the previous state with line input enabled. 
The same way is used to automatically restore the state saved for recording 
during recording audio. Switch to recording controls with  icon on the toolbar 
(check that Recording control is shown at the bottom of the main window). Set a 
desired state or recording controls (select appropriate input for recording and set 
the desired recording level for it), press  icon, select Recording in the Save 
state dialog box and press OK. The saved state will be automatically restored 
when recording actually starts. 
You can automatically restore the selection of both audio controls during 
playback/recording and volume levels. For detail, see the section about program 
Settings. 
Note that DDSound Volume Control runs simultaneously with 
Forward AV Studio and works even if the main window is not displayed. You do 
not need to keep the main window of DDSound Volume Control visible if you 
want to use automatic restoring of playback/recording states. But if you do not 
want to use this feature, it is not enough to just close the 
DDSound Volume Control main window. Instead you must turn off the option 
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Automatically change mixer state in Devices tab of the Settings dialog box in 
Forward AV Studio. 
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11.7 Local menu 
Local menu is called by pressing the mouse right button when the mouse cursor 
is over the main window of DDSound Volume Control. Most commands of this 
menu are also accessible via icons on the toolbar. 
This menu contains the following commands: 

Device select current audio device (soundcard) from the list in 
submenu; 

Select Device… the same as  icon on the toolbar; allows not only 
selecting current audio device but also 
enabling/disabling audio controls to be shown as faders 
in the main window; calls the device selection dialog 
box; 

Settings… the same as  icon on the toolbar; allow adjusting 
program settings; 

Switch Playback / Record the same as  icon on the toolbar; allows switching 
between playback/recording controls for the current 
audio device (soundcard). 

Show Volume in dB the same as  icon on the toolbar; switches the 
representation of volume level on faders between 
percent (%) and decibels (dB). 

Save current state as… the same as  icon on the toolbar; allows saving the 
current state of audio devices (audio controls volume 
and selection depending on program settings) with 
restoring it later. Calls the Save state dialog box. 

Keep always on Top if on, it allows keeping the main window of 
DDSound Volume Control over the windows of other 
applications (including Forward AV Studio). 

About… show the About dialog box. 
Close close the DDSound Volume Control main window. Note 

that by doing so you do not exit the program if you use 
it with Forward AV Studio. 
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11.8 Settings 

 

The settings dialog box is called by  icon on the toolbar or via the local menu. 
It allows changing DDSound Volume Control global settings. 
Save Mute / Select controls only – if this option is on, DDSound Volume Control 
saves and restores the state of selection buttons and does not change volume 
levels of audio controls. 
Auto save state when restore – if this option is on, DDSound Volume Control saves 
the changes of volume levels during playback/recording to appropriate state (the 
previous option must be turned on). When you start playback in 
Forward AV Studio, DDSound Volume Control saves the current state of audio 
device (that was before the start of playback), then recalls the state saved for 
playback. You can change the volume during playback, but when you stop 
playback and restart it again all changes will be lost. If you want to adjust the 
volume during playback and to save it for the next time (when playback will be 
started again), turn Auto save state when restore option on. The same is for 
recording controls: when you record audio and adjust recording level during 
recording, all changes will be saved in the state saved for recording. 
See also sections about using with Forward AV Studio and save state dialog box. 
Always on top – if this option is on, the main window of 
DDSound Volume Control is kept over other windows. This option is also 
accessible via the local menu. 
Show Volume in dB – if this option is on, volume levels of all audio controls are 
shown in decibels (dB). You may also set the range of faders: maximum volume 
is always 0 dB (when ‘handle’ is at the top of fader), minimal volume is set here 
(when ‘handle’ is at the bottom of fader; by default this value is -55 dB). 
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This option is also accessible with  icon on the toolbar or via the local menu. 

11.9 Some tips 
Do not keep all audio controls always enabled (selected) if you do not need them. 
For example, if you work in Forward AV Studio and mix digital audio (without 
recording or when recording is done), mute all input controls (microphone and 
line input) in the audio output. That will protect you from hearing the noise and 
hum from the line, which is important if you use microphone input. Muting of 
audio CD is also recommended because even the most advanced CDROM 
models may produce annoying digital noise even when no audio CD is currently 
playing. 
Select appropriate input for recording audio. 
For example, if you want to record voice from a microphone, it is not enough to 
just connect the microphone cable to the soundcards’ microphone input. You 
must select (enable) the microphone input in recording controls of the soundcard. 
Unselect inputs that you don’t need to avoid additional noise! 
Some soundcards allow selecting many inputs for simultaneous recording. Select 
only one input that you want to use for recording and unselect all others that you 
don’t need. It is not enough to mute them in playback controls. You should 
unselect them in recording controls. Note that even if you don’t hear the input 
signal from the soundcards’ output (in headphones, external speakers etc.) it does 
not necessarily mean that this input is not included in the recording. Always 
check recording controls before recording audio! 

Use  icon on the toolbar to switch between playback/recording controls. See 
the description of the main window for how to select (enable)/mute (disable) 
audio controls. 
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12 Glossary 
Audio effect preset parameters for applying to audio clips, tracks and 

whole project 
Audio track track for audio clips (WAW-files) 
Bandpass filter induces no changes in the volume of frequency 

components of the processed sound within a specified 
band. Bandpass filter has two parameters: center 
frequency and bandwidth. Components of the sound 
with frequencies other than the frequency within the 
band are suppressed. 

Clip Collection list of source multimedia files with additional 
information 

Clip file with video, audio and midi data 
Clipboard exchange information buffer  
Current time time value in the current time format 
Declick short FadeIn/FadeOut applied to the edges of audio 

clips to eliminate clicks on the boundaries of clips. 
Declick may have linear or non-linear profile. 

DC-offset constant component of audio signal. It may be caused 
by a DC-offset of the soundcard used for recording 
audio (almost all soundcards, even professional, have 
non-zero DC-offset). So, if you record audio signal with 
constant volume (e.g. sinusoidal wave) you get a file 
with non-equal absolute values of negative and positive 
samples. Increasing the file volume may cause 
considerable distortions. DC-offset can be almost 
eliminated by subtracting the average sample value 
from all samples of audio file. 

Dithering conversion of high-resolution audio (24-bit) to a lower 
resolution (8/16 bit) with adding noise. Internal audio 
format of Forward AV Studio is 24-bit, so conversion is 
needed for playing or writing audio in 8/16 bit formats. 
If 24-bit audio is just truncated or rounded to 16 bits, 
you may get audible distortions in very quiet sounds. If 
very quiet noise is added to the last bit of the signal 
before truncating, distortions are almost eliminated 
(become non-audible). 

Effects List list of audio effects 
Fast Convolution algorithm is used to filter audio with FIR (finite impulse 

response) filters. Such filters are used to filter digital 
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signals without phase distortions. This is very important 
for audio processing. Linear convolution is a simple and 
very slow filtering algorithm, fast convolution is a 
modification of filtering algorithm based on the fast 
Fourier transform. It allows using highest-quality FIR 
filters for processing audio in real time. 

Fast Fourier Transform 
 (FFT) is a fast modification of Fourier Transform that 

maps the source signal from a time- to frequency-
domain. It is used to obtain and analyze the frequency 
and phase components of the signal. The main FFT 
requirement is that the number of points in the 
processed signal must be an integer power of 2. 

Frequency response of digital filter (or any processing algorithm/device) is a 
characteristic that describes how the filter affects the 
amplitude of various frequency components of the 
processed audio signal. Frequency response describes 
amplification/notch of a signal at all frequencies from 0 
Hz to one-half of the sampling frequency. 

Highpass filter induces no changes in the volume of high-frequency 
components of the processed sound. Highpass filter's 
most important parameter is the cut-off frequency or the 
boundary frequency. Components of the sound with 
frequencies lower than the cut-off frequency is 
suppressed. 

Lowpass filter induces no changes in the volume of low-frequency 
components of the processed sound. The lowpass filter's 
most important parameter is the cut-off frequency. 
Components of the sound with frequencies higher than 
the cut-off frequency are suppressed. 

Midi track track for midi sound (MID-files) 
Phase response of digital filter (or any processing algorithm/device) is a 

characteristic that describes how the filter distorts phase 
at all frequency components of the processed audio 
signal. Phase response describes a phase-shift of a 
signal at all frequencies from 0 Hz to one-half of the 
sampling frequency. 

Project main window 
Quality of processing 
 feature allowing you to set the quality of processing on 

the Effects tab of the Settings dialog box in 
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Forward AV Studio (press F5 key). If you set the quality 
low, the processing will be performed with fewer 
calculations (you may encounter some distortions in the 
processed sound, but usually they are almost inaudible). 
It may be useful if you play a project with many audio 
effects or if you want to accelerate Normalize / Statistics 
functions. Please, note that not all effects support this 
feature and process the sound only at the highest quality 
setting. 

Range user-defined time interval 
Resampling changing the sample rate of digital audio signal. This is 

not a primitive task. All samples are recalculated to get 
a signal of different length, which must sound as the 
original one with no audible difference and distortions. 
Forward AV Studio uses a fast and high-quality filtering 
algorithm to perform audio resampling. 

Resampling filter filter is used to get high quality resampling. When audio 
signal is resampled to another sample rate, the simplest 
way is to add more samples to the signal (when the 
sample rate is increased), or to keep away unnecessary 
samples (when the sample rate is decreased). This is the 
simplest method that may result in considerable 
distortions in the resampled signal. Resampling filter is 
used to significantly improve the quality of resampling 
algorithm. The main characteristic of quality it the 
length of resampling filter response. Even if the length 
is small (some points), the distortions are almost 
inaudible. To get higher quality resampling, a greater 
length of filter is required (one-two hundred points 
gives very high quality). 

Sample rate (ratio) sampling frequency of digitized audio signal. The 
greater the sample rate, the higher the frequencies of the 
signal: according to the sampling theorem, a digitized 
signal can contain components of frequencies from zero 
to one-half of the sampling frequency. Sample rate is 
measured in samples per seconds or in Hz, both having 
the same meaning: the number of digital samples of a 
signal played during a second of playback (or recorded 
while digitizing the signal). For example, audio CD-
quality signal is sampled at 44100 Hz. Such signal can 
contain frequency components of up to 22050 Hz. 
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Sample resolution  (bits depth) denotes the precision of digital signal 
representation (accuracy of analog-to-digital converter 
while digitizing signal, for example, while recording 
digital audio from an analog source such as line or 
microphone input of a soundcard) and possible 
maximum dynamic range. 8-bit audio usually has 
audible distortions because of the high level of digital 
noise (dynamic range of only 48 dB); 16-bit audio is 
much more convenient for almost all purposes, for 
example, audio CD (96 dB dynamic range), 20/24-bit is 
professional-quality audio (120/144 dB dynamic range), 
soundcards with such quality and very low level of 
noise are very expensive. Forward AV Studio allows 
playback/recording audio in all resolutions. 

Status bar info line at the bottom of the Project window 
Time ruler ruler for project time reference 
Toolbar accelerator keys 
Video track track for video clips (AVI-files) 
Window function function to be multiplied by the response before 

performing the Fourier transform. These functions are 
used to obtain signal's primary spectral components. For 
more detail, see literature on digital signal processing. 

Working area area for editing project tracks. 
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